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Apache OpenOffice (AOO) est la suite bureau-
tique libre développée par la fondation APACHE
(ASF),  depuis  le  don,  par  ORACLE,  du  code
d'OpenOffice.org à l'ASF en 2011. 

Vous pouvez utiliser AOO en toute légalité sans
frais de licence, même dans le cadre d'une utilisa-
tion  professionnelle,  et  vous  pouvez  même
participer  à  son  développement,  puisqu'il  s'agit
d'un logiciel à code source ouvert.

AOO intègre  les  applications  suivantes : Writer
(traitement de texte),  Calc (tableur),  Impress (lo-
giciel de PréAO), Base (base de données), Math
(pour  l'édition  de  formules  mathématiques),  et
Draw (logiciel de dessin vectoriel et de PAO).

Comme OpenOffice  est  une  application  à  code
source ouvert, un certain nombre de versions dé-
rivées existent, dont les plus connues sont :

– OOo4Kids : version allégée de AOO, spéciale-
ment adaptée pour les enfants de 7 à 12 ans.

– OOoLight : version simplifiée de AOO destinée
aux adultes n'ayant pas une utilisation intensive
de la bureautique.

– LibreOffice : fork  de  OpenOffice.org  créé  en
2010 par un groupe de membres de la commu-
nauté OO.org. 

1.1. À propos de ce document
Ce document décrit l'utilisation, sous Windows, du
module  Calc des  suites  bureautiques  Apache
OpenOfficeTM et OOoLight.

Calc permet de créer toutes sortes de feuilles de
calcul aussi bien pour le traitement et l'analyse de
données  financières,  statistiques,  etc.  que  pour
permettre leur représentation sous forme de dia-
grammes afin de faciliter leur interprétation, et de
mieux visualiser les tendances et les relations qui
existent entre elles.

Avertissement
Ce document est un travail personnel et non une do-
cumentation officielle des projets Apache OpenOffice
et EducOO. 

Remerciements
À tous les développeurs, sans le travail desquels
les suites bureautiques AOO, OOo4Kids et OOo-
Light ne seraient pas disponibles.

Merci également à tous les collaborateurs franco-
phones qui se sont  chargés de la traduction de
ces logiciels  en français  et  à tous ceux qui  as-
surent  le  support  aux  utilisateurs  sur  le  forum
francophone : http://forum.openoffice.org/fr 
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Ce tutoriel a été réalisé avec Apache OpenOffice
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1. Généralités

License
Licensed under the Apache License, Version 2.0
(the "License"); you may not use this file except in
compliance with the License.

You  may  obtain  a  copy  of  the  License  at
http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in
writing, software distributed under the License is
distributed  on  an  "AS  IS"  BASIS,  WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND,
either express or implied.

See  the  License  for  the  specific  language
governing permissions  and limitations under  the
License.

1.2. Démarrer le module Calc
Il existe plusieurs façons de démarrer le module
Calc :

1. depuis le Centre de démarrage
2. directement depuis le bouton  Démarrer situé

sur le bureau de Windows, sans passer par le
Centre de démarrage. 

3. depuis l'Explorateur de fichiers, en double cli-
quant sur un fichier au format Calc (.odt) ;

4. en utilisant le  bouton de démarrage rapide si-
tué  dans  la  barre  des  tâches  (AOO
uniquement) ;

5. depuis un raccourci clavier placé sur le bureau
de Windows.

Centre de démarrage de AOO
C'est  l'écran  d'accueil  qui  apparaît  lorsqu'on
lance, depuis le bureau Windows, la commande
Démarrer  >  Tous  les  programmes  >
OpenOffice.org - OpenOffice.org. 

Le Centre de démarrage permet de démarrer, en
cliquant sur leur icône, tous les modules intégrés,

avec pour résultat la création d'un nouveau docu-
ment  vide  basé  sur  les  options  par  défaut  du
programme. 

Le Centre de démarrage est l'écran d'accueil qui ap-
paraît  en  premier  si  vous  utilisez  OOoLight ou
Apache  OpenOfficeTM comme  application  portable
sur une clé USB.

– Bouton  Ouvrir ... : permet de choisir  un docu-
ment  à  ouvrir,  afin  de  le  consulter  ou  de  le
modifier.

– Bouton  Modèles : donne accès  à  la  boîte  de
dialogue  Modèles  et  documents,  pour  pouvoir
démarrer  la  création  d'un  nouveau  document
basé sur un modèle existant.

Au bas  du  Centre  de  démarrage,  trois  boutons
conduisent  à  des  adresses Internet  importantes
vous permettant de :

1. Télécharger des modèles supplémentaires.
2. Ajouter  de  nouvelles  fonctionnalités  sous

forme d'extensions
3. Vous  connecter  au  site  officiel,  par  exemple

pour télécharger une nouvelle version.

Centre de démarrage OOoLight

Plus simple que son homologue AOO, il présente
les commandes suivantes : 

1. Créer  un texte avec Writer : pour  ouvrir  un
nouveau  document  vide  basé  sur  le  modèle
par défaut du programme.

2. Dessiner avec Draw : pour créer une nouvelle
feuille de dessin vierge.

3. Créer une présentation avec Impress : crée
une  nouvelle  présentation  vide  avec  les  op-
tions par défaut du programme.

4. Créer  un tableau avec Calc : crée  un  nou-
veau  classeur  vide  comprenant  deux feuilles
appelées Feuille 1 et Feuille 2.
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1. Généralités

5. Ouvrir un document : affiche la boîte de dia-
logue  Ouvrir pour  charger  un  document
existant. 

Démarrer depuis le bureau
Pour  démarrer  directement  AOO Calc ou  OOo-
Light Calc depuis le bureau Windows, utilisez la
commande : Démarrer > Tous les programmes
> OpenOffice.org - OpenOffice.org Calc ou Dé-
marrer > Tous les programmes > OOoLight -
OOoLight Calc.

Vous pouvez également ajouter  un raccourci di-
rect  pour  Calc  dans  le  menu  Démarrer.  Deux
méthodes sont possibles :

– En cliquant, avec le bouton droit de votre souris,
sur le lien conduisant au module Calc, puis en
choisissant  la  commande contextuelle  Ajouter
au menu Démarrer. Un lien de démarrage di-
rect apparaît alors dans le menu  Démarrer de
votre bureau.

– Vous pouvez également  ajouter,  sur  votre bu-
reau Windows, un raccourci de démarrage pour
Calc en cliquant avec le bouton droit  de votre
souris sur le lien normalement utilisé pour lancer
le  module  depuis  le  menu  Démarrer puis  en
choisissant la commande contextuelle Envoyer
vers - Bureau (créer un raccourci). Une autre
alternative consiste à faire glisser le lien de dé-
marrage  directement  sur  le  bureau  en
maintenant la touche Ctrl enfoncée.

Toutes les  méthodes ci-dessus ouvrent  un nou-
veau classeur vide comprenant : 

– AOO Calc : 3 feuilles de calculs vierges appe-
lées Feuille 1, Feuille 2, Feuille 3. 

– OOoLight  Calc : 2  feuilles  de  calculs  vierges
appelées Feuille 1, Feuille 2. 

1.3. Éléments de l'interface
Il n'y a pas de grandes différences entre l'interface
de AOO Calc et celle de OOoLight Calc si l'on ré-
tablit  les commandes masquées dans OOoLight
Calc pour alléger l'interface. 

Les  principales  différences  entre  les  deux  ver-
sions sont la taille des feuilles de calculs, réduites
à  250 colonnes et  1 000 lignes dans  OOoLight
Calc, et la présence de la Barre latérale à onglets,
apparue dans AOO depuis sa version 4.0, qui per-
met de regrouper en un seul endroit sur la droite
de l'écran, les fenêtres du Navigateur, du Styliste,
de  la  Gallery et  les  fonctionnalités  des  barres

d'outils contextuelles dans des volets accessibles
depuis une barre d'onglets. 

La fenêtre de Calc se compose d'éléments qu'on
retrouve souvent aussi dans les autres modules
de la suite. 

1. Barre de titre : indique les noms du fichier et
du programme actifs.  Elle dispose également
de boutons permettant la gestion de la fenêtre
de  l'application  (réduction/restauration/ferme-
ture).

2. Barre  de  menus : regroupe  l'ensemble  des
commandes  disponibles  réparties  en  catégo-
ries ou menus.

3. Barre d'outil  Standard : fournit un accès ra-
pide à des commandes importantes qui  sont
communes  à  tous  les  modules  de  la  suite
OpenOffice.org. 

4. Barre d'outils de Formatage : permet d'accé-
der  aux  principaux  outils  de  mise  en  forme
proposés par le programme.

5. Barre de calculs : présente le contenu de la
cellule active, c'est à dire une valeur ou la syn-
taxe d'une formule. 

6. Feuille  de calcul : se compose de lignes et
colonnes définissant des cellules à leurs inter-
sections.

7. Barre de défilement verticale,  avec son as-
censeur et  un outil  permettant  de fractionner
verticalement la feuille de calcul.

8. Barre de défilement horizontale,  avec à sa
gauche la zone des onglets de feuilles et un
outil  de navigation.  La zone affichant  les on-
glets  se  termine  par  une  petite  barre  noire
verticale  permettant  de  fractionner  verticale-
ment l'affichage de la feuille de calcul à l'aide
de la souris.
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1. Généralités

9. Barre d'état : fournit un certain nombre d'infor-
mations  importantes  sur  l'état  du  travail  en
cours en cours ainsi qu'un outil de zoom.

Barre de titre

1. Bouton affichant un menu de commandes de
gestion de la fenêtre du programme : réduire
l'application  dans  la  barre  des  tâches  de
Windows,  réduire/restaurer  la  taille  de  la  fe-
nêtre,  fermer la fenêtre (autrement dit  quitter
l'application).

2. Indication du nom du classeur actif et de l'ap-
plication en cours (Calc dans notre cas).

3. Dans sa partie droite, la barre de titre propose
à nouveau, mais sous forme de boutons cette
fois, les commandes de gestion de la fenêtre
du programme (réduction de l'application dans
la barre des tâches, réduction/restauration de
la fenêtre de l'application, fermeture de l'appli-
cation).

Zone des commandes
La zone de commandes du module Calc se situe
sous la barre de titre et se compose, par défaut,
d'une barre de menus et de barres d'outils.

1. Barre des menus : elle  regroupe l'ensemble
des commandes du programme en catégories
ou  menus.  En cliquant  sur  un menu,  on dé-
roule  l'ensemble  de  ses  commandes
connexes.  Certaines  sont  des  commandes
simples,  d'autres des  commandes complexes
proposant alors une liste de sous commandes
ou conduisant à l'ouverture d'une boîte de dia-
logue pour permettre  à l'utilisateur  de choisir
les options avec lesquelles elles doivent s'exé-
cuter. 

2. Barre d'outils Standard : répète, sous forme
de boutons, les commandes les plus fréquem-
ment  utilisées,  à  l'exception des  commandes
de mises en forme qui sont regroupées dans
une barre dédiée. On y trouve les commandes

d'ouverture, d'enregistrement, d'impression ou
de sauvegarde, ainsi que les principales com-
mandes  d'édition  ou  encore  des  outils  pour
l'insertion de formules ou de création de gra-
phiques.  On  y  trouve  également  des
commandes  de  tri,  d'insertion  d'objets,  ainsi
qu'une commande de Zoom. 

3. Barre  d'outils  Formatage : c'est  là  que  se
trouvent les commandes permettant de choisir
police,  taille,  attributs  et  couleur  des  carac-
tères,  alignement  du  contenu  des  cellules,
formatage  des  valeurs  monétaires,  définition
du nombre  de  décimales,  affichage en pour-
centage, etc... Il s'agit d'une barre contextuelle,
c'est à dire qu'elle ne met à disposition que les
commandes de mises en forme applicables au
contenu des cellules. Ainsi, par exemple, lors-
qu'un  dessin  se  trouve  sélectionné,  elle
disparaît pour laisser la place à la barre d'outils
Propriétés de l'objet de dessin, qui fournit les
outils  nécessaires  pour  la  mise  en forme de
celui-ci. 

Barre de calcul
Sous la zone de commande se trouve la barre de
calcul composée comme suit : 

– À gauche, la  Zone de nom affiche en perma-
nence  l'adresse  de  la  sélection  courante,  qui
peut  être une cellule unique ou un groupe de
cellules ;

– La  partie centrale se compose de 3 boutons :
l'Assistant Fonctions ouvrant une boîte de dia-
logue permettant l'insertion d'une fonction dans
la cellule sélectionnée, le bouton  Somme et le
bouton  Fonction représenté par le signe  = qui
permet d'entamer la saisie d'une formule dans
la cellule  sélectionnée (dont  l'adresse est  affi-
chée dans l'indicateur de la zone active).

– La partie droite, constituée par une zone de sai-
sie,  renferme  le  contenu  de  la  cellule
sélectionnée, une  valeur ou une  formule selon
le cas. C'est dans cette zone qu'on peut saisir
manuellement une formule de calcul.

Lorsqu'on clique sur le bouton Fonction, un signe
"=" apparaît dans la zone de saisie de la barre et
sa zone centrale se modifie comme suit :
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1. Généralités

– Le  bouton  Assistant  Fonctions permet
d'insérer une fonction choisie dans la boîte de
dialogue Assistant Fonctions.

– Le bouton d'annulation  permet d'annuler
l'édition effectuée dans la cellule et de revenir à
l'état antérieur (un résultat analogue serait obte-
nu en appuyant sur la touche Escape) ; ;

– Le  bouton de validation  remplit le même
rôle que la touche  Entrée du clavier : il  valide
l'opération d'édition en cours.

L'espace de travail
L’espace de travail correspond à la zone centrale
de la fenêtre, celle qui affiche la feuille du clas-
seur sur lequel on travaille. 

Il est encadré par les  barres de défilement verti-
cale et  horizontale, ainsi que par les zones d'en-
têtes de lignes et de colonnes de la feuille de cal-
cul affichée. 

Une barre de navigation située sur la gauche du
système  d'onglets  du  classeur  actif,  permet  de
parcourir les feuilles du classeur et d'atteindre sa
première feuille, celle qui précède ou suit la feuille
courante ou sa dernière feuille.

Au lancement du programme c'est un classeur vide
qui s'affiche dans l'espace de travail.

Le classeur est le document produit lorsqu'on tra-
vaille avec un tableur. C'est un carnet de feuilles
de calcul (3 par défaut, dans AOO Calc, 2 dans
OOoLight Calc, 1 dans OOo4Kids). Un classeur
peut renfermer un maximum de 256 feuilles.

Dans un  classeur,  chaque feuille de calcul  pos-
sède un nom propre affiché sur un onglet intégré
dans un système d'onglets  attaché au classeur.
Chaque feuille est constituée d'une grille dont les
colonnes et lignes définissent à leurs intersections
des cellules.

Pour accéder à une feuille spécifique, il suffit de
cliquer sur son onglet : la feuille sélectionnée s'af-
fiche alors dans l'espace de travail, en avant plan
des autres feuilles qui composent le classeur.

Un  classeur  s'enregistre  sous  forme  de  fichier
unique et permet ainsi de conserver en bloc les
différentes feuilles de calcul relatives à un même
projet. 

La barre d'état
Située au bas de la fenêtre du programme, sous
la barre de défilement horizontale,  elle se com-
pose  de  zones  zones  qui  affichent  des
informations sur le travail en cours ou permettent
d'accéder directement à certaines fonctionnalités
du programme. On distingue les zones suivantes,
(de gauche à droite) :

– Numéro de feuille   : un double clic sur
cette zone affiche le Navigateur

– Style de cellule ou style de page  : in-
dique le style actif. En double cliquant sur cette
zone, la boîte d'édition de style s'ouvre et vous
pouvez directement éditer le style de cellule ou
de page actif.

– Mode  Insertion   : cliquez  ici  pour  basculer
entre  le  mode  Insertion et  le  mode  Refrappe
lorsque vous saisissez du texte au clavier.

– Mode de Sélection  : définit le comportement
standard des flèches de navigation du clavier et
permet de basculer entre les modes de sélec-
tion  STD  (Standard),  EXT  (Extension),  AJT
(Ajout) On peut basculer de STD à EXT par F8.

– État  d'enregistrement  : ce  symbole  signale
que le classeur a subi des modifications et que
celles-ci n'ont pas encore été enregistrées.

– Fonction  : par défaut, lorsqu'on sélec-
tionne  un  ensemble  de  cellules,  cette  zone
affiche la somme des valeurs sélectionnées. En
cliquant à droite sur ce champ, on peut changer
cet affichage pour d'autres fonctions statistiques
comme la moyenne, le maximum, le minimum,
le nombre de données, etc.

– Zoom  : pour  changer  la
taille de l'affichage (facteur de Zoom), faites glis-
ser le curseur de zoom ou cliquez sur les signes
+ et - . Vous pouvez aussi cliquer à droite sur le
champ affichant la valeur actuelle du Zoom pour
choisir  dans  une liste  le  facteur  d'agrandisse-
ment  souhaité.  Un  double  clic  sur  ce  même
champ ouvre la boîte de dialogue Zoom et Dis-
position des pages. 

1.4. Configurer Calc
Les paramètres de configuration propres à Calc
sont accessibles par la commande : Outils > Op-
tions > OpenOffice Calc.

Ces  paramètres  se répartissent  en  7  boîtes  de
dialogue et permettent à l'utilisateur de configurer
son programme comme il le souhaite. 
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1. Généralités

Les  options  choisies  à  ce  niveau  sont  conservées
d'une séance de travail à la suivante tant qu'on ne
les modifie pas. Elles sont enregistrées dans le dos-
sier de profil de l'utilisateur.

En principe, vous devriez pouvoir vous passer de
faire  des  modifications  dans ces boîtes,  car  les
options prévues par  défaut  conviennent  dans la
majorité des cas.

Général
Cette boîte permet de définir l'unité de mesure à
utiliser  (cm)  ainsi  que la  valeur  des  tabulations
(1.25 cm). La boîte propose encore des options
relatives à l'actualisation des liens lors du charge-
ment  d'un  classeur  ainsi  que  le  choix  de
paramètres de saisie. 

Afficher
Cette boîte  permet  de décider  de l'affichage de
toute une série d'éléments :

– relatifs à la fenêtre du programme : en-têtes de
lignes et de colonnes, barres de défilement, on-
glets de feuilles, symboles du plan ;

– relatifs au contenu des cellules : afficher les for-
mules  à  la  place  des  valeurs  retournées,
afficher un indicateur de notes dans les cellules
contenant une note pour mieux les repérer, affi-
cher  le  débordement  de  texte,  afficher  les
références en couleur, etc…

– concernant  l'affichage  des  objets  insérés tels
qu'images, dessins, graphiques. Le programme
permet de les afficher ou de les masquer.

– relatifs à la feuille de classeur : affichage ou non
des lignes de la grille des feuilles de classeur,
avec possibilité de leur choisir une couleur, etc.

L'option d'affichage Mise en évidence des valeurs
permet d'afficher les données numériques en bleu
et les résultats retournés par les formules et fonc-
tions en vert clair. Les textes restent affichés en
noir.  Cette  mise  en  forme est  activable/désacti-
vable localement au niveau de la feuille de calcul
par la commande bascule  Affichage > Mise en
évidence des valeurs ou le raccourci Ctrl+F8.

L'option de Zoom Synchroniser les feuilles permet
d'appliquer à toutes les feuilles d'un classeur le
facteur d'agrandissement défini pour l'une d'entre
elles.

Calculer
Cette boîte permet de choisir une date de départ
pour le calendrier interne utilisé par le programme
pour convertir les entrées de type date en numé-
ros de série et pouvoir ainsi effectuer des calculs
sur les dates.

La boîte permet encore de choisir le nombre de
décimales à afficher par défaut pour les valeurs
numériques.

L'option  Rechercher  automatiquement  les  éti-
quettes de colonnes et lignes est intéressante car
elle  permet  au programme de reconnaître  auto-
matiquement des plages de cellules comprenant
des intitulés de lignes et colonnes. Il faut toutefois
que les noms utilisés comme arguments dans une
formule/fonction  commencent  par  une  lettre  et
que  ceux  renfermant  des  espaces  soient  enca-
drés d'apostrophes '. 

Si un intitulé contient  lui-même une apostrophe,  il
faut alors, lorsqu'il intervient comme argument, sai-
sir  le  caractère  \  (barre  oblique  inversée)  devant
l'apostrophe pour que le nom soit valide dans la for-
mule. 

La capture d'écran ci-dessous illustre un exemple
d'utilisation de cette fonctionnalité. 

La fonction SOMME a été saisie dans la cellule
B7 en utilisant comme référence l'intitulé de co-
lonne "Chiffre d'affaires 1998" en respectant  les
règles d'écriture mentionnées ci-dessus. La fonc-
tion  a  ensuite  été  simplement  recopiée  vers  la
droite. 

Listes de tri
Cette boîte permet d'afficher, de gérer et de créer
les  listes  d'éléments  dont  vous  pourrez  ensuite
vous servir dans vos feuilles de calculs. Il existe
par défaut des listes prédéfinies pour les mois de
l'année et les jours de la semaine qui vous faci-
litent  l'insertion  de  ces  informations  dans  vos
feuilles de calcul.

Modifications
Cette boîte permet de choisir les couleurs qui per-
mettront  d'identifier  plus  facilement  les
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1. Généralités

modifications apportées aux feuilles par les relec-
teurs. 

Grille
Cette boîte permet de déterminer la finesse de la
grille à utiliser pour positionner des éléments gra-
phiques dans les feuilles de calcul avec plus de
précision.  Vous  pourrez  régler  la  finesse  de  la
trame :

– en donnant une valeur d'écart des points aux ni-
veau des axes OX et  OY (Options  Résolution
horizontale  /  verticale)  dans l'unité  de  mesure
que vous avez choisie.

– en décidant du nombre de points intermédiaires
(graduations  secondaires)  que vous  souhaitez
entre les graduations principales des axes défi-
nies  au  point  précédent  (Option  Subdivision
horizontale / verticale).

L'activation de l'option Capturer à la grille confère
à la grille un effet magnétique ne permettant plus
le  déplacement  des  objets  graphiques  qu'entre
ses différents points. Vous pouvez désactiver tem-
porairement cet effet magnétique en effectuant le
déplacement d'un objet en maintenant la touche
Ctrl enfoncée.

L'option Grille visible permet de visualiser la grille.

L'option  Synchroniser les axes permet de réper-
cuter symétriquement toutes les modifications des
paramètres de la grille : résolution et subdivision
des axes OX et OY resteront alors toujours iden-
tiques. 

Imprimer
– Ignorer les pages vides pour l'impression : cette

option  permet  d'éviter  l'impression  de  pages
sans contenu ou objet de dessin.

– Imprimer uniquement les feuilles sélectionnées :
dans ce cas, seules les feuilles de calcul sélec-
tionnées  sont  imprimées  et  ce,
indépendamment  de  ce  qui  a  été  sélectionné
dans la boîte de dialogue Impression.

1.5. Les macros

Une macro consiste à regrouper dans une com-
mande  unique  la  série  de  commandes
nécessaires à l'exécution d'une tâche répétitive,
afin de pouvoir l'exécuter de manière entièrement
automatique. 

Il  n'est pas recommandé de recourir à des macros
pour appliquer des styles, car il existe pour cela le
Styliste, outil plus adapté pour ce genre de travail.
Ceci dit, rien n'interdit d'intégrer dans une macro un
style chargé de mettre en forme automatiquement
le résultat obtenu suite à l'exécution de la macro. 

On peut ainsi, par exemple, créer une macro pour
insérer  la  liste  des  mois  de  l'année  dans  une
feuille  de  calcul,  ou  pour  automatiser  l'insertion
dans du texte de caractères spéciaux utilisés fré-
quemment. 

Ce qui  suit  concernant  les  macros  s'applique à
tous  les  modules  de  la  suite :  Calc,  Impress,
Draw, Math et Base.

Créer une macro
Pour créer une macro, lancez la commande  Ou-
tils  >  Macros  >  Enregistrer  une  macro.  Une
petite fenêtre apparaît à l'écran et à partir de ce
moment toutes les opérations que vous effectuez
sont enregistrées dans la macro. 

Dans le cas d'une macro destinée à l'intégration
de caractères spéciaux, ces opérations consiste-
ront à :

– Lancer  la  commande  Insertion  >  Caractères
spéciaux ...

– Sélectionner le symbole souhaité.
– Valider par OK.

Une  fois  la  série  de  manipulations  précédentes
réalisée, cliquez sur  Terminer l'enregistrement.
Une  boîte  d'enregistrement  s'ouvre  alors  pour
permettre  de  définir  où  doit  être  enregistrée  la
macro. 

Dans le volet gauche de la fenêtre, intitulé  Enre-
gistrer la macro dans sont listées deux catégories,
Mes macros et  Macros OpenOffice, ainsi que les
différents documents OpenOffice actifs.

Chaque dossier comporte une bibliothèque nom-
mée  Standard dans laquelle il suffit d'enregistrer
la  macro  pour  la  rendre  disponible  uniquement
dans le document correspondant. Si au contraire
on souhaite  élargir  la  portée  de  la  macro  et  la
rendre utilisable dans tous les documents, il faut
alors choisir de l'enregistrer dans la bibliothèque
Standard de la catégorie Mes macros. 

Une fois le module devant contenir  votre macro
sélectionné, attribuez à celle-ci un nom explicite
dans le champ Nom de la macro puis cliquez sur
Enregistrer.
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1. Généralités

Dans le gestionnaire de macros d'OpenOffice Basic
se trouve un bouton  Éditer qui ouvre une fenêtre
dans laquelle s'affiche le code Basic de votre macro.
Vous pouvez alors modifier directement votre macro
en éditant son code.
Pour supprimer une macro, appuyez sur Supprimer
après  l'avoir  sélectionnée  dans  le  gestionnaire  de
macros. 

Utiliser une macro
Placez le point d'insertion à l'endroit où doit s'exé-
cuter la macro puis lancez la commande Outils >
Macros > Exécuter la macro pour ouvrir le sé-
lecteur de macro. 

Dans la colonne intitulée  Bibliothèque, dépliez la
section  Mes  macros,  puis  la  bibliothèque  Stan-
dard, puis cliquez sur le module. Dans la colonne
de droite vous voyez apparaître le nom de votre
macro. Sélectionnez-la puis cliquez sur le bouton
Exécuter.

Assigner un raccourci à une 
macro
Nous  prendrons  comme  exemple  l'assignation
d'un raccourci  clavier  au caractère  µ.  La procé-
dure s'effectue en deux étapes :

– Enregistrement d'une macro produisant  l'inser-
tion du caractère µ dans un document, au point
d'insertion.

– Assignation du raccourci Alt+M à cette macro.

Enregistrer la macro
1. Démarrer l'enregistrement de la macro par la

commande  Outils  >  Macros  >  Enregistrer
une macro.

2. Lancez la commande Insertion > Caractères
spéciaux pour ouvrir la boîte de dialogue Ca-
ractères  spéciaux,  puis  sélectionnez  le
caractère µ et cliquez sur OK.

3. Cliquez  sur  le  bouton  Arrêter  l'enregistre-
ment pour arrêter l'enregistrement, enregistrer
la  macro  et  afficher  la  boîte  de  dialogue
OpenOffice.org Macros Basic. 

4. Donnez un nom significatif à la macro dans le
champ Nom de la macro dans la partie supé-
rieure gauche de la boîte, puis enregistrez-la.
Pour  ce faire,  ouvrez  le  conteneur  de biblio-
thèque  Mes  macros,  recherchez  la
bibliothèque nommée Standard sous Mes ma-
cros, puis sélectionnez Module1 et cliquez sur
Enregistrer.

Assigner un raccourci à la macro
1. Lancez  la  commande  Outils  >

Personnaliser ...- Clavier. 
2. Cliquez  sur  le  bouton radio  OpenOffice  pour

mettre votre nouvelle assignation à disposition
de tous les modules de la suite OpenOffice.

3. Dans la liste  Raccourcis  clavier,  sélectionnez
la combinaison non utilisée Alt+M. 

4. Dans  la  liste  Catégorie,  faites  défiler  jusqu'à
l'entrée  Macros  OpenOffice,  cliquez  sur  le
signe  + puis cliquez sur le signe  + près de la
bibliothèque Standard et choisissez Module1.

5. Dans la  liste  Fonction,  choisissez micro puis
cliquez sur le bouton  Modifier dans la partie
supérieure droite de la boîte. La combinaison
de touches  sélectionnée apparaît  maintenant
dans la liste des raccourcis clavier avec le nom
de la macro qui lui est associée.

6. Validez par OK.

Assigner un bouton à une 
macro
1. Lancez la commande Outils > Macros - Gérer

les macros - OpenOffice Basic,  puis sélec-
tionnez  la  macro  désirée  et  cliquez  sur  le
bouton Assigner ....

2. La fenêtre Personnaliser qui apparaît renferme
3  onglets : Menus,  Barres  d'outils et  Événe-
ments, pour permettre d'associer une macro à
chacun de ces éléments. 

3. L'onglet  Barres  d'outils affiche  une  liste  de
barres d'outils dans une liste déroulante. Choi-
sissez  celle  dans  laquelle  vous  souhaitez
intégrer  une  icône  de  démarrage  pour  votre
macro,  puis  dans  la  section  Contenu  de  la
barre d'outils, cliquez sur le bouton Ajouter. 

4. Dans la liste Catégorie, sélectionnez votre ma-
cro  puis  cliquez  sur  Ajouter pour  la  faire
apparaître  dans  la  liste  des  boutons  de  la
barre. 

5. Il reste à attribuer une icône à votre macro. Si
vous  ne  trouvez  pas  votre  bonheur  dans  la
liste des icônes déjà disponibles, sélectionnez
l'une d'entre elles  puis  cliquez sur  le  bouton
Modifier et choisissez la commande Modifier
l'icône.  Une  fenêtre  apparaît  dans  laquelle
vous  pouvez  choisir  l'icône  qui  représentera
votre macro.

6. Cliquez sur OK pour valider.
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Calc est un  tableur,  c'est à dire une application
destinée à effectuer toutes sortes de travaux sur
des données organisées dans des  feuilles  qua-
drillées : calculs,  opérations de tri  et  de filtrage,
représentations graphiques, etc. 

Le classeur est le type de document créé par un
tableur. Par défaut, il se compose de 3 feuilles de
calculs dans AOO Calc, de 2 feuilles dans OOo-
Light Calc et de 1 feuille dans OOo4Kids.

2.1. Organisation
Un  classeur  est  dynamique,  c'est  à  dire  qu'on
peut modifier  la composition de ses feuilles : lui
en ajouter de nouvelles, en supprimer, les renom-
mer,  ou  encore  réorganiser  leur  ordre  de
succession.

Le menu contextuel des onglets de feuilles ren-
ferme toutes les commandes permettant de gérer
les feuilles du classeur. 
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2. Le classeur

Naviguer entre les feuilles
Pour  sélectionner  une feuille,  il  suffit  de  cliquer
sur son onglet dans la zone d'affichage des on-
glets de feuilles, au bas de l'espace de travail. La
copie d'écran ci-dessous correspond à la sélec-
tion de la Feuille3.

Lorsque  le  classeur  contient  de  nombreuses
feuilles, cette zone n'est pas assez grande pour
permettre  un  affichage  complet  des  onglets  de
feuilles.  Dans  ce  cas,  des  boutons  fléchés  de-
viennent  actifs  sur  la  gauche  de  la  zone
d'affichage  des  onglets  pour  permettre  de  faire
défiler les feuilles :

– le dernier bouton fléché de droite, celui qui porte
un triangle orienté vers la droite et un trait verti-
cal,  permet d'accéder à l'onglet de la dernière
feuille ;

– le premier premier bouton fléché tout à gauche,
permet d'accéder à l'onglet de la toute première
feuille du classeur ;

– deux autres boutons fléchés permettent d'accé-
der  à  l'onglet  précédent  ou  suivant  celui  qui
correspond à la feuille affichée. La sélection de
la feuille précédente/suivante peut également se
faire  au  clavier  en  appuyant  sur  Ctrl+Pg-
Préc/PgSuiv.

Il est possible d'augmenter l'espace réservé à l'affi-
chage des onglets en élargissant à l'aide de la souris
(par Cliquer glisser vers la droite) la ligne de sépara-
tion entre la zone d'affichage des onglets et la barre
de défilement horizontale.

Sélectionner plusieurs feuilles
Chaque feuille de calcul peut être utilisée de ma-
nière indépendante des autres. Toutefois, lorsque
des  données  sont  à  reproduire  sur  plusieurs
feuilles, il est utile de pouvoir sélectionner le bloc
de feuilles dans lesquelles elles doivent être répé-
tées, de manière à n'effectuer le travail de saisie
qu'une seule fois.

Pour  sélectionner  plusieurs  feuilles  simultané-
ment,  il  suffit  de  cliquer  sur  leurs  onglets
respectifs tout  en maintenant la touche  Ctrl en-
foncée.  Les  onglets  des  feuilles  sélectionnées
(Feuilles1, 3, 4) s'affichent alors en blanc, pour les
distinguer des onglets non sélectionnés qui  res-
tent affichés en gris (Feuilles 2 et 5 dans la copie
d'écran ci-dessous).

Pour sélectionner d'un seul coup un groupe d'on-
glets successifs, cliquez sur le premier, puis sur le
dernier en maintenant la touche Maj enfoncée.

Pour désactiver la sélection d'une feuille à l'inté-
rieur d'un groupe de feuilles sélectionnées, cliquer
à nouveau sur son onglet tout en maintenant la
touche Ctrl enfoncée. 

Insérer des feuilles
La commande  Insérer une feuille... située dans
le menu contextuel des onglets de feuilles (ou la
commande de menu Insertion > Feuille ...) ouvre
la boîte  Insérer une feuille  regroupant toutes les
options qui permettent de rajouter des nouvelles
feuilles au classeur actif.

La  rubrique  Position permet  de  choisir  l'endroit
d'insertion  dans  le  classeur : avant  ou  après  la
feuille active.

La rubrique Feuille offre deux possibilités :

– l'option  Nouvelle  feuille permet  d'insérer  des
feuilles de calculs vierges à la position choisie
dans  la  rubrique  Position.  Si  on  ne  souhaite
ajouter qu'une seule feuille, il est possible de lui
attribuer un nom ;

– l'option À partir d'un fichier active le bouton Par-
courir... qui  permet  de  choisir  le  classeur
externe à partir duquel les feuilles seront impor-
tées. Une fois le choix du classeur effectué, la
liste de ses feuilles apparaît dans une zone de
la  boîte  et  on  peut  sélectionner  à  la  souris
celle(s) qu'on souhaite incorporer ou lier (si l'op-
tion Lier est cochée) au classeur actif.

La validation par OK réalise l'insertion.

Supprimer des feuilles
Pour supprimer une feuille, la sélectionner en cli-
quant  sur  son onglet,  puis  lancer  la  commande
contextuelle  Supprimer  la  feuille....La  suppres-
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2. Le classeur

sion ne devient effective qu'après confirmation par
l'utilisateur.

Renommer une feuille
On peut renommer une feuille à partir de la com-
mande  correspondante  du  menu  contextuel  de
son onglet,  ou en double cliquant sur celui-ci.  Il
suffit alors de saisir le nouveau nom dans la boîte
Renommer la feuille puis de valider par OK. 

Un nom de feuille ne peut contenir que des lettres
et des chiffres, éventuellement séparés par des es-
paces.

Copier ou déplacer une feuille
La procédure peut être réalisée à l'intérieur d'un
même classeur ou entre 2 classeurs distincts.

À l'intérieur d'un même classeur
À l'intérieur  d'un  même classeur,  la  méthode la
plus simple consiste à effectuer l'opération à l'aide
de la souris.

– Pour recopier une feuille à un autre endroit du
classeur actif, cliquer sur son onglet en mainte-
nant  la  touche  Ctrl enfoncée,  puis  le  faire
glisser jusqu'à son nouvel emplacement. Lors-
qu'on relâche la souris l'onglet représentant la
feuille  dupliquée  apparaît  sous  le  même nom
que la feuille originale, mais avec le suffixe "2"
pour signaler qu'il s'agit d'une copie.

– Pour déplacer une feuille à un autre endroit du
classeur, la faire simplement glisser jusqu'à son
nouvel emplacement.

Entre deux classeurs
Pour copier  /  déplacer une feuille d'un classeur
vers un autre :

– Appeler le menu contextuel de la feuille à co-
pier/déplacer  et  sélectionner  la  commande
Déplacer/copier la feuille... pour ouvrir la boîte

de dialogue  Déplacer/copier  la feuille.  Par dé-
faut  la  boîte  propose  un  déplacement.  Pour
effectuer une copie,  il  faut  cocher l'option  Co-
pier.

– Dans la liste déroulante  Vers le document, sé-
lectionner  le  classeur  de  destination,  puis  la
position  d'insertion  sous  la  rubrique  Insérer
avant.

– Valider la commande par OK.

Une autre fenêtre d'affichage
La commande Fenêtre > Nouvelle fenêtre fournit
une copie du classeur actif dans une nouvelle fe-
nêtre.  A des  fins  d'identification,  le  nom  de  la
copie est  suivi,  dans la  barre de titre,  du signe
deux-points et du numéro "2".

Il est alors possible de réduire la taille des deux
fenêtres pour pouvoir les disposer côte à côte.

Masquer une feuille de calcul
Lorsque le classeur renferme un grand nombre de
feuilles,  il  est  possible  de  masquer  certaines
d'entre elles qui sont moins utilisées.

– Cliquez sur l'onglet de la feuille à masquer pour
l'afficher dans l'espace de travail.

– Lancez la commande Format > Feuille > Mas-
quer.

Les feuilles masquées ne s'affichent plus à l'écran
et ne sont pas imprimées, mais on peut y faire ré-
férence dans des formules.

Pour  réafficher  une  feuille  masquée,  lancer  la
commande Format > Feuille > Afficher ...

Une boîte  s'ouvre et  on  peut  alors  sélectionner
dans  la  liste  des  feuilles  masquées  celle  qu'on
souhaite réafficher.

Le masquage ou le réaffichage de feuilles ne peut se
faire que feuille après feuille. Le masquage ou le ré-
affichage d'un groupe de feuilles n'est pas possible.

2.2. Protéger un classeur
Il est possible, lors de l'enregistrement d'un clas-
seur, de prévoir plusieurs niveaux de protection. 

Notez  bien  que  ces  commandes  de protection  ne
fonctionnent sous OpenOffice que si  vous enregis-
trez vos classeurs au format  .odt qui est le format
officiel de OpenOffice.org. 
Elles ne sont pas fonctionnelles dans le cas de sau-
vegardes dans des formats externes comme .xls de
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2. Le classeur

Microsoft  Excel,  même si  OpenOffice  Calc  est  ca-
pable de travailler sur des fichiers de ce format.

La protection d'un classeur peut se faire à trois ni-
veaux :

– on peut protéger l'accès au classeur en l'enre-
gistrant  avec  un  mot  de  passe  qu'il  faudra
impérativement  connaître  pour  pouvoir  l'ouvrir
par la suite ;

– on peut  protéger l'organisation d'un classeur
et dans ce cas, seules les personnes connais-
sant le mot de passe pourront procéder à des
insertions, suppressions ou renommages de ses
feuilles ;

– on peut  protéger une ou plusieurs feuille(s)
de classeur contre toute modification.

Protéger l'accès
Lancer  la  commande  Fichier  >  Enregistrer
sous... .  Dans la boîte de dialogue qui s'ouvre,
cocher  l'option  Enregistrer  avec  mot  de  passe,
puis valider après avoir donné un nom au fichier
et lui avoir choisi un dossier de sauvegarde.

Une boîte s'ouvre vous invitant à définir le mot de
passe qui protégera le classeur. 

Saisissez un mot de passe comportant au moins
cinq caractères dans les deux champs  Mots de
passe et  Confirmer.  Les  mots  de  passe  res-
pectent la casse (A234Z est différent de a234z).

Par  la  suite,  il  faudra indiquer  le  mot  de passe
pour ouvrir le classeur.

Pour désactiver la protection d'un classeur, vous ne
pouvez que créer une nouvelle version non protégée
de votre classeur. 
Pour ce faire, commencez par l'ouvrir en fournissant
le mot de passe qui le protège, puis enregistrez-le
une nouvelle fois par la commande Fichier > Enre-
gistrer sous... en veillant bien à décocher l'option
Enregistrer avec mot de passe et à lui attribuer un
nouveau nom avant de valider.
Vous  disposez  alors  de  deux  versions  identiques,
une version protégée et une qui ne l'est pas. Vous
pouvez alors supprimer la version protégée. 

Protéger l'organisation
Ce  type  de  protection  n'interdit  pas  l'accès  au
classeur mais empêche simplement toute modifi-
cation  dans  son  organisation  interne  et  la
composition de ses feuilles (suppression, dépla-
cement,  masquage,  affichage,  insertion  ou
attribution  d'un  nouveau  nom  aux  feuilles  de-
viennent impossibles), si on ne connaît pas le mot
de passe qui permet d'ôter la protection.

La commande de protection est la suivante : Ou-
tils > Protéger le document – Document... Elle
ouvre une boîte permettant la définition du mot de
passe de protection.

Par la suite,  vous pouvez enregistrer  tout  à fait
votre  document  et  le  rouvrir  normalement.  Par
contre, vous constatez que toutes les commandes
d'insertion, de suppression, de renommage, ou de
copie déplacement de feuilles ne sont plus dispo-
nibles pour ce classeur. 

Pour retrouver ces fonctionnalités et ainsi annuler
la protection de l'organisation de votre classeur, il
suffit de rappeler une nouvelle fois la commande
Outils > Protéger le document – Document...
puis de saisir le mot de passe qui avait été défini
précédemment pour la protection de l'organisation
du classeur.

La  validation  désactive  alors  la  commande  de
protection de l'organisation du classeur.

Protéger les feuilles
La commande Outils > Protéger le document –
Feuille... permet  d'activer  la  protection intégrale
de la feuille de calcul active. Elle ouvre une boîte
permettant la définition du mot de passe de pro-
tection. 
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2. Le classeur

• Par défaut, les cellules d'une feuille de calcul pos-
sèdent  l'attribut  "Protégé"  qui  les  protègent  en
écriture, mais cette protection ne devient effec-
tive que sur demande explicite de l'utilisateur en
lançant la commande Outils > Protéger le do-
cument – Feuille....

• Si on n'entre pas de mot de passe dans la boîte
ci-dessus, la feuille sera quand même protégée
en  écriture,  mais  un  simple  rappel  de  la  com-
mande  Outils  >  Protéger  le  document  –
Feuille... suffira à annuler sa protection.

Par  la  suite  vous pouvez  enregistrer  tout  à  fait
votre  document  et  le  rouvrir  normalement.  Par
contre,  vous  constatez  que  toute  intervention
dans la feuille protégée vous est interdite.

Pour annuler la protection de la feuille, relancez
simplement  la  commande  Outils  > Protéger  le
document – Feuille... 

Ensuite, dans la boîte de dialogue Déprotéger la
feuille, saisissez le mot de passe de protection.

2.3. Feuille de calcul
La feuille de calcul constitue le document de base
sur  lequel  on  travaille  avec  un  tableur.  Nous
avons vu que cette feuille fait partie d'un classeur
qui s'enregistre et s'ouvre comme un tout et cor-
respond au fichier qui sera enregistré à la fin de la
session de travail avec Calc.

Chaque feuille est représentée, au bas de la zone
de travail par un onglet portant son nom. C'est en
cliquant sur lui qu'on rend la feuille active et ac-
cessible  à  l'édition.  L'accès  aux  parties  non
visibles de la feuille est rendu possible par la pré-
sence de barres de défilement.

Toute action dans une feuille de calcul nécessite
de réaliser successivement les 3 opérations sui-
vantes :

1. Naviguer, c'est à dire se rendre à l'endroit (cel-
lule ou plage de cellules) où l'action doit être
exécutée, à l'aide du clavier ou de la souris.

2. Sélectionner la  cellule  /plage de cellules  où
l'action doit se faire, ce qui revient à position-
ner le curseur du programme dessus.

3. Réaliser l'action  souhaitée  en  lançant  une
commande ou une procédure d'édition.

Lignes et colonnes
Structurellement, une feuille de calcul se présente
comme une grille organisée en une suite de 65
536 lignes et de 1 024 colonnes, dont les inter-
sections définissent des cases ou cellules.

– Les colonnes sont désignées par des lettres de
l'alphabet (A, B, C,...), la colonne suivant la co-
lonne Z étant appelée AA, elle-même suivie de
AB, AC, AD, etc., jusqu'à AZ. Au delà de AZ, les
colonnes sont nommées BA, BB,BC, etc. 

– Les lignes sont numérotées de 1 à 65 536.

Les feuilles de calcul de OOoLight sont réduites à
1000 lignes et  256 colonnes, mais cette taille est
suffisante dans la majorité des cas.

Sélectionner lignes et colonnes
La sélection d'une ligne ou d'une colonne se fait
simplement en cliquant sur son en-tête à l'aide de
la souris. La sélection de plusieurs lignes ou co-
lonnes  ensembles  appelle  à  la  distinction  des
deux cas suivants :

– On  peut  sélectionner  plusieurs  lignes  ou  co-
lonnes contiguës en cliquant sur l'en-tête de la
première puis sur celle de la dernière en mainte-
nant la touche Maj enfoncée. Le même résultat
peut être obtenu par un simple Cliquer-glisser
sur les en-têtes des lignes ou colonnes à sélec-
tionner.

– Si  on  doit  réaliser  la  sélection  de  plusieurs
lignes ou colonnes non contiguës, il suffit de cli-
quer  sur  leurs  différentes  en-têtes  en
maintenant la touche  Ctrl enfoncée pendant le
processus.

Pour désélectionner  une ligne ou une colonne fai-
sant  partie  d'un  bloc  de  lignes  ou  de  colonnes
sélectionnés, il  suffit de cliquer sur la ligne ou co-
lonne à désélectionner en maintenant la touche Ctrl
enfoncée.
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2. Le classeur

Gérer les lignes et les colonnes
Les commandes de gestion des lignes et des co-
lonnes sont accessibles :

– depuis la barre des menus ;
– à l'aide de raccourcis clavier ;
– dans  les  menus contextuels  attachés  aux  en-

têtes de lignes et colonnes.

Insertion de lignes et de colonnes
La commande  Insertion > lignes / colonnes ...
permet l'insertion de lignes/colonnes dans un ta-
bleau. 

Lors d'une procédure d'insertion, la ligne ou co-
lonne insérée prend toujours la place de la ligne
ou colonne sélectionnée qui se trouve repoussée
d'une  ligne  vers  le  bas  (insertion  de  ligne)  ou
d'une  colonne  vers  la  droite  (insertion  de
colonne). 

À la suite d'une insertion, le programme réorga-
nise automatiquement la numérotation des lignes
et des colonnes de la feuille et actualise les réfé-
rences utilisées par les formules qui s'y trouvent
pour tenir compte de sa nouvelle organisation.

Suppression de lignes ou de colonnes
La  commande  contextuelle  Supprimer  des
lignes/colonnes réalise la suppression de lignes
et colonnes sélectionnées. 

Suppression diffère d'effacement. 
• Lors d'une suppression, on détruit une partie du

support de la feuille de calcul, ce qui nécessite
une actualisation de la numérotation de la grille. 

• Lors  de  l'effacement  d'une  ligne  ou  d'une  
colonne,  on  supprime  simplement  son  contenu
mais pas la ligne ou la colonne en tant que telle.
La structure de la feuille reste inchangée.

En  supprimant  une  ligne  ou  une  colonne  qui
contient des données, on perd celles-ci et on rend
incohérentes les formules y faisant référence, ce
que le programme signale en affichant dans les
cases de ces formules le signe  # REF !.  Il  pro-
page  également  cet  affichage  aux  cellules
devenues  incohérentes  indirectement  du  fait
qu'elles  utilisent  des  résultats  devenus  incohé-
rents.

Modifier hauteur et largeur de lignes et 
colonnes
La commande  Format > Ligne/colonne déroule
un sous-menu permettant de modifier  manuelle-
ment la hauteur de la ligne en cours,  ou de lui

choisir  une hauteur  optimale  (après  avoir  défini
l'espacement supplémentaire à ménager entre le
plus grand caractère de la ligne et les bords supé-
rieurs de la cellule qui le contient). 

À noter que la hauteur/largeur d'une ligne/colonne
peut être également modifiée à l'aide de la souris
par un  Cliquer – glisser sur la ligne de sépara-
tion entre les en-têtes de lignes/colonnes. 

Un double clic sur la ligne de séparation permet de
définir rapidement une largeur optimale de colonne
ou une hauteur optimale de ligne. 

La commande  Format > colonne permet égale-
ment de choisir une largeur optimale (après avoir
défini  l'espacement  supplémentaire  à  ménager
entre l'entrée la plus longue de la colonne et les
bords latéraux de la cellule qui la contient).

Les raccourcis clavier Alt + flèche gauche / droite
et  Alt + haut /  bas permettent également d'agir
sur la largeur de la colonne ou la hauteur de la ligne
qui contient la cellule sélectionnée.

Masquer lignes/colonnes
Les  commandes  Format  >  Ligne  et Format  >
Colonne permettent également le masquage de
lignes/colonnes sélectionnées ou leur réaffichage
si  elles  étaient  masquées.  Le  contenu  d'une
ligne/colonne masquée n'est plus visible et n’est
pas  imprimé,  mais  il  reste  accessible  aux  for-
mules qui y font référence.

Le masquage d'une ligne / colonne peut également
se faire en réglant sa hauteur / largeur à 0 à l'aide
de la souris.

Pour  récupérer  l'affichage  de  lignes  /  colonnes
masquées,  créer  une  sélection  encadrant  la
ligne  /  colonne  masquée,  puis  lancer  la  com-
mande Format > Ligne / colonne – Afficher.
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Se déplacer (naviguer)
Se déplacer dans une feuille de calcul (on dit aus-
si parfois naviguer) consiste à atteindre la partie
de la feuille où on souhaite travailler. Ce déplace-
ment peut s'effectuer à l'aide du clavier ou de la
souris.

À l'aide du clavier
Lorsqu'on se déplace dans une feuille de calcul à
l'aide de touches de navigation du clavier, la cel-
lule atteinte se trouve toujours automatiquement
sélectionnée et donc prête à recevoir un contenu.

– On peut se déplacer d'une cellule de haut  en
bas et de droite à gauche par rapport à la posi-
tion  courante  à  l'aide  des  quatre  flèches
directionnelles du clavier.

– On peut se déplacer d'un écran vers le haut ou
le bas à l'aide des touches  PgPréc (PgUp) et
PgSuiv (PgDn).

– On peut se déplacer d'une page écran vers la
gauche  ou  la  droite  par  ALT+  PgPréc ou
ALT+PgSuiv.

– Début (Home) positionne  le  curseur  dans  la
première cellule de la ligne active.

– Fin (End)  positionne le curseur dans la der-
nière cellule non vide de la ligne active.

– Ctrl+Début sélectionne la cellule A1.
– Ctrl+Fin positionne  le  curseur  sur  la  dernière

cellule non vide de la feuille.
– Tab et  Maj+Tab produisent  respectivement un
déplacement d'une cellule vers la droite ou vers la
gauche.

À l'aide de la souris et des barres de 
défilement
On peut se déplacer : :

– D'une ou de plusieurs lignes vers le bas ou le
haut. Un clic sur les flèches de la barre de défi-
lement verticale décale l'affichage de la feuille
d'une ligne vers le haut ou le bas.

– D'une ou de plusieurs colonnes vers la gauche
ou la droite. Un clic sur les flèches de la barre
de défilement horizontale décale l'affichage de
la  feuille  d'une  colonne  vers  la  droite  ou  la
gauche.

– D'un écran vers le haut, le bas, la droite ou la
gauche en cliquant de part et d'autre de l'ascen-
seur  des  barres  de  défilement  horizontale  et
verticale.

Fixer des lignes et colonnes
Lorsqu'on travaille avec une grande feuille de cal-
cul,  il  est  souvent  utile  de  figer  les  lignes  et
colonnes de titre pour les garder visibles en per-
manence pendant le défilement du contenu.

Fixer les en-têtes de colonnes

– Sélectionner complètement la ligne située juste
sous  la  ligne des  en-têtes  de  colonnes  qu'on
souhaite conserver visible en permanence.

– Lancer la commande bascule Fenêtre > Fixer.

Figer les intitulés de ligne

– Sélectionner la colonne située juste à droite de
celle qu'on souhaite conserver visible en perma-
nence.

– Lancer la commande bascule Fenêtre > Fixer.

Une ligne renforcée sépare une ligne ou une co-
lonne fixée du reste de la feuille de calcul.

Si une cellule de la feuille se trouve sélectionnée
au  moment  de  lancer  la  commande  Fenêtre  >
Fixer, on obtient à la fois la fixation des intitulés
de lignes situés dans la colonne à gauche de la
cellule sélectionnée, et la fixation des intitulés de
colonnes situés dans la ligne au-dessus de la cel-
lule en question.

Pour annuler la fixation d'une ligne ou d'une co-
lonne,  rappeler  simplement  la  commande
Fenêtre > Fixer pour la désactiver.

Fractionner l'espace de travail
Dans les feuilles de calcul de grande taille, cette
fonctionnalité permet de fractionner la fenêtre ac-
tive horizontalement  et  verticalement  en deux à
quatre volets pour pouvoir afficher différents par-
ties de la feuille de calcul éloignées les unes des
autres.

2 méthodes sont possibles : : 

– la commande bascule Fenêtre > Scinder ;
– utiliser  les  curseurs  de  fractionnement pré-

sents en haut de la barre de défilement verticale
et à l'extrémité droite de la barre de défilement
horizontale.

Commande Fenêtre > Scinder
La commande bascule Fenêtre > Scinder permet
de fractionner l'affichage au niveau du coin supé-
rieur gauche de la cellule sélectionnée. L'espace
de travail se trouve alors partagé verticalement et
horizontalement en deux fenêtres indépendantes
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2. Le classeur

(volets)  disposant  chacune  de  leurs  propres
barres de défilement, ce qui permet un affichage
simultané  à  l'écran  de  deux  régions  éloignées
dans la feuille.

Le retour à un affichage normal s'obtient en relan-
çant  la  commande  Fenêtre  >  Scinder pour  la
désactiver.

Si on sélectionne au préalable une ligne ou une co-
lonne entière, l'affichage sera scindé, selon le cas,
en deux fenêtres superposées ou juxtaposées. 

Les curseurs de fractionnement

Faire glisser vers la gauche le curseur de fraction-
nement ci-dessus pour obtenir un fractionnement
vertical en deux volets.

Faire glisser vers le bas le curseur de fractionne-
ment  ci-dessus  pour  obtenir  un  fractionnement
horizontal en deux volets.

Pour annuler le fractionnement, double cliquez sur
la  ligne  de  séparation  à  supprimer  ou  utilisez  la
commande bascule Fenêtre > Scinder.

2.4. Les cellules
Les  cellules sont  les  éléments  de  base  d'une
feuille de calcul. Elles sont caractérisées par leur
Adresse composée de l'indication de la colonne et
de  la  ligne  à  l'intersection  desquelles  elles  se
trouvent. Ces deux éléments (coordonnées) défi-
nissent de manière univoque leur position dans la
feuille.

Les cellules peuvent contenir : :

– des  valeurs : : numériques  (nombres,  dates,
heures,  valeurs  monétaires),  du  texte
(étiquette/commentaire)

– des  formules de calcul et des  fonctions ac-
compagnées  du  résultat  des  calculs  qu'elles
effectuent.

– des  attributs de  mise  en  forme  déterminant
l'apparence que prendront leurs contenus. 

Une cellule vide ne renferme aucune valeur, mais
elle possède un format, c'est à dire qu'elle renferme
toujours les attributs de mise en forme hérités du
modèle de classeur sur lequel le classeur actif est

basé, ou ceux qu'on lui a attribué par la suite. 

Sélectionner cellules et plages
Une  sélection correspond  à  une  cellule  ou  un
groupe de cellules adjacentes ou non (plage mo-
nobloc  ou multiple),  sur  lesquels  le  pointeur  de
programme se trouve positionné.

Sélectionner une cellule
On peut utiliser le clavier ou la souris pour sélec-
tionner une cellule.

– Positionner le pointeur de la souris sur la cellule
puis effectuer un clic gauche : : la cellule est sé-
lectionnée et apparaît avec un contour renforcé
et une poignée de recopie dans son coin infé-
rieur droit (petit carré noir sur lequel le pointeur
de la souris prend la forme d'une croix). 

– Déplacer, à l'aide des flèches de navigation du
clavier, le pointeur du programme jusqu'à la cel-
lule à sélectionner. On voit ici que "Navigation"
et "Sélection" sont simultanées.

Lorsqu'une  cellule est sélectionnée, son contenu
s'affiche dans la partie droite de la barre de calcul
tandis  que son  adresse apparaît  dans  la  partie
gauche de la barre.

Sélectionner plusieurs cellules
Lorsque c'est une plage de cellules qui est sélec-
tionnée,  la  barre  de  calcul  affiche  toujours  le
contenu de la cellule qui porte le focus. Dans sa
zone  intitulée  Zone  de  nom,  elle  affichera
l'adresse de la plage ou seulement l'adresse de la
cellule portant le focus, selon que la plage sélec-
tionnée est monobloc ou non.
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2. Le classeur

Un clic gauche dans le coin supérieur gauche de la
feuille (à l'intersection des en-têtes de colonnes et
de lignes) sélectionne toute la feuille.

Sélectionner une plage "monobloc"
L'opération peut être réalisée à l'aide de la souris
ou du clavier.

A l'aide de la souris

Deux méthodes sont possibles

Première méthode 

1. Sélectionner à l'aide de la souris la cellule mar-
quant le coin supérieur gauche de la zone à
sélectionner (première cellule de la zone).

2. En maintenant le bouton gauche de la souris
enfoncé, étendre la sélection à toute la zone
désirée par  glissement  de la  souris  (Cliquer-
glisser). La plage sélectionnée apparaît en vi-
déo inversée.

3. Une fois la sélection terminée, relâcher le bou-
ton gauche de la souris : : l'adresse de la plage
apparaît dans la  Zone de nom (partie gauche
de la  barre de calcul).  Remarquez que dans
l'écriture de l'adresse d'une plage,  le double-
point est utilisé comme séparateur pour la déli-
miter : : B5:D8 signifie  "de la cellule B5 à la
cellule D8".

Deuxième méthode

Sélectionner une ligne ou une colonne entière en
cliquant simplement sur leur en-tête respective.

Sélectionner une plage en cliquant d'abord sur sa
première cellule puis, après avoir  appuyé sur la
touche Maj et en la conservant enfoncée, simple-
ment  positionner  le  pointeur  de la  souris  sur  la
dernière cellule et effectuer un clic gauche.

A l'aide du clavier

Sélectionner au clavier (flèches de navigation) la
première cellule de la zone à sélectionner.

Appuyer sur la touche  Maj et, tout en la mainte-
nant  enfoncée,  étendre  la  sélection  à  toute  la
zone choisie à l'aide des flèches de navigation du
clavier.

Il est possible de déplacer le focus sur une cellule
dans une plage sélectionnée sans perdre la sélec-
tion en cliquant sur la cellule en combinaison avec
la touche Ctrl. 

Sélectionner une plage multiple
La sélection d'une plage multiple se fait à la souris
en maintenant  la  touche  Ctrl enfoncée pendant
toute la procédure. Une fois l'opération terminée,
relâcher la touche Ctrl. 

Adresse des cellules et des 
plages
Chaque cellule de la feuille de calcul active est ré-
férencée de manière unique par son adresse (ses
coordonnées).  Celle-ci  se  compose  d'un  couple
de valeurs : la lettre de la colonne dans laquelle
elle se trouve, suivie du numéro de la ligne qui la
contient.  Avec un tel  système de repérage,  une
cellule à l'intersection de la colonne G et  de la
ligne 12 aura pour adresse G12.

Lorsqu'une  cellule  est  sélectionnée,  son  adresse
s'affiche dans la partie gauche de la barre de calcul,
intitulée Zone de nom.

Adresse complète d'une cellule
L'adresse  complète d'une  cellule  comprend  le
chemin d'accès au classeur qui la contient, suivi
du nom de la feuille dans laquelle elle se trouve et
de son adresse dans cette feuille,  le tout s'écri-
vant en respectant une syntaxe comme le montre
l'exemple qui suit.

Ainsi, la référence à la cellule G5 dans la Feuille2
du  classeur.sxc  "Toto"  sur  le  lecteur  F  s'écrira
comme  suit : "='file:///F|/Toto.swc'#$Feuille2.G5".
Ne  pas  oublier  les  guillemets  simples  qui  en-
tourent le nom du fichier et le signe # qui indique
l'emplacement à l'intérieur du fichier.

L'écriture d'une telle adresse permet de récupérer
dans la feuille active le contenu d'une cellule d'un
classeur externe, mais il est bien plus simple de pro-
céder  par  pointage,  après  avoir  préalablement
ouvert le classeur renfermant la cellule externe à ré-
férencer.

Adresse d'une plage
Un  groupe  de  cellules  adjacentes  s'appelle  un
bloc de cellules ou plage et un tel bloc est réfé-
rencé par les adresses de ses cellules supérieure
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2. Le classeur

gauche  et  inférieure  droite,  séparées  par  deux
points (A5:E9, par exemple).

La notion de plage de cellules est toutefois plus
générale et  peut  se composer  également  d'élé-
ments  non  adjacents.  Dans  ce  dernier  cas,  la
plage sera référencée par la suite des adresses
des différentes cellules et blocs qui la composent,
séparés les uns des autres par le caractère point-
virgule. Exemple : plage B3:B5;D6;F8:G10

Contenu des cellules
Les cellules d'une feuille de calcul peuvent rece-
voir les différents types de contenus suivants :

– données : textes, nombres, dates et heures ;
– formules (fonctions) : le résultat retourné par

leur calcul s'affiche dans la cellule contenant la
formule (fonction) ;

– formats : un contenu format correspond à l'en-
semble des propriétés d'affichage de la cellule.
Dans le cas des formats, seules les modifica-
tions  par  rapport  aux  attributs  du  format
standard sont  supprimés lors  d'une procédure
d'effacement. Effacer le formatage d'une cellule
revient  donc  à  lui  restituer  le  format  standard
d'origine ;

– notes : bulles de commentaires qu'on peut atta-
chés aux cellules ;

– objets : son, vidéo, image, etc...

L'effacement  du contenu d'une cellule  peut  être
différencié, et c'est ce que permet la boîte de dia-
logue qui s'ouvre automatiquement lorsqu'on tape
la touche Suppr sur une sélection. 

La boîte permet l'effacement complet du contenu,
avec retour à une cellule vide avec le format pré-
vu par défaut par le programme (format de base),
ou  au  contraire,  un  effacement  partiel  affectant
seulement certains de ses contenus.

Il  résulte  de ce qui  précède que lorsqu'on sou-
haite recopier  le contenu d'une cellule ou d'une
plage à un autre endroit de la feuille il faut d'abord
commencer  par  copier  l'intégralité  du  contenu
dans le presse-papiers par la commande Édition
> Copier. Ensuite, on a deux possibilités :

– soit on transfère l'intégralité du contenu c'est à
dire valeurs, formats et formules éventuelles en
lançant la commande Édition > Coller dans la
cellule destinataire sélectionnée ;

– soit on opte pour un transfert partiel du contenu
en  lançant  la  commande  Édition  >  Collage
spécial... et on effectue le choix du contenu à
transférer dans la boîte de dialogue qui s'ouvre.
Si la copie à effectuer renferme des valeurs nu-
mériques, les options de la rubrique Opérations
permettent de définir une opération arithmétique
à  appliquer  aux  valeurs  copiées.  Celles-ci
peuvent ainsi être, si on le souhaite, ajoutées ou
soustraites au contenu de la cellule de destina-
tion, ou encore multipliées ou divisées dans la
cellule de destination.

Recopier des cellules
Cette procédure consiste à reproduire intégrale-
ment les contenus d'une cellule ou d'une plage à
un autre endroit de la feuille de calcul. Si les cel-
lules de la plage cible contiennent des données,
celles-ci sont écrasées par celles contenues dans
les cellules recopiées.

Le  cas  des  cellules  renfermant  des  formules  sera
abordé dans le  chapitre consacré aux formules  et
fonctions. 

On peut procéder à l'aide du presse-papiers ou di-
rectement à la souris.

Si la plage cible renferme des données et que vous
procédez  à  l'aide  du  presse-papiers,  un  message
d'avertissement vous indique que les contenus de la
plage cibles seront écrasés.

A l'aide du presse-papiers
1. Sélectionner  la  cellule/plage  dont  le  contenu

est à copier.
2. Appeler la commande Édition > Copier... : les

contenus sont copiés dans le presse-papiers.
3. Sélectionner la cellule de destination puis lan-

cer la commande Édition > Coller.

A l'aide de la souris
1. Sélectionner  la  plage  à  copier,  puis  cliquer

dessus sans relâcher la souris. 
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2. Le classeur

2. Appuyer sur la touche Ctrl et la maintenir en-
foncée tandis qu'on traîne la sélection jusqu'à
destination. Lorsqu'il s'agit de copier une seule
cellule, la procédure est différente (voir l'illus-
tration  concernant  les  déplacements  de
cellules  ci-dessous).  Cette  procédure  recopie
les contenus intégralement.

Déplacer des cellules
L'opération consiste à déplacer une ou plusieurs
cellules, avec leur contenu, à un autre endroit de
la  feuille.  Si  les  cellules  de  la  plage  cible
contiennent des données, celles-ci sont écrasées
par celles contenues dans les cellules déplacées. 

On peut procéder à l'aide du presse-papiers ou di-
rectement à la souris.

Si la plage cible renferme des données et que vous
procédez  à  l'aide  du  presse-papiers,  un  message
d'avertissement vous indique que les contenus de la
plage cibles seront écrasés.

A l'aide du presse-papiers
1. Sélectionner  la  cellule/plage à  déplacer,  puis

appeler la commande Édition > Couper.
2. Sélectionner  une  cellule  de  destination.  S'il

s'agit d'un déplacement de plage, la cellule de
destination sélectionnée sera la cellule supé-
rieure  gauche  de  la  page  de  destination  du
déplacement.

3. Appeler la commande Édition > Coller : le dé-
placement s'effectue. 

A l'aide de la souris
La procédure est identique à celle utilisée pour la
copie à l'aide de la souris. Seule différence, ici la
procédure  est  effectuée  sans  faire  appel  à  la
touche Ctrl.

Le  déplacement  d'une cellule individuelle est
un peu particulier dans Calc et est illustré ci-des-
sous.

1. Sélectionner la cellule à déplacer.

2.  Appuyer sur  Maj  pendant que vous cliquez
une seconde fois sur la cellule. Ensuite, relâ-
chez la touche Maj.

3. Par un Cliquer-Déposer, déplacez la cellule jus-
qu'à sa destination avant de relâcher le bouton de
la  souris.  Si  vous  procédez  en  maintenant  la
touche Ctrl enfoncée, vous effectuez une copie et
non un déplacement.

Supprimer des cellules entières
Dans ce cas, on ne supprime pas seulement le
contenu des cellules, mais vraiment les cellules,
ce qui provoque une réorganisation de la feuille
de calcul qui se traduit par un décalage des cel-
lules de droite ou du bas.

On procède comme suit :

1. On sélectionne la cellule à supprimer.
2. On lance la  commande de suppression  Édi-

tion  >  Supprimer  des  cellules  ... ou  la
commande contextuelle équivalente.

3. Une boîte de dialogue apparaît pour demander
de spécifier  la  direction de  déplacement  des
cellules  restantes  pour  combler  le  trou  créé
dans la feuille.

Protéger des cellules
On peut protéger certaines plages d'une feuille de
calcul  tout  en laissant  d'autres parties librement
modifiables.

La méthode se base sur le fait  que les cellules
peuvent posséder ou non l'attribut  Protégé dans
l'onglet Protection de la boîte de dialogue Forma-
tage  des  cellules (commande  Format  >
Cellules...).

Par défaut, toute cellule possède l'attribut  Protégé,
mais la protection ne devient effective que lorsque
l'utilisateur  le  demande explicitement  par  la  com-
mande  Outils  >  Protéger  le  document  >
Feuille....

Activer la protection de certaines cellules
1. Commencer  par  s'assurer  que  les  plages  à

protéger  possèdent  bien  l'attribut  Protégé au
départ (ce qui est le cas par défaut) et ne pas
oublier  de  modifier  la  valeur  de  cet  attribut
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2. Le classeur

dans les zones qui doivent rester accessibles
en écriture après la demande de protection de
la feuille.

2. Une fois ces précautions prises, lancer la com-
mande  Outils  >  Protéger  le  document  >
Feuille... pour ouvrir la boîte Protéger la feuille
qui permet de définir le mot de passe à utiliser
par  la  suite  lorsqu'on  voudra  déprotéger  la
feuille si on est amené à apporter des modifi-
cations dans ses zones protégées. 

Retirer la protection de cellules
Pour  supprimer  la  protection  de  cellules  proté-
gées :

1. Enlever la protection de la feuille, puis sélec-
tionnez les plages à déprotéger.

2. Lancer  la  commande  Format  >  Cellules  –
Protection pour pouvoir enlever l'attribut  Pro-
tégé aux seules cellules qu'on souhaite rendre
accessibles.

3. Rétablir la protection de la feuille en exécutant
la commande Outils > Protéger le document
– Feuille...

2.5. Les fichiers texte CSV
Le format CSV (Comma Separated Values) est un
format  de  fichier  texte  qui  permet  l'échange de
données provenant  d'une feuille  de calcul  entre
différentes applications. 

Dans un fichier de ce format, chaque ligne repré-
sente  une  ligne  de  la  feuille  de  calcul  et  les
différentes  colonnes  sont  souvent  séparées  par
une virgule, mais il est possible d'utiliser d'autres
caractères pour délimiter une zone, comme le ca-
ractère de tabulation. 

Si une zone ou une cellule contient une virgule, le
contenu  de  cette  zone  ou  cellule  doit  être  placé
entre guillemets simples (') ou doubles (").

Ouvrir un fichier CSV dans Calc
1.  Lancez  la  commande  d'ouverture  de  fichiers
Fichier > Ouvrir (Ctrl+O).

2. Cliquez sur la pointe de flèche située à droite
du  bouton  Tous  les  fichiers  *.* et  choisissez
Texte CSV (*.csv ;*.txt) comme type de fichier.

3. Sélectionnez le fichier à ouvrir, puis cliquez sur
le bouton Ouvrir.

4.  La  boîte  Import  de  texte apparaît  avec  une
zone qui permet de spécifier les caractères utili-
sés pour la séparation du texte en colonnes. 

Si le fichier CSV utilise un caractère séparateur de
texte non répertorié dans la zone Options de sépa-
rateur, activez la case à cocher Autres puis entrez le
caractère en question.

Dans la partie inférieure de la boîte, une zone de
prévisualisation permet de contrôler que la dispo-
sition des données importées est correcte. Vous
pouvez cliquer avec le bouton droit  de la souris
dans une colonne de la zone d'aperçu pour définir
son format ou la masquer.

5. Cliquez sur OK.

Enregistrer une feuille au 
format CSV
1. Affichez la feuille de classeur à enregistrer sous
forme de fichier CSV.

2.  Lancez  la  commande  Fichier  >  Enregistrer
sous.

3. Dans la boîte qui s'ouvre, entrez un nom de fi-
chier,  puis  choisissez  Texte  CSV dans  la  zone
Type de fichier. 

4. Désignez le dossier de sauvegarde puis cliquez
sur le bouton Enregistrer.

5.  Confirmez  l'enregistrement  au  format  CSV
dans la boîte d'avertissement qui apparaît. 

Dans la boîte de dialogue Exportation de fichiers
texte, sélectionnez les options voulues, puis vali-
dez par OK.
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L'exportation d'une feuille de calcul au format CSV
ne conserve que les  données  de la  feuille  active,
sans ses formules et sa mise en forme. 
Si vous voulez exporter les formules en tant que for-
mules, sous la forme =SOMME(A2:C4), il faut cocher
l'option Formules dans la boîte ouverte par la com-
mande  Outils  > Options > OpenOffice Calc >
Affichage.
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Ce chapitre traite des différents types de données
que peuvent contenir les cellules d'une feuille de
calcul. Ces données (informations) sont essentiel-
lement de deux types : les  textes (ou intitulés) et
les valeurs (nombres, dates, heures, valeurs mo-
nétaires  avec  lesquelles  on  effectuera  des
calculs).

Si l'entrée de textes ne pose généralement pas de
problèmes, il n'en est pas de même avec la saisie
des valeurs. Celles-ci doivent être entrées en res-
pectant  certaines  règles  pour  éviter  que  le
programme ne les interprète comme du texte. 

À la base de ces règles de saisie se trouvent no-
tamment  certaines  options  choisies  pour  les
Paramètres régionaux, dans le Panneau de confi-
guration de Windows.

3.1. Les paramètres régionaux
Avant de se mettre à utiliser un tableur, il est bon
de commencer par définir les formats et sépara-
teurs  (séparateur  des  milliers  et  séparateur
décimal) à appliquer par défaut lors de la saisie
de valeurs numériques.

Par la suite, il sera toujours possible de reformater
localement les valeurs autrement, si on le souhaite.

L'accès à la boîte permettant la définition des Pa-
ramètres régionaux se fait en double cliquant sur
l'icône  correspondante  dans  la  fenêtre  du  Pan-
neau de configuration de Windows. 

La boîte qui s'ouvre propose, sous différents on-
glets,  des  options  permettant  de  préciser  ses
choix pour les valeurs numériques de type date et
heure, nombres, valeurs monétaires, etc. 

Les  réglages  ci-dessous  correspondent  à  ma
configuration  personnelle.  À  vous  de  définir  la
vôtre.

Nombres
Le point est choisi comme séparateur décimal et
l'apostrophe  comme  séparateur  des  milliers.  Le
trait  d'union  juste  devant  une  valeur  numérique
est utilisé pour l'entrée de valeurs négatives. Le
nombre de décimales significatives est 2. Le sys-
tème métrique est adopté.
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3. Saisir les données

Symbole monétaire
Le symbole Sfr. est choisi comme symbole moné-
taire  et  il  doit  s'afficher  à  gauche  des  valeurs
monétaires. Le programme adoptera alors ces dé-
finitions comme format par défaut pour l'affichage
des valeurs monétaires et c'est ce format qui sera
appliqué  lorsqu'on  formatera  des  valeurs  dans
une feuille avec le bouton  Format numérique :
monétaire situé dans la barre d'outils Formatage.

Dates
Le  point  est  choisi  comme séparateur  des  élé-
ments d'une date courte. Exemple : 12.05.97.

Heures
Le  double  point  est  utilisé  pour  séparer  les
heures, les minutes et les secondes dans l'écri-
ture  d'une  valeur  de  type  heure.  Exemple :
12:23:42.

3.2. Procédures générales
Ci-dessous, les procédures pour insérer un conte-
nu dans une cellule ou une plage monobloc.

Contenu dans une cellule
La procédure générale de saisie de données dans
une cellule est la suivante :

1. Commencer par sélectionner la cellule destina-
taire.

2. Taper l'information au clavier directement dans
la cellule sélectionnée ou dans la partie droite
de la  barre de formule.  Les différents  carac-
tères frappés s'affichent alors à la fois dans la
cellule cible et dans la barre de formule. À ce
stade,  on  peut  toujours  annuler  l'édition  en
cours en appuyant sur Échap ou sur le bouton
Annuler dans la barre de formule ;

3. Valider l'entrée par Enter, le bouton de valida-
tion dans la barre de formule, la touche Tab ou
l'une des touches de navigation du clavier (va-
lable uniquement si  vous avez effectué votre
saisie dans une cellule et non dans la barre de
formule).

Lorsque le contenu est plus grand que la cellule,
la feuille de calcul se comporte comme suit :

– si le contenu est un libellé (texte), il peut débor-
der  sur  les  cellules  situées  sur  sa  droite,  à
condition qu'elles soient vides. Si ce n'est pas le
cas, l'affichage est tronqué dans la cellule lors
de la validation et une petite flèche rouge poin-

tant vers la droite le signale, mais le contenu ap-
paraît intégralement dans la partie droite de la
barre de formule ;

– si le contenu est de type valeur (donnée ou ré-
sultat d'un calcul), il ne sera affiché que s'il tient
effectivement  dans  la  cellule.  Dans  le  cas
contraire, le programme affiche une série de ca-
ractères dièse "#" dans la cellule, signalant par
là qu'une valeur s'y trouve, mais que la largeur
de la cellule ne permet pas son affichage com-
plet.  La  valeur  apparaît  intégralement  dans la
barre de calcul et apparaîtra dans la cellule lors-
qu'on élargira la colonne dans laquelle elle se
trouve.

Remarques

– Pour corriger des fautes de frappe en cours de
saisie, utilisez la touche Retour arrière pour ef-
facer les caractères erronés, puis corrigez votre
entrée.

– Pour  interrompre  la  saisie,  appuyez  sur  la
touche  Échap,  Cette  procédure  restitue  le
contenu d'origine de la cellule si la saisie se fai-
sait par dessus-celui-ci.

– Pour modifier un contenu déjà validé, double-cli-
quez sur la cellule qui le contient pour basculer
en mode édition puis procédez à la correction
voulue. On peut aussi sélectionner la cellule et
écraser son ancien contenu en entrant directe-
ment le nouveau par dessus.

– Pour  supprimer  le  contenu  d'une  cellule  ou
d'une  plage,  la  sélectionner  puis  appuyer  sur
Suppr. Une boîte apparaît permettant d'effacer
complètement le contenu ou de procéder à un
effacement différencié : Textes, Nombres, Dates
et  heures,  Formules,  Commentaires,  Formats,
Objets.

– Les contenus de type texte sont  automatique-
ment  alignés  à  gauche  dans  la  cellule,
contrairement  aux  contenus  de  type  valeurs
(nombres, dates, heures et valeurs monétaires)
qui sont alignés à droite.

Contenu dans une plage 
monobloc
– Entrer la donnée à reproduire (elle s'inscrit dans

la cellule portant le focus).
– Appuyer sur la combinaison de touches Alt+En-

trée : l'entrée  est  recopiée  dans  toute  les
cellules de la sélection.
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3. Saisir les données

Cette technique ne fonctionne pas dans une plage
de cellules disjointes.

Effacer le contenu d'une 
sélection

L'effacement est demandé par la commande Édi-
tion > Effacer... ou la touche Suppr au clavier. La
boîte de dialogue qui s'ouvre permet de préciser
le  type  de  contenu  à  effacer :  effacement  total,
seulement les valeurs, les formules, les commen-
taires  ou  la  mise  en  forme  des  cellules
sélectionnées.

Inverser un tableau
Si  vous avez commencé à  saisir  un  tableau et
que vous constatez que vous auriez mieux fait de
mettre en lignes ce que vous avez défini en co-
lonnes, vous pouvez corriger comme suit :

1. Sélectionnez votre tableau avec la souris.
2. Cliquez du bouton droit de la souris et sélec-

tionnez Couper (ou appuyez sur Ctrl+X).
3. Cliquez sur la cellule de départ du tableau.
4. Lancez la commande Edition > Collage spé-

cial.

5. Cochez la case Transposer et cliquez sur OK.

Les lignes de votre tableau d'origine sont deve-
nues  les  colonnes  du  nouveau  tableau,  et  les
colonnes du tableau d'origine forment désormais
les lignes du nouveau tableau.

3.3. Les textes
Le programme interprète une entrée comme du
texte  après  s'être  assuré  qu'il  ne  s'agissait  pas
d'une formule ou d'une valeur (numérique, date,
heure…), qui doivent respecter une syntaxe pré-
cise. Tout ce qui n'est pas valeur ou formule est
donc automatiquement considéré comme texte et
aligné à gauche dans la cellule.

Fonction d'auto-complétion
Cette fonctionnalité permet de reproduire rapide-
ment dans une cellule un texte (jamais une valeur
numérique)  déjà  saisi  précédemment  dans  une
autre cellule de la même colonne.

Lors  de  la  saisie  suivante,  il  suffit  simplement
d'entrer les premières lettres du texte pour voir le
programme le proposer en entier :

– s'il  s'agit bien du texte souhaité, on peut alors
accepter en validant l'entrée par Enter ;

– si  ce n'est  pas  le  cas,  il  suffit  simplement  de
poursuivre la saisie du contenu souhaité.

Cette  fonctionnalité  est  active  par  défaut.  Pour  la
désactiver,  désélectionnez  la  commande  bascule
Outils > Contenu des cellules > AutoSaisie.

Un texte long
Si la cellule s'avère trop étroite pour afficher entiè-
rement une entrée de type texte et si les cellules
situées juste à droite sont vides, le texte excéden-
taire déborde sur celles-ci et reste complètement
affiché au niveau de la feuille de calcul après vali-
dation de l'entrée.

Si le texte excédentaire ne peut déborder sur les
cellules situées à sa droite, parce qu'elles ne sont
pas vides, alors le programme le "tronque" au mo-
ment  de  la  validation,  mais  le  conserve
intégralement  en  mémoire  et  l'affiche  complète-
ment dans la barre de formule lorsque la cellule
est sélectionnée.

Dans ce cas, une pointe de flèche rouge apparaît
sur  la  droite  de  la  cellule  concernée,  indiquant
que celle-ci contient plus de texte que celui affi-
ché à l'écran. En double-cliquant sur cette flèche
rouge, on accède l'affichage complet du contenu
de la cellule. Cette option de marquage peut être
supprimée si on le désire par la commande Outils
>  Options >  OpenOffice  Calc  >  Affichage en
désactivant l'option Débordement de texte.

Si on souhaite que le texte saisi dans une cellule
soit toujours affiché, on a deux possibilités : 

– on peut élargir la colonne qui contient la cellule
pour permettre au texte de s'y afficher complè-
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3. Saisir les données

tement.  Cette  option  n'est  toutefois  réalisable
que si le texte n'est pas trop long ;

– si le texte est vraiment trop long, il reste la pos-
sibilité  de  le  répartir  sur  plusieurs  lignes  à
l'intérieur de la cellule en appliquant  l'une des
procédures suivantes : soit  utiliser  le raccourci
clavier  Ctrl+Entrée pour  produire  un  saut  de
ligne forcé à l'approche de la bordure droite de
la cellule,  soit  activer  la commande  Format >
Cellule…- Alignement et cocher l'option  Ren-
voi à la ligne automatique. Dans ce cas, le texte
saisi dans la cellule passera automatiquement à
la ligne suivante à l'approche du bord droit de la
cellule, comme cela se passerait dans un docu-
ment  texte  lorsque  le  texte  approche  de  la
marge droite de la page.

Pour éviter que sur la nouvelle  ligne créée par un
saut  de  page  avec Ctrl+Enter le  texte  ne  com-
mence par une majuscule, il faut désactiver l'option
Majuscule en début de phrase dans l'onglet Options
de la commande Outils > Options d'AutoCorrec-
tion.

Un contenu chiffré 
Lorsqu'un contenu chiffré, comme un numéro de
téléphone ou un code postal, doit être considéré
comme du texte et non comme un nombre, il faut
le saisir précédé du caractère apostrophe' ou for-
mater la cellule destinataire au format texte avant
de procéder à la saisie du numéro.

En  effet,  lorsqu'une  cellule  ne  renferme  que  des
chiffres,  Calc  interprète  le  contenu  comme  un
nombre.
Lorsque  le  contenu  d'une  cellule  renferme  des
chiffres et des lettres, il est interprété comme texte.

Les notes
Il  est possible d'ajouter à toute cellule une note
(commentaire)  par  la  commande  Insertion  >
Commentaire, ce qui a pour effet de faire appa-
raître un cadre permettant l'édition de la note.

Un simple clic dans la feuille de calcul valide le
texte entré et crée la note. Dans ce cas, la cellule
affiche un petit carré rouge, dans son coin supé-
rieur droit, et le contenu de la note apparaît dans
une  bulle  lorsque  le  pointeur  de  la  souris  se

trouve simplement positionné sur la cellule (voir
copie d'écran ci-dessous).

Il faut toutefois avoir activé l'option  Outils > Op-
tions  >  OpenOffice  >  Général  >  Aide  -
Infobulles pour pouvoir bénéficier de cette fonc-
tionnalité d'affichage.

Pour modifier le texte d'une note, sélectionner la
cellule qui la contient puis relancer la commande
Insertion > Commentaire pour retrouver la cadre
permettant l'édition de la note et pouvoir la modi-
fier ou la supprimer en effaçant la totalité de son
texte.

3.4. Les valeurs
Les valeurs correspondent aux nombres, dates et
heures,  ou  encore  valeurs  monétaires utilisés
pour calculer des résultats à l'aide de formules.

Contrairement  aux  libellés  (textes),  les  valeurs
s'alignent à droite dans les cellules.

Lorsqu'une  valeur  ne  peut  s'afficher  en  totalité
dans  une  cellule,  le  signe  "###"  s'affiche  à  sa
place. Pour récupérer l'affichage correct de la va-
leur,  il  faut  augmenter  la  largeur  de  la  colonne
correspondante, par la commande Format > Co-
lonne – Largeur... ou encore par un double clic
sur le séparateur droit dans l'en-tête de la colonne
concernée. 

Les nombres
Les nombres s'écrivent à l'aide de chiffres et sans
espaces, sous peine de voir le programme consi-
dérer  la  valeur  entrée  comme  du  texte  et
d'affecter les formules qui y feraient référence (du
texte dans une formule a une valeur de zéro).

Par défaut, Calc admet la série de caractères sui-
vants pour l'écriture des nombres :

0 1 2 3 4 5 6 7 8 9 + - ( ) , / %. E e. Toute autre
combinaison de chiffres et de caractères non nu-
mériques sera considérée comme du texte. 
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3. Saisir les données

Si  on  souhaite  utiliser  d'autres  caractères  pour
écrire des valeurs numériques, par exemple l'apos-
trophe comme séparateur des milliers ou un autre
caractère comme séparateur décimal, il faut d'abord
les  spécifier  sous  Windows,  au  niveau  des  Para-
mètres régionaux.

Format numérique standard
Le format numérique appliqué à une cellule déter-
mine la forme sous laquelle la valeur entrée sera
affichée dans la cellule.

Par  défaut  (cellule  au  format  "Standard"),  les
nombres s'affichent sous forme d'entiers, de frac-
tions  décimales  (5.45)  ou  encore  de  manière
exponentielle  (5.45E+05),  et  automatiquement
sous  cette  dernière  forme si  leur  partie  entière
comprend plus de 11 chiffres, comme montré ci-
dessous.

Calc arrondit la dernière décimale affichée, mais
calcule sur la base du contenu initial non arrondi
de  la  cellule,  indépendamment  de  l'affichage,
comme montré ci-dessous.

Règles de saisie des nombres
La saisie des grands nombres, sans aucun espa-
cement  et  sans  séparateur  des  milliers,  est
toujours admise quel que soit le séparateur des
milliers adopté au niveau des  Paramètres régio-
naux  de  Windows.  Il  est  toutefois  possible  de
définir, dans ces  Paramètres régionaux, l'espace
ou un autre caractère (apostrophe, par exemple)
comme séparateur des milliers).

Pour entrer un nombre négatif, il faut le faire pré-
céder du signe "-" ou le saisir entre parenthèses.

Les  nombres décimaux  sont entrés en utilisant
le séparateur décimal choisi au niveau des Para-
mètres régionaux de Windows.  Si on se trompe
de séparateur,  le  nombre est  considéré  comme
du texte et se retrouve aligné à gauche dans la
cellule. Par défaut, les nombres décimaux sont af-
fichés avec deux chiffres après la virgule, mais le
programme  utilise  toute  la  partie  décimale  du
nombre dans ses calculs.

Les nombres en  notation fractionnaire doivent
être entrés en ménageant un espace entre la par-
tie  entière  et  fractionnaire,  afin  d'éviter  que  le
programme ne confonde l'entrée avec une date.
Après validation, le nombre fractionnaire est auto-
matiquement converti en son équivalent décimal,
qui  s'affiche sous cette  forme dans la  barre  de
calcul. Par contre, l'affichage sous forme fraction-
naire  est  maintenu au niveau de la  cellule,  qui
reçoit  automatiquement  le  format  de  nombre
"Fraction". 

– Pour afficher des fractions à deux chiffres, comme
par exemple "2 3/16", il faut modifier le format de
cellule après validation de l'entrée, en choisissant
dans la catégorie  Fraction,  le format d'affichage
des fractions à deux chiffres. 

– Les  valeurs  fractionnaires  inférieures  à  l'unité,
comme "1/5" doivent être entrées précédées du
chiffre "0" (entrer 0 1/5).

L'entrée d'un pourcentage se fait en saisissant la
valeur  du  pourcentage  suivie  du  signe  "%".  La
cellule  reçoit  automatiquement  le  format  de
nombre "Pourcentage" lors de la validation.

Dates et heures

Écriture des dates
Calc reconnaît toujours les entrées de type date
lorsqu'on les écrit avec des  / , des  - , ou encore
des  points  comme  séparateurs  entre  les  jours,
mois et années. Ainsi, les formats de saisies sui-
vants  sont  systématiquement  reconnus  comme
dates :

– 25/10/02 ou 25/10 (dans ce dernier cas, l'année
considérée par le programme sera l'année cor-
respondant à la date système).

– 17-01-99
– 11.03.02 (dans ce dernier  cas,  ne pas oublier

d'indiquer  l'année,  sous  peine  de  voir  le  pro-
gramme  confondre  la  date  entrée  avec  un
nombre comportant une partie décimale si on a
choisi le point comme séparateur décimal).

Après validation, le programme attribue automati-
quement à la cellule le format de date défini au
niveau des Paramètres régionaux sous Windows.
Le format de la date après validation peut donc
différer de son format lors de la saisie.

• Comme  toute  entrée  de  type  numérique,  une
date se trouve alignée à droite. 

• Il  est  possible  de saisir  une date et  une heure
dans  la  même cellule,  en séparant simplement
les 2 entrées par un espace.
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3. Saisir les données

Conversion des dates en numéros de 
série
En interne, Calc convertit les entrées de type date
en  numéros de série.  Ceux-ci correspondent au
nombre de jours et fraction de jour écoulés depuis
une date de référence donnée. Trois dates de ré-
férence sont proposées sous Outils > Options >
OpenOffice Calc – Calculer - Date :

– 30.12.1899 (Par défaut) : le choix de ce calen-
drier interne attribue le numéro de série 0 à la
date 30.12.1899.

– 01.01.1900 : le numéro de série 0 est attribué à
la date 1 janvier 1900.

– 01.01.1904 : le 1 janvier 1904 correspond à la
valeur 0.

Si l'on copie une date basée sur l'un des calendriers
vers un classeur basé sur un autre, la date est auto-
matiquement transposée en fonction du calendrier
interne utilisé par le classeur de destination.

En résumé, lorsqu'on saisit dans Calc une date,
celle-ci reçoit automatiquement un format de date
(ceci afin que ce soit bien une date qui s'affiche
dans la cellule et non un numéro de série), mais
en  interne,  le  programme  établit  la  correspon-
dance entre la date entrée et le nombre (numéro
de série) qui lui correspond dans son calendrier
interne. 

Ce sont ces numéros de série que le programme
utilise pour effectuer ses calculs. 

Pour retrouver le numéro de série sous-jacent à une
date entrée, il suffit de redonner à la cellule le for-
mat numérique standard.

Il résulte de ce qui précède que :

– Lorsqu'on  effectue  la  différence  entre  deux
dates, le programme effectue simplement la dif-
férence  entre  les  numéros  de  série
correspondants et retourne le nombre de jours
écoulés entre les deux dates.

– Lorsqu'on ajoute un nombre à une date, le pro-
gramme  le  rajoute  au  numéro  de  série
correspondant à la date entrée, puis il applique
un format de date au résultat du calcul.

Écriture des heures
Calc enregistre en interne les heures sous forme
de fractions décimales. Ici également, par défaut,
le  format  d'affichage de l'heure entrée est  celui
défini  dans  les  Paramètres  régionaux de
Windows.

Lors de la saisie des heures, seul le caractère ":"
est autorisé comme séparateur entre les heures,
les minutes et les secondes. Des formats de sai-
sie  systématiquement  reconnus  comme  des
entrées d'heures sont listés ci-dessous :

• 4:19 AM ; 4:19:13 PM

• 13:57 ; 15:45:03

Pour saisir une heure exprimée à l'aide d'une va-
leur comprise entre 0 et 12 (format 12 heures ou
format américain), ajoutez un espace puis AM ou
PM à la suite de l'heure. Sans cette information
supplémentaire,  le  programme  considère  qu'il
s'agit d'une heure exprimée à l'aide d'une valeur
comprise entre 0 et  24 (format 24 heures).  Par
exemple,  si  on  tape  3:00  au  lieu  de  3:00  PM,
l'heure est enregistrée sous la forme 3:00 AM. 

Valeurs monétaires
Pour  entrer  une  valeur  monétaire,  sélectionner
d'abord la cellule destinataire, puis appuyer sur le
bouton  Format  numérique :  Monétaire dans la
barre Formatage : le format monétaire préconfigu-
ré dans les Paramètres régionaux de Windows se
trouve alors automatiquement appliqué et il suffit
de saisir  la valeur  sans espaces ni  séparateurs
des milliers.

L'application  d'une  telle  préconfiguration  héritée
des paramètres régionaux définis sous Windows
peut  toutefois  s'avérer  dangereuse  en  cas  de
transmission de documents à des tiers originaires
d'autres  pays.  Pour  éviter  que,  lors  d'un  tel
échange, l'OS du destinataire  n'inscrive dans le
document original ses propres paramètres régio-
naux, en particulier un symbole monétaire et des
séparateurs de décimales et de milliers différents,
on  a  intérêt  à  bloquer  le  format  monétaire  des
feuilles de calcul en procédant comme suit :

– Lancer  la  commande  Format  >  Cellule…  –
Nombres puis sélectionner la catégorie  Moné-
taire.

– Dans la zone de liste Langue, sélectionnez une
configuration de base pour le format monétaire
et les séparateurs de décimales et de milliers.
L'option Par défaut vous renvoie au format mo-
nétaire défini au niveau de votre OS.

Dans la zone de liste  Format,  vous pourrez retou-
cher le format monétaire correspondant à la langue
que vous avez sélectionnée.
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3. Saisir les données

3.5. Rechercher/remplacer des 
données

La commande Édition > Rechercher & Rempla-

cer... (Ctrl+F) ou encore le bouton  de même
nom dans  la  barre  d'outils  Standard ouvrent  la
boîte Rechercher & Remplacer.

Le champ éditable Rechercher permet de saisir la
donnée recherchée et le champ éditable Rempla-
cer celle de remplacement.

Les boutons commande Rechercher/Rechercher
tout et  Remplacer/Remplacer  tout permettent
respectivement de lancer la Recherche et le Rem-
placement au coup par coup, c'est à dire jusqu'à
la prochaine occurrence trouvée ou, au contraire,
de l'appliquer directement à toute la sélection cou-
rante ou à l'ensemble de la feuille.

Si  on  coche  l'option  Cellules  entières,  la  re-
cherche  retourne  alors  uniquement  les  cellules
dont le contenu correspond exactement au texte
recherché.

L'option  Respecter  la  casse impose  de  tenir
compte de la  composition en majuscules et  mi-
nuscules du texte recherché.

Le bouton Plus d'options agrandit la boîte vers le
bas pour afficher des possibilités supplémentaires
avec des options qui permettent de limiter la re-
cherche à certains contenus (Formules,  Valeurs,
Notes), de lui spécifier un sens (Ligne par ligne ou
Colonne  par  colonne),  ou  encore  de  demander
l'extension de la recherche à toutes les feuilles du
classeur actif et pas seulement à la feuille active.

Parmi les options supplémentaires on trouve aus-
si : 

– Sélection active seulement : permet de limiter la
recherche à une zone sélectionnée avant le lan-
cement de la commande.

– Vers le haut : la recherche s'effectue depuis la
position courante du curseur jusqu'au début de
la feuille.

– Expressions  régulières : cette  option  doit  être
activée si le texte entré dans le champ Recher-
cher renferme  des  caractères  de  substitution
(caractères joker comme ? ou *).

– Rechercher des styles : permet d'effectuer la re-
cherche de cellules dotées d'un certain format.
Sélectionnez alors le style de cellule dans  Re-
chercher,  puis  sélectionner  un  style  de
substitution dans Remplacer par.

– Recherche  des  similarités : permet  d'effectuer
une recherche de similarités après avoir  para-
métré  les  options  de  recherche  à  l'aide  du
bouton marqué de trois points de suspension si-
tué juste à droite.

3.6. Importer des données
Il est possible de récupérer dans une feuille des
données provenant d'un fichier extérieur, situé sur
le disque dur ou sur Internet, sans passer par une
copie  de  transit  dans  le  presse-papiers  de
Windows.

Si les données à importer proviennent d'un classeur
local, elles doivent avoir été définies et nommées au
préalable.

Deux méthodes sont possibles pour réaliser l'im-
portation :

– Faire  appel  à  la  commande  Insertion > Lien
vers des données externes...qui ouvre la boîte
Données externes.

– Utiliser le Navigateur d'objets d'OpenOffice.

Insertion > Données externes
Marquez le début de la plage d'insertion en sélec-
tionnant une cellule dans la feuille destinataire de
l'importation.

– Lancez  la  commande  Insertion  >  Lien  vers
des données externes... puis indiquez dans le

© 2014 - G. Waterval Version : 19.01.14 Apache licence, Version 2.0

O O o 4 K i d s   -  A p a c h e  O p e n O f f i c e    T M   -  O O o L i g h t
Des  solutions l ibres  et  gratuites  pour votre bureautique privée et  profess ionnel le

Page 31/92 

http://www.apache.org/licenses/LICENSE-2.0
http://wiki.ooolight.org/index.php/Main_Page/fr
http://www.openoffice.org/fr/
http://www.openoffice.org/fr/
http://wiki.ooo4kids.org/index.php/Main_Page/fr


3. Saisir les données

champ éditable  URL de la source de données
externe,  le  chemin  d'accès  complet  au  fichier
source en vous aidant éventuellement du bou-
ton situé à droite du champ éditable.

– A la validation de la commande, le fichier source
se charge en arrière-plan et ses plages définies
s'affichent  dans la  zone  Feuilles/plages dispo-
nibles depuis  laquelle  il  suffit  de  choisir  les
éléments à importer avant de valider.

Utiliser le Navigateur
Vérifiez  d'abord  que  les  documents  source  et
cible sont bien ouverts.

– Depuis le document cible (dans lequel l'insertion
doit se faire), ouvrez le Navigateur et sélection-
nez  dans  sa  partie  inférieure  le  document
source dont il doit afficher les éléments dans sa
zone centrale.

– Spécifiez le mode d'insertion souhaité depuis le
bouton Mode Glisser situé dans la partie supé-
rieure droite du  Navigateur. Vous avez le choix
de mener l'insertion en tant que  hyperlien,  lien
ou copie.

– Faites alors glisser les éléments qui vous inté-
ressent depuis le Navigateur dans votre feuille
de calcul.

3.7. Recopier des données
La recopie de  données dans des  cellules  adja-
centes peut se faire vers le haut, le bas, la droite
ou la gauche, mais jamais en diagonale. La pro-
cédure peut s'effectuer à l'aide de la souris ou en
faisant appel à la commande Édition > Remplir.

Il est également possible d'insérer des listes pré-
définies  (jours  de  la  semaine,  mois,  etc.)  ou
encore d'associer  à certaines cellules des listes
d'entrées prédéfinies parmi lesquelles l'utilisateur
pourra choisir l'entrée à insérer.

A l'aide de la souris

Méthode générale
La procédure générale est la suivante :

– on commence par sélectionner la plage à reco-
pier ;

– on procède à la recopie dans la direction sou-
haitée, par un Cliquer-glisser sur la poignée de
recopie de la sélection.

Cette poignée se présente comme un petit carré
noir situé dans le coin inférieur droit de la sélec-

tion, comme montré dans la copie d'écran ci-des-
sous.

Lorsqu'on pointe dessus avec la souris, le poin-
teur prend la forme d'une croix. 

S'il  s'agit  de recopier  des  valeurs numériques,
on évitera une incrémentation ou une décrémen-
tation en procédant avec la touche Ctrl enfoncée. 

Si on ne procède pas avec la touche Ctrl enfon-
cée, on obtient une recopie incrémentée, comme
montré ci-dessous.

Recopie incrémentée
Cette fonctionnalité permet la création de séries
de valeurs qui peuvent s'incrémenter ou se décré-
menter de cellule en cellule dans un ordre donné.

La liste "Pierre, Jacques, Paul, Firmin, Eustache,
Isidore, Cunégonde" ne constitue pas une liste in-
crémentée, c'est une simple liste de noms. 

Par contre, les séries "1, 3, 5, 7, 9" ou "article1,
article2,  article3,  article4",  ou  encore  "23.04.02,
24.04.02, 25.04.02, 26.04.02" etc. en constituent
des exemples concrets.

Trois  types  de  données  sont  fréquemment  ren-
contrées  dans  des  listes  incrémentées  ou
décrémentées :

– les valeurs numériques, ainsi que les valeurs de
type dates et heures ;

– les  textes  incluant  des  nombres (précédés ou
suivis d'un nombre) comme Article 1, Article 2,
etc. En effet,  lorsqu'un nombre est présent au
début ou à la fin d'un texte, il  est possible de
créer une série où les nombres s'incrémentent
ou se décrémentent ;

– des listes prédéfinies comme les jours de la se-
maine ou les mois de l'année.

Création directe à l'aide de la poignée de recopie :

1. entrer la première valeur de la série dans une
cellule (tête de série) ;

2. valider l'entrée ;
3. poursuivre la saisie de la suite des valeurs de

la série en étirant simplement la poignée de re-
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copie  dans  la  direction  souhaitée.  Lorsqu'on
relâche le bouton de la souris, le programme
crée la série dans les cellules sélectionnées.

La fonction de recopie incrémentée utilise la valeur
de départ de la première cellule de la sélection pour
créer la série en utilisant par défaut une incrémen-
tation d'une unité à chaque fois. 

Pour appliquer une incrémentation personnalisée
à une série, il faut entrer les deux premières va-
leurs  de  la  série  avant  d'étirer  la  poignée  de
recopie pour permettre au programme de détermi-
ner le pas à adopter entre les différentes valeurs
de la série. L'amplitude du saut à introduire (va-
leur  de  l'incrément)  est  libre.  Ainsi,  la  copie
d'écran ci-dessous montre la recopie incrémentée
d'une plage contenant comme premières valeurs
24 et 29, ce qui fournit au programme une valeur
d'incrémentation de 5.

Pour  les  séries  de  types date,  heures,  mois,
jour, la première valeur doit d'être introduite avec
le format  adéquat.  À titre  d'exemple,  créez  une
série allant de A1 à A7, qui commence avec une
heure égale à 12:15, avec un incrément de 50 mi-
nutes.  Il  suffit  de  saisir  simplement  les  deux
premières valeurs de la série, puis de sélection-
ner  les  deux cellules  qui  les  contiennent  (1)  et
d'étirer la poignée de recopie jusqu'à la cellule A7
(2). 

Commande Édition > Remplir
– Sélectionner à la fois la plage à recopier et la

zone adjacente dans laquelle la recopie doit se
faire.

– Lancer la commande Édition > Remplir et choi-
sir dans son sous menu la direction de recopie
souhaitée.

Il n'est pas possible de créer une liste incrémentée
par  cette  méthode.  Seule  la  recopie  est  possible.
Pour une liste incrémentée, il faut utiliser la variante
Édition > Remplir > Série ...

Commande Édition > Remplir >
Série
Englobez dans une même sélection la tête de la
série à construire et les cellules dans lesquelles la
suite de la série doit être construite, puis lancez la
commande Édition > Remplir – Série... pour ou-
vrir la boîte de dialogue Remplir la série.

Choisissez d'abord une direction de remplissage,
puis le type de série à construire, avant de spéci-
fier la valeur finale de la série et l'incrément.

Le choix du type  Date activera les options de la
rubrique  Unité de temps,  dans laquelle il  faudra
choisir l'unité de temps utilisée pour l'incrément.

Les 3 autres types permettent de construire des
séries  numériques,  incrémentées  ou  décrémen-
tées,  moyennant  la  définition  d'un  pas
d'incrémentation/décrémentation  et  de  limites
pour la série (valeurs initiale et finale).

Les listes prédéfinies
Le programme dispose par défaut de 2 listes pré-
définies,  sous deux formats : l'une concerne les
jours de la semaine et l'autre les mois de l'année.

L'insertion d'une liste prédéfinie est très simple :
on  commence par  entrer  le  contenu de la  pre-
mière cellule de la liste, par exemple janvier, puis
on utilise la  poignée de recopie pour  insérer  la
liste dans la feuille de calcul.

Créer une liste personnalisée
Lancer la commande  Outils  > Options > Ope-
nOffice Calc – Listes de tri. La boîte qui s'ouvre
se compose de deux panneaux :

– Le panneau de gauche,  intitulé  Listes,  affiche
les listes déjà existantes.

– Le panneau de droite,  intitulé  Entrées,  permet
de saisir ou de modifier les éléments d'une liste.

Il est possible de créer une nouvelle liste en cli-
quant  sur  le  bouton  Nouveau puis  en  tapant
directement les éléments de la liste dans le volet
Entrées en utilisant la virgule comme séparateur,
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3. Saisir les données

avant  de  cliquer  sur  le  bouton  Ajouter pour  la
faire apparaître dans le volet Listes.

Vous  pouvez  également  utiliser  la  frappe  sur  la
touche  Enter pour  séparer  les  éléments  de  votre
liste en construction.

On peut également créer une liste en l'important
directement  depuis  une  feuille  de  calcul.  Pour
cela il faut que la plage de cellules contenant ses
éléments ait été sélectionnée avant le lancement
de la commande Outils > Options > OpenOffice
Calc – Listes de tri.

Dans la fenêtre qui s'ouvre, l'adresse de la plage
sélectionnée dans le champ Copier la liste depuis
et un simple clic sur le bouton Copier suffisent à
la créer et à la rajouter aux listes déjà existantes.

Pour supprimer une liste, la sélectionner le pan-
neau  Listes,  puis  cliquer  sur  le  bouton
Supprimer. 

Créer une liste de choix prédéterminée
Quand on crée des tableaux de saisie, il est pos-
sible d'interdire à l'utilisateur la saisie de certaines
valeurs dans une case ou lui permettre de choisir
son entrée parmi une liste de valeurs prédéfinies. 

Ce contrôle de validité des entrées dans une cel-
lule  se  fait  simplement  en  appliquant  à  celle-ci
des règles de validité. 

Ces  règles  de  validité  peuvent  indiquer,  par
exemple, que la saisie doit impérativement corres-
pondre à des nombres entiers compris entre telle et
telle valeur, des nombres décimaux, des dates, une
plage de cellule, un texte d'une longueur fixée, ou
encore une liste de choix présentée sous forme de
menu déroulant.

Procédez comme suit :

1. Cliquez sur la cellule à contrôler, puis lancez la
commande Données > Validité... 

2. Dans la boîte de dialogue  Validité,  sélection-
nez  Liste dans  le  menu  déroulant  Autoriser
(onglet  Critères).  Activez  l'option  Tri  des  en-
trées dans l'ordre croissant si vous voulez que
la liste soit automatiquement triée. 

3. Saisissez ensuite vos différents choix dans le
champ  Entrées,  en  allant  à  la  ligne  pour
chaque choix. Cliquez sur OK pour valider.

Si tout a bien été défini, une petite flèche apparaît
sur la droite de la cellule pour permettre d'accéder
aux choix proposés dans la liste déroulante. 

Pour affecter cette fonctionnalité aux cellules de
la colonne, recopiez la cellule vers le bas à l'aide
de la souris, puis effacez le contenu texte des cel-
lules. 

Par la suite, lors de la saisie dans cette colonne il
vous suffira à chaque fois de choisir votre valeur
dans la liste déroulante affectée à chaque cellule.

Pour  supprimer  complètement  cette  fonctionnalité
d'une cellule effacez-la par Supprimer  en choisis-
sant l'option Tout supprimer.

3.8. Contrôler la saisie de 
données

La commande  Données > Validité ... ouvre une
boîte de dialogue qui permet de spécifier des cri-
tères de validité  pour  la  saisie  de valeurs dans
une cellule ou une plage de cellules afin d'éviter à
l'utilisateur des erreurs lors de saisie.

Lorsque vous supprimer  complètement  le  contenu
d'une cellule à laquelle des critères de validité sont
associés, ceux-ci sont également supprimés. 

Onglet "Critères"
Cet onglet permet de définir la catégorie de va-
leurs  acceptées  lors  de  la  saisie  et  de  définir,
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dans le bas de la boîte, le sous ensemble de va-
leurs de la catégorie choisie qui sont acceptées.

Choisir le type de valeur acceptée
L'option Autoriser les cellules vides permet d'ac-
cepter  ou  de  refuser  la  présence  de  cellules
vides.

La liste Autoriser permet de choisir l'une des caté-
gories de données suivantes : 

– Toutes les valeurs : aucune restriction pour les
données entrées.

– Nombres  entiers : seuls  les  nombres  entiers
sont autorisés, mais pas tous, seulement ceux
satisfaisant au critère défini dans la partie infé-
rieure de la boîte.

– Nombre décimal : seuls les nombres décimaux
satisfaisant au critère défini sont acceptés.

– Date : seules les entrés de type date satisfai-
sant au critère défini sont acceptées.

– Heure : seules les entrées de type heure satis-
faisant au critère défini sont acceptées.

– Plage  de  cellules : les  valeurs  permises  sont
celles figurant  dans une plage de cellules  qui
peut  être  directement  définie  dans la  feuille  à
l'aide de la souris. Une option permet de trier ou
non les valeurs de la plage et de filtrer d'éven-
tuels doublons.

– Liste : option  permettant  de  composer  la  liste
des entrées autorisées et même de la trier. Au
final  on  obtient  une  liste  déroulante  lorsqu'on
sélectionne une cellule pour laquelle on a défini
une liste d'entrées possibles et il est alors pos-
sible  de  choisir  simplement  dans  la  liste  la

valeur à insérer .
– Longueur  du  texte : permet  de  limiter  les  en-

trées  aux  seuls  chaînes  de  caractères
satisfaisant au nombre de caractères spécifié.

Définir un critère d'acceptation pour le 
type de valeur choisie

Dans la partie inférieure de la boîte, une liste dé-
roulante Données permet de choisir un opérateur
de comparaison valide pour composer un critère
restrictif pour les valeurs du type choisi. Le champ
éditable  Valeur permet de saisir la valeur ou les
valeurs nécessaires à la définition du critère.

Si on a choisi la catégorie Liste, la partie inférieure
de la boîte affiche un cadre éditable Entrées permet-
tant  de  saisir  les  éléments  de  la  liste  qui
constitueront des entrées valides.

Onglet "Aide à la saisie"
Cet  onglet  permet  de  composer  un  message
d'aide qui  pourra s'afficher lorsque la  cellule ou
plage de cellules est sélectionnée dans la feuille
pour informer l'utilisateur sur les entrées qui sont
autorisées dans ces cellules.

Ce message se compose d'un titre et d'un conte-
nu.

C'est l'option Afficher l'aide à la saisie lors de la sé-
lection d'une cellule qui permet de décider d'afficher
ou non le message d'aide.

Onglet "Message d'erreur"
Vous  pouvez  composer  ici  le  message  d'erreur
qui apparaîtra en cas de saisie de valeur incor-
recte  et  décider  de  l'action  à  exécuter  dans ce
cas.

La liste Action propose les choix suivants :

– Arrêter : la  saisie  erronée  n'est  pas  prise  en
compte et la cellule est de nouveau prête pour
l'entrée d'un contenu correct.

– Avertissement : la  saisie  erronée est  prise  en
compte mais le message d'erreur signale à l'uti-
lisateur qu'elle n'est pas correcte.

– Information : la  saisie  erronée  est  prise  en
compte mais le message d'erreur signale à l'uti-
lisateur qu'elle n'est pas correcte.

– Macro : le  bouton  Parcourir  ... s'active  pour
vous permettre de choisir la macro à exécuter
pour avertir l'utilisateur de son erreur.

Exemple
Nous allons créer un exemple qui n'accepte, dans
une plage de cellules, que la saisie de valeurs en-
tières inférieures à 100 et qui refuse les cellules
vides.

L'onglet Critères se présente alors comme suit.
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Dans l'onglet Aide à la saisie, nous créons le mes-
sage d'avertissement qui apparaîtra lorsque nous
sélectionnons une cellule de la plage pour y en-
trer une valeur.

Le message ne s'affichera que si l'option d'affichage
du message est cochée, 

Dans  l'onglet  Message d'erreur,  nous  créons  le
message qui  s'affichera en cas  de saisie  incor-
recte, ainsi que l'action que le programme devra
exécuter dans ce cas.
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Ce  chapitre  traite  de  l'insertion  de  formules et
fonctions dans les feuilles de calcul. Cette inser-
tion  doit  se  faire  en  respectant  une  syntaxe
précise et peut être réalisée manuellement ou à
l'aide d'un assistant. 

4.1. Les formules
Les formules permettent d'effectuer des calculs à
partir  de  valeurs  contenues  dans  les  cellules
d'une feuille de calcul. Ces valeurs peuvent être
de simples données numériques ou des résultats
retournés par d'autres formules ou fonctions. 

Les formules n'intègrent généralement pas dans
leur syntaxe des valeurs elles-mêmes, mais plutôt
les  adresses des  cellules  qui  les  contiennent.
Cette façon de poser les formules permet de re-
calculer  automatiquement  les  résultats  lorsqu'on
modifie des données dans la feuille.

Les  formules  peuvent  être  entrées  directement
dans la  cellule  où doit  apparaître  le  résultat  du
calcul ou dans la partie droite de la barre de for-
mule  lorsque  la  cellule  destinataire  est
sélectionnée.

Syntaxe générale
Toute formule  commence obligatoirement  par  le
signe égal "=" suivi d'une expression détaillant le
calcul  à  effectuer,  avec  utilisation  éventuelle  de
parenthèses pour préciser  l'ordre dans lequel le
calcul doit être effectué. 

La présence du signe "=" est indispensable pour dé-
clarer  au  programme  que  le  contenu  entré
correspond bien à une formule et non à une entrée
de type texte.

Exemple : =A1+10 : affiche  la  valeur  contenue
dans la cellule A1 augmentée de 10 dans la cel-
lule sélectionnée (ici C1), qui correspond à celle
devant recevoir le résultat du calcul.

Après validation,  comme dans l'exemple ci-des-
sus, le résultat du calcul s'affiche dans la cellule
où a été introduite la formule. La formule sous-ja-
cente s'affiche dans la barre de formule lorsque la
cellule est sélectionnée.

Pour afficher dans la feuille les formules et non les
résultats, utiliser la commande : 
Outils > Options > OpenOffice Calc - Afficher
puis cochez l'option "Formules".
Lorsqu'une cellule renfermant une formule/fonction
est  sélectionnée et  qu'on clique,  dans la  ligne de
saisie  de la  barre de formule,  la  formule  apparaît
dans la cellule et affiche les adresses des cellules
concernées en couleurs différentes pour faciliter sa
lisibilité 

Opérateurs et opérandes
Une formule se présente comme une combinai-
son d'opérandes et  d'opérateurs respectant  une
certaine  syntaxe d'écriture  et  s'écrivant  toujours
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dans la  cellule  où doit  apparaître  le  résultat  du
calcul.

Opérateurs
Il y a trois types d'opérateurs possibles pour l'écri-
ture de formules :

– Opérateurs arithmétiques : * ; + ; / , %, ^ (élé-
vation à la puissance). 

– Opérateurs de comparaison : =, <, >, < >, <=,
>=. Ces opérateurs permettent la création d'ex-
pressions  retournant  l'une  des  deux  valeurs
VRAI ou FAUX.

– Opérateur de texte $ : opérateur de concaténa-
tion  de  chaînes  de  caractères.  Le  résultat
retourné est une chaîne de caractères.

Règles de priorité des opérateurs
Le programme évalue une formule de gauche à
droite,  en  respectant  les  règles  de  priorité  des
opérateurs énoncées ci-dessous. 

– Les  multiplications  et  les  divisions  ont  priorité
sur les additions et les soustractions. Attention
également aux parenthèses : la formule =1+2*3
donnera un autre résultat que =(1+2)*3. 

– Les  opérateurs  unaires  "^"  et  "%"  qui  s'ap-
pliquent  à  un  opérande  sont  prioritaires  par
rapport à tous les autres. 

– La modification de l'ordre de priorité des opéra-
teurs se fait en posant des parenthèses. Ainsi,
l'expression 7 + 2 * 4 est normalement évaluée
comme 7 + (2 * 4) dont la valeur est 56 et non
comme (7 + 2) * 4 dont la valeur est 36. Il est
souvent  prudent  d'entourer  les  sous-expres-
sions  de  parenthèses  pour  éviter  toute
ambiguïté dans l'ordre des calculs,  le contenu
des parenthèses étant évalué en premier. 

Opérandes
Les opérandes peuvent correspondre directement
à  des  valeurs,  mais  on les  fait  correspondre le
plus  souvent  aux  adresses des  cellules  ou des
plages qui les contiennent. 

Un opérande peut être lui-même une formule ou
une fonction, ce qui conduit à des expressions im-
briquées. 

La saisie d'une formule impose : 

– soit  d'écrire directement les adresses des cel-
lules contenant les valeurs qu'elle va utiliser, 

– soit de pointer les cellules concernées à l'aide
de la souris, ce qui est de loin plus confortable. 

Pour indiquer les opérations à effectuer, on tape
l'opérateur au clavier. Après validation, le résultat
s'affiche dans la cellule hébergeant la formule et
la  formule  s'affiche  dans  la  barre  de  formule
lorsque la cellule est sélectionnée.

Écrire une formule
Pour saisir une formule dans une cellule :

1. cliquez sur la cellule dans laquelle vous voulez
entrer la formule (cellule qui retournera le ré-
sultat) ;

2. tapez = (un signe égal) dans la zone d'édition
de la barre de calcul  ou directement dans la
cellule  sélectionnée.  Vous  pouvez également
cliquer sur le bouton  Fonction dans la partie
centrale de la barre de formule pour laisser le
programme se charger lui-même d'insérer  ce
signe  "=".  La  barre  de  formule  bascule  en
mode édition  et  affiche alors  les  boutons  de
validation ou d'invalidation ;

3. saisissez la  formule,  en tapant  l'adresse des
opérandes au clavier ou en les désignant par
pointage  avec  la  souris  directement  dans  la
feuille de calcul.  La saisie des opérateurs se
fait au clavier. Vous pouvez annuler à tout mo-
ment l'édition en cours par la touche Échap ;

4. appuyez sur Entrée pour valider votre formule
et quitter le mode d'édition de la barre de for-
mule. Si votre formule est définie correctement
le résultat de son calcul apparaît dans la cel-
lule.

• Vous pouvez entrer la  même formule dans une
plage  de  cellules  en  sélectionnant  d'abord  la
plage, puis, après avoir écrit la formule dans la
cellule portant le focus , en validant par la combi-
naison de touches Alt+Entrée une fois la saisie
terminée. 

• En double cliquant sur une cellule contenant une
formule,  la  barre  de  formule  bascule  en  mode
édition et vous pouvez modifier votre formule.

Formule contenant des fonctions
Une formule peut intégrer une ou plusieurs  fonc-
tions comme opérandes. Procédez comme suit :

1. cliquez sur la cellule dans laquelle vous voulez
entrer la formule ;

2. pour débuter la formule par la fonction, cliquez
sur le bouton  Fonction dans la  barre de cal-
cul ;

3. lancez  la  commande  Insertion  >  Liste  des
fonctions pour  afficher  dans  une  fenêtre  la
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liste des fonctions disponibles, puis double-cli-
quez sur la fonction à insérer dans la formule ;

4. entrez les arguments de la fonction ou pointez
leurs adresses directement dans la feuille ;

5. continuez l'édition de votre formule, en veillant
éventuellement à utiliser des parenthèses pour
éviter toute équivoque dans le calcul de la for-
mule, puis validez par Entrée. 

Formules utilisant des données externes
Il  est  possible  de  définir  des  formules  (ou  des
fonctions) utilisant  des données extérieures à la
feuille ou au classeur actif. De telles données sont
appelées références externes ou encore informa-
tions  liées lorsqu'elles  sont  intégrées  comme
arguments d'une fonction ou formule située dans
une autre feuille du même classeur ou d'un autre
classeur.

Sélectionner la cellule destinataire de la formule,
taper le signe "=", puis, après avoir tapé l'opéra-
teur ou la fonction qui doit précéder l'insertion des
données liées, effectuez l'une des procédures sui-
vantes :

– si  vous  souhaitez  créer  une  liaison  avec  une
autre feuille du même classeur, cliquez sur l'on-
glet  de  celle-ci,  puis  sélectionner  dedans  les
cellules ou la plage à lier ;

– si  vous  souhaitez  créer  une  liaison  avec  une
feuille de calcul située dans un autre classeur,
commencez par l'ouvrir, puis sélectionnez dans
ce classeur la cellule ou la plage de cellules à
lier.

Il  ne reste alors qu'à terminer l'édition de la for-
mule dans la feuille de départ,  avant  de valider
par Entrée. 

Les informations liées seront automatiquement ac-
tualisées lors de l'ouverture du fichier de destination
ou lorsque des modifications sont apportées au fi-
chier  source  lorsque  le  fichier  de  destination  est
ouvert.

Afficher ou masquer les 
formules
Par  défaut,  les  formules  et  fonctions  sont  mas-
quées  dans  les  cellules  qui  les  contiennent,  et
seuls  leurs résultats  sont  affichés.  Elles n'appa-
raissent que dans la barre de formule lorsque la
cellule qui les contient est sélectionnée.

Pour des raisons de documentation, on peut sou-
haiter  imprimer  une  feuille  de  calcul  avec  les
formules contenues dans ses cellules. 

Si  c'est  le cas,  il  faut  le demander par la com-
mande  Outils > Options > OpenOffice Calc >
Afficher (avant de lancer la commande d'impres-
sion) et activer la case à cocher Formules. 

Pour retrouver l'affichage des résultats après l'im-
pression, il suffit de relancer une nouvelle fois la
commande et de désactiver l'option Formules. 

Calculer avec des dates
Les dates (comme les heures d'ailleurs) peuvent
être  ajoutées,  soustraites  et  incluses  dans  des
calculs.

Calculer un moment

Calculer une période

Exercice
1. Créez la feuille de calcul reproduite ci-dessous
sans indiquer les valeurs de la colonne C et de la
cellule B8 car ce sont les valeurs qu'on va vous
demander de calculer.
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2. Calculez le chiffre d'affaire annuel (CA) dans la
cellule B8.

3. Calculez les valeurs de la colonne C en divi-
sant le CA de chaque trimestre par le CA annuel
calculé à l'étape précédente,  puis  en multipliant
par 100 le résultat obtenu.

4.  Sélectionnez  la  plage  C4:C7  et  réduisez  le
nombre de décimales à 2 par la commande For-
mat > Cellules > Nombre.

4.2. Les fonctions
Les fonctions  sont  des  formules  prédéfinies  qui
effectuent des calculs standards portant sur des
valeurs particulières appelées  arguments.  Le re-
cours à des fonctions vous évite de devoir créer
vous-même des formules longues et complexes.

Ainsi,  par  exemple,  la  fonction  SOMME  addi-
tionne des valeurs contenues dans des plages de
cellules tandis que la fonction VPM permet de cal-
culer  des  remboursements  de  prêts  en fonction
de leurs  taux  d'intérêt,  la  durée du prêt  et  son
montant principal (3 valeurs qui correspondent en
fait aux arguments qui lui sont nécessaires pour
effectuer son calcul). 

• Toutes les fonctions ne peuvent toutefois se dé-
composer  en  calculs  élémentaires.  Ainsi,  par
exemple, les fonctions logiques ou de recherche
n'ont pas d'équivalent sous forme de formules.

• Une  fonction  peut  constituer  une  partie  quel-
conque d'une formule.

Exemples de fonctions simples :

=ARRONDI(A1;1) : arrondit  le  contenu  de  A1  à
une décimale.

=B8-SOMME(B10:B14) : additionne  les  cellules
B10 à B14 et en soustrait la valeur de B8.

=SOMME(B8;SOMME(B10:B14)) : calcule  la
somme des cellules B10 à B14 et l'ajoute à la va-
leur de B8.

Syntaxe
Une fonction se compose d'un  nom évoquant la
plupart du temps le résultat qu'elle retourne, suivi
d'une liste d'arguments mis entre parenthèses. 

• Aucun espace ne peut être inséré entre le nom
de la fonction, les parenthèses et les arguments.

• Le nombre et le type d'arguments sont précisé-
ment définis par la syntaxe de chaque fonction.

• Certaines fonctions n'ont pas d'arguments, mais
leur nom doit néanmoins être suivi des deux pa-
renthèses, ex. la fonction AUJOURD'HUI().

La description générale d'une fonction est donc la
suivante :

Nom_fonction(Argument1;Argument2;...).

Les fonctions  ont  donc une syntaxe légèrement
différente  de  celle  des  formules,  bien  qu'elles
commencent aussi par le signe "=" : elles ne né-
cessitent  que  la  définition  des  arguments,  la
saisie  d'opérateurs  n'est  plus  nécessaire  car  la
fonction connaît la formule à appliquer. 

La syntaxe des fonctions se compose donc es-
sentiellement de deux éléments :

– le signe "=" suivi du nom de la fonction ;
– les  arguments de la fonction (ses références),

qu'on peut saisir directement au clavier ou défi-
nir par pointage dans la feuille de calcul à l'aide
de la souris. Les arguments sont enfermés dans
des parenthèses et  séparés les uns des autres
par des points-virgules. Ces arguments peuvent
correspondre à des nombres, du texte, des va-
leurs  logiques  telles  que VRAI  ou  FAUX,  des
matrices, des références (adresses des cellules
contenant les valeurs utilisées par la fonction),
des constantes, des formules ou d'autres fonc-
tions,  conduisant  alors  à  des  fonctions
imbriquées.

Insérer une fonction
Il existe deux façons de procéder pour insérer une
fonction dans une cellule :

– on peut procéder manuellement ;
– on peut recourir à un assistant.

Insertion manuelle
La méthode consiste à écrire le nom de la fonc-
tion  dans  la  cellule  destinataire,  ou  après
sélection  de  celle-ci,  directement  dans  la  zone
d'édition de la barre de formule,  à la suite d'un
signe "=",  puis  à  entrer  ses  arguments  directe-
ment  au  clavier,  ou  par  pointage à  l'aide  de  la
souris. Procédez comme suit : 

1. sélectionnez la cellule qui doit retourner le ré-
sultat de la fonction ;

2. tapez le signe "=" (sans les guillemets) puis le
nom  de  la  fonction  à  insérer.  Si  on  ne  le
connaît  pas  de  mémoire,  on  peut  appeler  la
commande  Insertion >  Liste  des fonctions
pour afficher dans une fenêtre la liste des fonc-
tions disponibles, réparties en catégories, avec
pour chaque fonction sélectionnée dans la liste
un bref descriptif  de son utilité et de sa syn-
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taxe. Pour insérer la fonction choisie dans la
cellule  sélectionnée,  double  cliquer  sur  son
nom dans la liste ou cliquer sur le bouton fx en
haut à gauche de la fenêtre après l'avoir sim-
plement sélectionnée ;

3. entrez  ensuite  les  arguments  entre  paren-
thèses (directement au clavier ou par pointage
avec la souris).  Lorsque plusieurs arguments
sont  requis,  ils  doivent  être  séparés  les  uns
des autres par le caractère ";" 

4. validez par  Entrée : le résultat retourné par la
fonction s'affiche dans la cellule.

Pour refermer la fenêtre listant les fonctions dispo-
nibles,  relancer  la  commande  Insertion  >  Liste
des fonctions (commande bascule).
Cette fenêtre est également accessible comme volet
de la barre latérale si vous utilisez AOO 4.xx.

L'Assistant Fonction
L'Assistant Fonctions est une boîte à deux onglets
qui  offre  une aide à l'insertion de fonctions.  On
peut l'appeler depuis son icône dans la  barre de

formule  ,  le  raccourci  Ctrl+F2,  ou  la  com-
mande  Insertion  >  Fonction...,  après  avoir
sélectionné la cellule destinataire de la fonction à
insérer.

Onglet Fonctions

L'onglet Fonctions est organisé en deux volets :

– le volet gauche affiche la liste des fonctions dis-
ponibles réparties en catégories dans une liste
déroulante. Le choix d'une catégorie affiche la
liste des fonctions qu'elle contient ;

– le  volet  droit  de  la  boîte  se  décompose  lui-
même en deux zones.  La  zone supérieure af-
fiche un court descriptif (nom, syntaxe d'écriture
et signification) de la fonction sélectionnée dans
le volet gauche. Un double clic sur une fonction
affichée dans le volet gauche fait apparaître des
zones de saisie pour ses arguments et active en
même temps la zone inférieure où s'affiche la
syntaxe  de  la  fonction  en  cours  d'édition.  La
zone Résultat fournit à tout moment les résultats
intermédiaires du calcul en cours d'édition et in-
dique  si  celui-ci  peut  être  effectué  avec  les
arguments saisis. Si ces derniers entraînent une
erreur, ce champ affiche alors le code de l'er-
reur.

La définition des arguments peut se faire :

– directement dans la feuille à l'aide de la souris.
Cette manière de faire est facilitée par les bou-

tons Sélectionner, qui se trouvent sur la droite
des différents champs de saisie des arguments.
Ces boutons permettent de réduire la boîte pour
faciliter  la  sélection  des  arguments  dans  la
feuille de calcul elle-même. Lorsque la boîte est
réduite, le bouton Agrandir, permet de retourner
à son affichage normal une fois la sélection ter-
minée.  La  réduction  de  la  boîte  s'obtient
également  automatiquement  dès  qu'on  sélec-
tionne par Cliquer-glisser une plage de cellules
dans la feuille de calcul. Le relâchement de la
souris  s'accompagne  d'un  retour  à  l'affichage
normal ;

– en insérant directement les arguments dans les
différents champs de la boîte, par saisie de va-
leurs numériques ou de références.

Si l'un des arguments de la fonction à définir est lui-
même une fonction, on le définira en cliquant sur le
bouton f(x). Il suffira alors de choisir la fonction à
utiliser et de définir ses propres arguments avant de
valider pour retourner à la définition de la fonction
initiale.  On  construira  ainsi  une  fonction  imbri-
quée.

Lorsque l'édition de la fonction est terminée, cli-
quez sur  OK pour produire son insertion dans la
feuille.

Onglet Structure

Cet onglet permet de visualiser la structure d'une
fonction.  L'affichage  se  fait  de  manière  hiérar-
chique : les signes + et - permettent d'ouvrir ou de
fermer les entrées des formules afin d'afficher ou
de masquer les arguments.

Les arguments corrects sont représentés par un
point  bleu  et  les  incorrects  par  un  point  rouge.
Ainsi, par exemple, un texte introduit comme ar-
gument  d'une  fonction  statistique  apparaîtra  en
rouge puisqu'une telle fonction n'autorise que des
arguments de type nombre.

Fonctions imbriquées
Vous  pouvez  utiliser  le  résultat  d'une  fonction
comme  argument  d'une  autre  fonction  et
construire ainsi une  fonction imbriquée. Dans ce
cas, vous devez commencer par la fonction qui
doit être calculée en dernier. 

Dans  l'exemple  ci-dessous,  nous  calculons  la
moyenne de la plage B2:B5 et l'utilisons comme
argument pour la fonction ARRONDI, afin de pou-
voir par la suite n'utiliser que la valeur arrondie du
calcul de la moyenne. 
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La fonction MOYENNE est alors imbriquée dans
la fonction ARRONDI.

4.3. Copie de formules et de 
fonctions

Lorsque le contenu de la cellule à copier est une
formule ou une fonction, le programme le recopie
en considérant la position des opérandes comme
relative à la position de la formule.

Lorsque la recopie d'une formule doit se faire dans
des cellules adjacentes, on utilise la poignée de re-
copie pour la réaliser à l'aide de la souris.
L'adaptation des références de cellules lors de la co-
pie d'une formule est identique, que la formule ait
été copiée à l'aide de la souris (avec la touche Ctrl
enfoncée), du presse-papiers ou de la poignée de re-
copie.

Adressage relatif
Lorsqu'on recopie une formule une ou deux cases
vers la droite, les adresses des cellules référen-
cées  se  trouvent  automatiquement  décalées  de
une  ou  deux  cases  vers  la  droite,  comme  le
montre l'exemple ci-dessous. 

Ce comportement par défaut utilisé par Calc pour
la  recopie des  formules  et  fonctions  est  appelé
adressage  relatif.  Ainsi,  A1  désigne  dans  une
formule une référence relative à la cellule A1.

L'exemple ci-dessus montre l'utilité de la fonction
de recopie de formule dans un tableau. On insère
la  fonction  SOMME  en  B7,  puis  on  la  recopie

deux cases vers la droite à l'aide de la souris et
de la poignée de recopie. Dans ce cas, pas de
problème avec l'adressage, il est relatif. 

Lors  du  déplacement d'une  formule,  les  réfé-
rences de cellules relatives ne sont pas adaptées à
la nouvelle position de la formule.
Lors du déplacement d'une plage calculée, la for-
mule reste liée à la plage (puisqu'elle en fait partie)
et  les  références  relatives  sont  automatiquement
adaptées à la nouvelle position de la plage 

Adressage absolu
Il peut arriver que lors de la recopie d'une formule
ou  d'une  fonction,  l'un  des  opérandes  corres-
ponde à une cellule "fixe" de la feuille de calcul.

Dans ce cas, afin d'éviter que l'adresse de la cel-
lule  pointée  ne  soit  décalée  relativement  à  la
nouvelle position occupée par la formule/fonction
recopiée,  il  faut  fixer  sa position  par  un  adres-
sage absolu dans la formule. Pour ce faire, on
note  l'adresse de cette  cellule  avec  des  signes
dollars $, un devant le numéro de ligne et un de-
vant  la  lettre  identifiant  la  colonne.  Ainsi,  un
adressage absolu de la cellule A1 s'écrira: $A$1.
On écrira de même :

• $A$3 : pour une référence absolue à la cellule
A3.

• $A$1:$B$2 : pour référencer la plage A1:B2 de
manière absolue.

Dans l'exemple ci-dessous, des résultats erronés
s'affichent  dans  la  plage  C5:C7  car  tous  les
adressages sont relatifs. Or ici, les formules reco-
piées dans les cellules de la plage C5:C7 doivent
toutes pouvoir  accéder au contenu de la cellule
B8. La référence à la cellule B8 ne doit donc pas
changer lors de la recopie de la formule C4 dans
la plage C5:C7, elle doit être absolue (fixe).

Ci-dessous la correction à apporter  dans la for-
mule en C4. La cellule B8 est rendue référence
absolue dans la formule.
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Références mixtes
Les références peuvent combiner les caractères
relatif  et  absolu.  On  parle  alors  de  références
mixtes. Ainsi, $A1 représente une référence ab-
solue  à  la  colonne,  mais  relative  à  la  ligne,
pointant sur A1.

Le tableau ci-dessous calcule les suppléments de
salaire perçus lors de l'exécution d'heures supplé-
mentaires de différents tarifs. On voit que :

– Les références aux différents tarifs sont mixtes
(colonne relative, ligne fixe).

– Les références aux  nombres  d'heures  supplé-
mentaires  prestées  sont  également  mixtes
(colonne fixe, ligne relative).

On commence par poser la formule en B4, en-
suite on la recopie jusqu'en B8, puis on recopie
vers la droite la plage B4:B8.

Conversion relatif/absolu 
Lors de l'édition d'une formule/fonction, ses réfé-
rences  peuvent  être  aisément  converties  de
relatives en absolues, après y avoir placé le cur-
seur, à l'aide du raccourci Maj+F4.

Ainsi,  si  la  cellule  A1  est  pointée  comme réfé-
rence :

– Un premier appel au raccourci la transformera
en référence absolue $A$1 

– Un second appel en fera A$1 
– Un troisième appel aboutira à $A1 

– Un quatrième appel restituera la référence rela-
tive A1 d'origine.

Exemple 1
L'exemple  ci-dessous  illustre  la  différence  de
comportement au cours de la recopie entre une
formule  utilisant  des  adresses  relatives  et  la
même formule faisant appel à un adressage ab-
solu.

– Formule en B5 : =B2-B3 (adressage relatif)

– Formule en C5 : =$B$2-$B$3 (adressage abso-
lu)

Recopions  B5  en  B6 : le  résultat  est  faux  car
l'adressage  de  la  formule  étant  relatif,  le  pro-
gramme a adapté les références en fonction du
déplacement de la formule une ligne vers le bas.
Il  en résulte qu'en B6 on trouve la  formule sui-
vante : =B3-B4, dont l'un des opérandes, B4 se
trouve être une cellule contenant du texte, ce qui
génère un message d'erreur dans la cellule B6.

La recopie de C5 en C6 ne pose par contre pas
problème : l'adressage  étant  absolu,  les  réfé-
rences de la formule recopiée n'ont pas changé. 

Exemple 2 (références mixtes)
Partons de l'exemple d'une table de multiplication.
Dans la ligne 1 on crée une série 1 à 5 et on la re-
produit dans la colonne A.

En  B2,  nous  devons  introduire  la  formule
"=A2*B1" et  la recopier  vers la droite jusqu'à la
cellule E2. Pour éviter qu'au cours de la recopie
vers  la  droite  il  y  ait  incrémentation  des  réfé-
rences  de  colonnes,  devenant  successivement
B2, C2, D2, on va figer la référence de colonne A
en introduisant le signe $ devant le A dans l'écri-
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ture  de  la  référence  A2.  Notre  formule  s'écrira
donc " =$A2*B1" (sans les guillemets). 

Pour  recopier  la  formule de B2 vers  le  bas,  ce
sera cette fois la référence de ligne du terme B1
qu'il faudra fixer (B$1). La formule correcte à insé-
rer  dans  la  cellule  B2  sera  donc  finalement :
"=$A2*B$1" (sans les guillemets) et cette formule
pourra alors être recopiée dans l'ensemble du ta-
bleau  pour  nous  fournir  notre  table  de
multiplication. 

4.4. Fonctions usuelles
Ci-dessous une liste non exhaustive de quelques
fonctions courantes.

Fonction SI
La  fonction  SI permet  de  soumettre  l'exécution
d'une formule à la satisfaction d'une condition. Si
celle-ci est vraie, la formule est exécutée, dans le
cas contraire, elle ne l'est pas ou c'est une autre
fonction qui est exécutée en cas de fonctions im-
briquées.

Partons  d'un  exemple  concret.  Votre  système
qualité vous impose d'effectuer tous les mois un
certain  nombre  de  contrôles  sur  divers  instru-
ments. Vous pouvez dans ce cas, pour ne pas les
oublier, créer une feuille de calcul listant :

– dans la colonne A intitulée Instruments, les diffé-
rents  appareils  à  contrôler  mensuellement,
Appareil 1, 2, 3,..., n ;

– dans la colonne B, intitulée Dernier contrôle, les
dates des derniers contrôles effectués ; 

– dans la colonne  C,  intitulée  Prochain contrôle,
vous  posez  une  formule  qui  calculera,  pour
chaque instrument, la date du prochain service
à effectuer, en se basant sur la date du précé-
dent contrôle. Cette date s'obtiendra en ajoutant
simplement  30  jours  à  la  date  du  dernier
contrôle effectué.

– dans la colonne D, intitulée Status, on affiche en
permanence l'état des travaux de contrôle des
instruments : "OK" s'affichant si la date du pro-
chain  entretien  n'est  pas  atteinte,  "LATE"  si
celle-ci est atteinte, voire dépassée.

Notre feuille aura l'aspect  général  suivant,  avec
en A1 la date du jour de cette copie d'écran.

Posons maintenant en C3 et D3 les formules et
fonctions  adéquates,  puis  recopions  les  vers  le
bas de notre feuille.

Formule en C3
 = B3+30 

Fonction en D3
= SI(C3<AUJOURDHUI();"LATE";"OK"), ce que 
nous traduirons par : "Si la date affichée en C3 
est inférieure à la date d'aujourd'hui (22.10.02 
dans notre exemple), écris en D3 LATE, sinon 
écris OK". 

MAX, MIN, MOYENNE, NB
Ces fonctions permettent de déterminer la valeur
maximale, minimale et la moyenne d'une série de
valeurs. 

La fonction NB retourne le nombre de cellules ren-
fermant une valeur numérique, et son résultat est
utilisée  comme  argument  dans  le  calcul  de  la
moyenne des valeurs.

Fonction NB.SI
La fonction NB.SI détermine le nombre de cellules
non vides d'une plage, répondant à un critère. 

Syntaxe : =NB.SI(Plage;Critères)

Dans  l'exemple  ci-dessous,  on  recherche  le
nombre de valeurs dans une plage qui sont stric-
tement inférieures à 40.  La valeur retournée en
A5 est 5.
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4. Formules et fonctions

La fonction NB compte le nombre de valeurs re-
présentées dans une plage.

Fonctions NB.VIDE et NBVAL
La  fonction  NB.VIDE  permet  de  calculer  le
nombre de cellules vides dans une plage de cel-
lules.  Par  exemple,  pour  afficher  le  nombre  de
cellules vides présentes dans une sélection allant
de  B2  à  E13,  on  insère  la  fonction : =
NB.VIDE(B2:E13).

Dans certains calculs complexes de moyennes par
exemple,  il  est  nécessaire  que  toutes  les  cellules
soient  remplies.  On  peut  alors  utiliser  la  fonction
NB.VIDE dans une formule "SI". 
La formule ci-dessous teste la présence de cellules
vides. Elle affiche un message d'erreur si  il  existe
des cellules vides. Sinon, elle affiche la moyenne: 
=  SI(NB.VIDE(B2:E13)>0;"Calcul  impossible,  il  y  a
des cellules vides";MOYENNE(B2:E13)))

La fonction NBVAL renvoie le nombre total d'en-
trées  (chiffres,  textes,  etc.)  dans  la  plage  de
cellules sélectionnée.

Fonction SOMME
Cette fonction permet d'additionner, par exemple
en C4, les valeurs contenues dans une plage sé-
lectionnée,  par  exemple,  la  plage  (A1:C3).  La
fonction  pourra  être  posée  de  diverses  façons,
après avoir sélectionné la cellule C4 :

– Manuellement, en tapant dans la barre de calcul
=SOMME(A1:C3). Vous pouvez également sé-
lectionner  la  plage  à  la  souris,  ce  qui  vous
évitera  de  devoir  taper  son  adresse  dans  la
barre de formule. 

– En cliquant directement sur le bouton SOMME
dans la barre de formule, la fonction est auto-
matiquement  introduite  et  le  calcul  est
généralement proposé pour la plage de cellules
situées au dessus de la cellule dans laquelle la

fonction SOMME est introduite. Cette plage se
trouve entourée d'un cadre bleu dans la feuille
de calcul.  Si  la zone proposée correspond au
calcul à effectuer, il suffit de valider par Enter. Si
au  contraire,  la  proposition  faite  par  le  pro-
gramme  ne  convient  pas,  vous  devez  lors
sélectionner la plage correcte directement dans
la feuille avant de valider la fonction. 

– Une troisième solution consisterait à insérer la
fonction à l'aide de l'Assistant Fonction.

Fonction ARRONDI
Syntaxe : ARRONDI(nombre;nombre)

La fonction arrondit la valeur  nombre à la valeur
indiquée dans le deuxième argument nombre, se-
lon les règles suivantes :

– Les chiffres inférieurs à 5 sont arrondis à l'unité
inférieure et ceux supérieurs à 5 à l'unité supé-
rieure. 

– Une valeur négative dans le second argument
nombre produit l'arrondissement à une position
correspondante avant le séparateur décimal.

Exemple Résultat

=ARRONDI(8.1412;1) 8.1

=ARRONDI(-27.446;2) -27.45

=ARRONDI(27.446;2) 27.45

=ARRONDI(28.342;0) 28

=ARRONDI(1183;-2) 1200

• Les fonctions ARRONDI.INF et ARRONDI.SUP uti-
lisent  les  mêmes  arguments  que  la  fonction
ARRONDI. Elles permettent de définir si un chiffre
à la position donnée doit être arrondi à l'unité su-
périeure ou inférieure.

• Pour arrondir un nombre décimal à l'entier immé-
diatement  inférieur,  on  peut  utiliser  la  fonction
ENT(nombre).  Ainsi,  la fonction =ENT(76.88) re-
tourne le résultat 76.

RECHERCHEV et RECHERCHEH
La fonction RECHERCHEV recherche une valeur
dans la première colonne d'un tableau, puis ren-
voie, une valeur située dans la même ligne, mais
à partir  d'une colonne que vous indiquez.  Cette
fonction s' utilise donc pour rechercher une valeur
dans un tableau disposé en colonnes, lorsque les
critères de recherche se trouvent  dans une co-
lonne située à gauche des données recherchées
et qu'on veut récupérer une valeur située dans la
même ligne, mais n colonnes à droite. 
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Syntaxe : =RECHERCHEV(critère de 
recherche;matrice;Indice;ordre de tri)

La fonction RECHERCHEH recherche une valeur
dans  la  ligne  supérieure  d'un  tableau,  puis  re-
tourne  le  contenu  de  la  cellule  située  dans  la
même colonne, mais à partir de la ligne que vous
indiquez. Cette fonction s'utilise pour rechercher
une  valeur  dans  un  tableau  disposé  en  lignes,
lorsque  les  critères  de  recherche  sont  situées
dans une ligne en haut de la table de données et
qu'on  veut  récupérer  une  valeur  située  dans  la
même colonne, mais n lignes plus bas. 

Syntaxe : =RECHERCHEH(critère de 
recherche;matrice;Indice;trié)

Il  est  nécessaire  de  déclarer  le  tableau  en  réfé-
rences absolues pour éviter tout problème lors de la
recopie des formules. On peut aussi nommer le ta-
bleau des références.
RECHERCHEV
Si la valeur du quatrième argument "ordre de tri"
est 0, la première colonne sur la gauche du tableau
exploité ne doit pas être triée (comme dans notre
exemple). Si on ne renseigne pas de valeur ou qu'on
met la valeur à 1, la première colonne doit être triée
(tri ascendant).
RECHERCHEH
Si la valeur du quatrième argument "trié" est 0, la
première ligne du tableau exploité ne doit pas être
triée  (comme dans notre  exemple).  Si  on  ne ren-
seigne pas de valeur ou qu'on met la valeur à 1, la
première ligne doit être triée (tri ascendant).
Dans les deux cas, la récupération de la valeur re-
cherchée se fait dans une cellule d'un autre tableau,
qui peut correspondre à une facture, par exemple.

Exemple d'utilisation
Pour mieux comprendre l'utilité de ces deux fonc-
tions, nous allons partir d'un exemple.

On suppose qu'on se trouve au rayon fruits et lé-
gumes d'un supermarché. Les différents produits
y sont disposés dans des caisses portant un nu-
méro de Référence et un Prix unitaire (100 g). Les
tableaux  RECHERCHEV  et  RECHERCHEH
montrent les deux dispositions possibles pour un
tableau répertoriant les fruits et légumes mis en
vente avec leur numéro de référence et leur prix
unitaire.

Nous choisissons, par exemple quelques tomates
et les posons sur le plateau de la balance. Nous
indiquons le numéro de  Référence de notre pro-
duit  et  la  balance  nous  recherche  le  Nom du
produit correspondant, mesure la  Quantité (g) de
marchandise et calcule le Total à payer. 

Pour ce faire, elle établit la correspondance entre
la Référence (numéro qu'on a entré) et le Nom du
produit (recherche1) et récupère son Prix unitaire
(recherche2)  en  exploitant  les  données  figurant
dans l'un des deux tableaux source selon le type
de fonction de recherche qu'elle utilise. Elle cal-
cule  alors  le  Total à  payer,  en  fonction  de  la
Quantité qu'elle a pesée et du Prix unitaire du pro-
duit, qu'elle a récupéré par la seconde fonction de
recherche. Le travail effectué au niveau de la ba-
lance  est  représenté  par  le  formulaire  de
recherche de notre exemple. 

Utilisation de deux feuilles de calcul
Les fonctions RECHERCHEV et RECHERCHEH
sont beaucoup utilisées dans les factures.

Dans ce genre d'utilisation, il est tout à fait pos-
sible d'utiliser deux feuilles de calcul distinctes, la
première comportant la  facture proprement dite,
avec  des  fonctions  de recherche exploitant  une
seconde  feuille  de  tarifs contenant  les  réfé-
rences,  les  désignations  et  les  tarifs  unitaires
disposés en lignes ou colonnes selon le type de
formule de recherche utilisé dans la facture.

Fonctions DATE et HEURE

Conversion en numéro de série 

– DATE(Année;Mois;Jour) : renvoie le numéro de
série correspondant à une date donnée.

– DATEVAL(Date_texte) : numéro de série corres-
pondant à une date donnée en format texte.
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– TEMPS(Heure;Minute;Seconde) : numéro  de
série pour une heure exprimée en heures, mi-
nutes et secondes.

– TEMPSVAL(Heure_texte) : convertit  une heure
représentée sous forme de texte en numéro de
série. 

Extraction d'une composante date/heure 

– ANNEE(Numéro_de_série) : retourne  l'année
correspondant au numéro de série entré comme
argument.

– MOIS(Numéro_de_série) : renvoie  le  mois  de
l'année (compris  entre 1 et  12)  correspondant
au numéro de série entré comme argument.

– JOUR(Numéro_de_série) : renvoie  le  jour  du
mois correspondant au numéro de série entré
comme argument.

– HEURE(Numéro_de_série) : renvoie  l'heure
(comprise entre 0 et 23) correspondant au nu-
méro de série passé comme argument.

– MINUTE(Numéro_de_série) : renvoie la minute
(comprise entre 0 et 59) correspondant à l'argu-
ment numéro_de_série.

– SECONDE(Numéro_de_série) : renvoie  la  se-
conde  (entre  0  et  59)  correspondant  à
l'argument numéro_de_série. 

– JOURSEM(Numéro_de_série;Type_retour) :
renvoie le jour de la semaine (de 1 à 7) corres-
pondant à l'argument numéro_de_série 

Date ou heure actuelle 

– AUJOURDHUI() : retourne la date courante.
– MAINTENANT() : retourne la date du jour avec

l'heure courante. 

Autres fonctions 

– JOURS360(Date_début;Date_fin;Méthode) : re-
tourne le nombre de jours compris entre deux
dates sur la base d'une année de 360 jours. 

– NB.JOURS.OUVRES(Date_départ;Date_fin;Jou
rs_fériés) : renvoie le  nombre de jours ouvrés
compris entre deux dates. 

Fonctions dans la barre d'état
La barre d'état propose dans un menu accessible
d'un  clic  droit  de  souris,  une  liste  de  fonctions
simples permettant d'effectuer rapidement un cal-
cul sur une plage sélectionnée.

Dans ce cas, le résultat ne s'affiche que dans la
barre d'état et ne modifie aucunement la feuille de
calcul.  Par  défaut,  c'est  la  fonction SOMME qui
est active. 

4.5. Rechercher les erreurs
Calc dispose de fonctionnalités qui facilitent la dé-
tection  d'erreurs  dans  les  formules  et  les
fonctions.

Types d'erreurs
La saisie de formules et fonctions et leur modifica-
tion peuvent s'accompagner d'erreurs : références
circulaires, fautes de syntaxe ou logiques.

Références circulaires
Elles  surviennent  lorsque  des  formules  ou  des
fonctions font référence à elles-mêmes. 

Elles apparaissent généralement à la suite de mo-
difications de la structure de la feuille (insertion ou
suppression de cellules, lignes et colonnes et de
leurs contenus). L'exemple ci-dessous montre ce
qui  peut  arriver  lorsqu'on effectue des modifica-
tions dans une feuille de calcul. 

Étape 1 : on calcule en A7, la somme de la plage
A3:A6.

Étape 2 : on recopie la plage A3:A7 vers la droite,
puis on supprime la valeur contenue en B6, le re-
calcul  se fait  automatiquement  et  on obtient  un
résultat correct en B7.
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Étape 3 : on recopie la plage B3:B7 vers la droite,
puis on déplace la cellule C7 d'une case vers le
haut, dans la cellule C6. On crée ainsi une réfé-
rence circulaire, car la fonction SOMME se trouve
maintenant dans une cellule dont la référence fait
partie de ses arguments. On obtient donc un mes-
sage d'erreur dans la cellule concernée ainsi que
l'affichage du message "Erreur : référence circu-
laire"  dans la  barre  d'état  lorsque la  cellule  est
sélectionnée.  Pour  corriger,  il  faut  redéfinir  la
plage calculée par la fonction SOMME en C6.

Erreurs de syntaxe
Elles sont immédiatement détectées après la sai-
sie et signalées par différents messages, selon la
formule.  Elles  résultent  de  fautes  de  frappe  ou
d'espaces introduits par erreur après une paren-
thèse  ouvrante  ou  avant  une  parenthèse
fermante, par exemple.

En  double  cliquant  sur  la  cellule  incriminée,  la
syntaxe de la fonction apparaît et on peut la corri-
ger  manuellement  avant  de  valider  la  version
corrigée par Enter.

Fautes logiques
Elles surviennent lorsque les références de cel-
lules  utilisées  ne  sont  pas  adaptées  pour
l'obtention des résultats escomptés.

Un double clic sur la cellule incriminée affichera la
syntaxe de sa formule et permettra la correction.

Signalisation des erreurs
Calc affiche des messages aux endroits où des
formules incorrectes sont insérées pour vous per-
mettre de les corriger plus facilement.

– ##### : le contenu ne peut s'afficher en entier
dans la cellule, il faut régler la largeur de la co-
lonne.

– #REF! : problèmes avec les références de cel-
lules.

– #DIV/0! : tentative de diviser par 0. Vérifier les
références. 

– #NOM? : noms de cellules ou de plages de cel-
lules référencées incorrects.

– #NUL! : références de cellules introuvables. Vé-
rifier les références.

– #N/A : références  possibles  à  des  cellules
vides. Vérifier la formule.

– #VALEUR! : le type d'argument ne correspond
pas à la syntaxe de la formule. Vérifier les argu-
ments de la formule ou fonction.

– #NOMBRE! : vérifier  si  les  arguments  se
trouvent dans les plages numériques correctes.

En double cliquant  sur une formule/fonction,  les
cellules  ou  plages  des  antécédents  s'entourent
d'un cadre et la syntaxe de la formule s'affiche à
l'intérieur de la cellule pour permettre de la modi-
fier,  comme  montré  dans  la  copie  d'écran  ci-
dessus avec une fonction MOYENNE. Pour annu-
ler cet affichage, appuyer sur Échap.

Audit des formules/fonctions
Cette fonctionnalité permet de vérifier à tout mo-
ment les références de cellules utilisées dans les
formules  et  fonctions  en  affichant  les  relations
entre les différentes cellules.

Cette fonctionnalité est particulièrement utile pour
vérifier des feuilles de calculs de taille importante,
dépassant les capacités d'affichage de l'écran.

L'activation de cet outil permet de relier, à l'aide
de flèches de couleurs, une cellule contenant une
formule ou fonction à celles contenant ses réfé-
rences ou à celles qui utilisent le résultat de son
calcul. 

Le principe d'utilisation est simple. On sélectionne
une cellule renfermant une formule/fonction puis
on active la commande souhaitée.
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4. Formules et fonctions

La  copie  d'écran  ci-dessous  montre  ce  qu'il  se
passe lorsqu'on active la commande Repérer les
erreurs après avoir sélectionné une cellule qui en
renferme.  Ainsi  la  cellule  C8 contient  une  réfé-
rence  circulaire  qui  est  alors  marquée  d'un
symbole rouge et la cellule C9 renferme une divi-
sion par  0.  Dans ce dernier  cas,  le  programme
trace des flèches en bleu depuis les références
(antécédents) vers la formule pour aider l'utilisa-
teur à mieux voir le problème et le corriger.

Pour supprimer tous les marquages, utilisez sim-
plement  la  commande  Supprimer  tous  les
repères.

L'audit vous permet également de pointer : 

– vers  les  antécédents,  c'est  à  dire  les  cellules
auxquelles fait référence la formule/fonction) ;

– vers les  dépendants,  c'est à dire vers les cel-
lules  qui  se  réfèrent  au  résultat  de  la
formule/fonction  que  vous  avez  sélectionnée,
comme  montré  dans  la  copie  d'écran  ci-des-
sous.

La formule C11 a pour antécédents A3 et A7.

Le résultat retourné en C7 est utilisé par la fonc-
tion ARRONDI.SUP en C10.

Les commandes Supprimer le repérage des an-
técédents/dépendants permettent de supprimer
sélectivement les repères.

En double-cliquant sur les flèches, vous pouvez ac-
céder directement aux antécédents ou dépendants,
ce qui s'avère particulièrement pratique si ces cel-
lules ne sont pas visibles dans la partie de la feuille
affichée.

Marquer les données incorrectes : entoure en
rouge toutes  les cellules  de la  feuille  contenant
des données non conformes aux règles de validi-
té  définies  dans  la  commande  Données  >
Validité ....

Dans l'exemple ci-dessous, nous avions demandé
que la plage A3:A11 ne contiennent que des en-
tiers positifs. Nous obtenons donc ce qui suit en
lançant la commande d'Audit  Marquer les don-
nées incorrectes.

Actualiser  les  repères : redessine  tous  les  re-
pères  de  la  feuille.  Les  formules  modifiées
pendant  que  les  repères  sont  redessinés  sont
prises en compte.

Actualisation automatique : actualise automati-
quement tous les repères de la feuille chaque fois
qu'on modifie une formule.
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Mode Remplissage : lorsque ce mode est activé,
le pointeur de la souris change de forme et en cli-
quant sur n'importe quelle cellule on affiche une
flèche de repère jusqu'à  la  cellule  antécédente.
Pour  quitter  ce  mode,  appuyez  sur  Échap ou,
dans le menu contextuel, sur la commande Quit-
ter le mode Remplissage.

4.6. Nommer les cellules et les 
plages

Il  est  possible de référencer une cellule ou une
plage de cellules par un nom. Un tel référence-
ment améliore la lisibilité des formules en rendant
les adresses utilisées dans leur  définition moins
abstraites.

Depuis la barre de formule
1. Sélectionner la cellule ou la plage à nommer.
2. Cliquer dans la Zone de nom de la  barre de

formule et remplacer l'adresse de la sélection
par un nom.

– Valider par Enter.

Il est alors possible d'accéder d'un simple clic aux
plages  nommées  car  elles  sont  listées  dans  la
Zone de nom de la barre de formule 

• Pour renommer une plage, la sélectionner et lui
donner un autre nom.

• Pour  supprimer un  nom  existant  vous  devez
obligatoirement passer par la commande  Inser-
tion > Noms > Définir ... et le supprimer de la
liste dans la boîte de dialogue.

Boîte "Définir des noms"
1. Sélectionner la cellule ou la plage (monobloc)

à nommer.
2. Lancer la commande Insertion > Noms – Dé-

finir...
3. Dans la boîte qui s'ouvre, saisir le nom à attri-

buer à la plage/cellule dans le champ éditable
Nom.  Un nom de plage doit débuter par une
lettre  de  l'alphabet  et  ne  peut  contenir  d'es-
paces. Le caractère "trait bas" sera utilisé pour
relier les différentes parties d'un nom.

4. Dans le champ Assigné à, sélectionner la cel-
lule ou la plage à nommer, si on ne l'a pas fait
avant de lancer la commande. Un bouton per-
met  de  réduire  la  boîte  pour  permettre  de
définir la plage à nommer directement dans la
feuille par pointage à l'aide de la souris.

5. Cliquer sur le bouton  Ajouter pour ajouter le
nouveau nom à la liste.

6. Valider la commande par OK.

La boîte de dialogue permet également de :

– Supprimer un nom défini  antérieurement en le
sélectionnant dans la liste puis en cliquant sur
Supprimer avant de valider par OK.

– Redéfinir, dans le champ Assigné à, une plage
associée  à  un  nom.  On  peut  la  redéfinir  par
pointage dans la feuille après avoir cliqué sur le

bouton 

• Les noms de plages ou de cellules définis dans le
classeur  actif  apparaissent  dans  la  liste  dérou-
lante  Zone de nom située sur  la  gauche de la
barre de formule.

• On les retrouve également listés dans la rubrique
Noms de plage dans le Navigateur d'objets. 

Création automatique de noms
La  commande  Insertion  >  Noms  >  Créer  ...
ouvre une boîte de dialogue permettant d'utiliser
les  titres  de  colonnes  ou  de  lignes  de  la  FC
comme noms pour les cellules correspondantes.
La méthode est la suivante : 

1.  On sélectionne les cellules à nommer,  en in-
cluant dans la sélection les titres de lignes ou de
colonnes, puis on lance la commande Insertion >
Noms > Créer ...

2. Dans la boîte qui s'ouvre, on coche l'option cor-
respondant à la ligne ou la colonne contenant les
noms à utiliser.

3. On valide la commande.
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4. Formules et fonctions

La copie d'écran ci-dessous illustre la méthode. 

– On sélectionne la plage B3:C6 puis on lance la
commande Insertion > Noms > Créer ....

– Dans  la  boîte  on  coche  l'option  Ligne  supé-
rieure pour récupérer les noms à partir de cette
ligne. A la validation de la commande, la plage
B4:B6  reçoit  le  nom  Prix  unitaire  et  la  plage
C4:C6 reçoit le nom Quantité.

– On  effectue  ensuite  en  D4  le  calcul :
=Prix_unitaire*Quantité et  on recopie vers le
bas.

Si  vous saisissez  votre  formule  manuellement,  at-
tention à bien écrire Prix_unitaire avec le trait bas
pour éviter une erreur de syntaxe !
Si vous utilisez la commande Insertion > Noms >
Insérer  ... pour  insérer  les  arguments  nommés
dans vos fonctions, vous n'aurez pas ce problème.
En effet, la boîte qui s'ouvre affiche les plages nom-
mées  définies  pour  le  classeur  et  leurs  noms
obéissent bien à la syntaxe requise.

Insérer des noms dans une 
formule
La  commande  Insertion  >  Noms >  Insérer  ...
ouvre une boîte listant les noms définis dans le
classeur  pour  pouvoir  les  insérer  dans une for-
mule  ou  une  fonction  en  cours  d'édition.  La
commande permet encore de créer une liste des
noms utilisés dans le classeur actif. 

– Sélectionner une cellule vide dans la feuille.
– Lancer la commande Insertion > Noms > Insé-

rer ...pour ouvrir la boîte Insérer un nom.

– Cliquer  sur  le  bouton  Insérer  tout.  L'insertion
de la liste  se fait  dans la feuille  comme dans
l'exemple ci-dessous.

Attribuer un nom à une 
constante
Il  est également possible d'attribuer des noms à
des  valeurs  constantes  sans  devoir  les  entrer
dans une cellule de la feuille  de calcul.  Ci-des-
sous un exemple, avec la TVA (6%).

– Lancez la commande Insertion > Noms > Défi-
nir ...

– Dans la boîte de dialogue Insérer des noms, en-
trez  le  nom  de  la  constante  dans  le  champ
éditable Nom.

– Dans le champ éditable Assigner à, introduisez
la valeur de la constante (ex. =6%), puis cliquez
sur le bouton  Ajouter et validez par le bouton
OK pour refermer la boîte.
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Les options de mise en forme à disposition dans
Calc permettent essentiellement de formater deux
types d'éléments :

– les cellules (et leur contenu) ;

– les feuilles de calcul elles-mêmes, dans le but
de  pouvoir  obtenir  des  sorties  imprimées  sur
des pages d'impression de format donné.

5.1. Les propriétés des cellules
Les différentes options de mise en forme de cel-
lules sont regroupées dans la boîte de dialogue
Formatage des cellules qui s'ouvre à l'appel de la
commande Format  >  Cellule... ou  depuis  le
menu contextuel d'une sélection. Cette boîte re-
groupe dans 7 onglets les différentes options de
mise en valeur applicables aux cellules et à leur
contenu.

Les principales options de mise en forme sont égale-
ment  disponibles  sous  forme  de  boutons  dans  la
barre d'outils Formatage, permettant une réalisation
plus simple et plus rapide des travaux courants de
mise en forme.

Formats numériques
L'application d'un format numérique ne change en
rien la valeur réelle du nombre auquel il est appli-
qué, c'est seulement son affichage qui se trouve
modifié.  Ainsi,  par  exemple,  quel  que  soit  le
nombre de décimales affichées à l'écran, Calc tra-
vaillera toujours sur 14 décimales.

La barre d'outils Formatage
La barre d'outils Formatage dispose de 5 boutons
dédiés à la mise en forme rapide de valeurs nu-
mériques :

– Les deux premiers permettent d'attribuer à une
valeur  numérique  l'un  des  formats  Monétaire,
Pourcentage ou Standard tels qu'ils sont prévus
par défaut  par le programme, c'est  à dire tels
qu'ils ont été définis dans les Paramètres régio-
naux de Windows.

– Les  deux  derniers  boutons  de  la  série  per-
mettent  d'ajouter/supprimer  une  décimale  aux
valeurs sélectionnées.

La commande Format > Cellule... – 
Nombres
L'onglet Nombres de la boîte de dialogue Forma-
tages des cellules, regroupe la totalité des options
de mise en forme applicables aux valeurs numé-
riques. Les formats numériques disponibles sont
regroupés en catégories dans la partie gauche de
la boîte. Pour chaque catégorie choisie, une série
de formats  prédéfinis,  avec  un aperçu,  s'affiche
sous la rubrique Format. 
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Lorsqu'on sélectionne un format, la zone de texte
Description de format, située au bas de la boîte
affiche le code du format sélectionné.

Le format  Standard de la catégorie  Nombre,  re-
présente  le  format  de  cellule  automatiquement
appliqué par défaut par le programme lorsqu'une
entrée de type numérique est reconnue. Ce for-
mat utilise la police Albany en taille 10 et affiche
systématiquement en notation scientifique les très
grands nombres dont  le nombre de chiffres dé-
passe 15.

Dans la liste des catégories, celle appelée Défini
par l'utilisateur affiche les formats personnalisés
créés  par  l'utilisateur.  Lorsque  de  tels  formats
sont sélectionnés, les boutons  Modifier le com-
mentaire et Supprimer, situés juste à droite de la
zone Description de format deviennent actifs, per-
mettant  de  modifier  le  commentaire  associé  au
format sélectionné ou encore de carrément sup-
primer le format de la liste.

Seuls  les  formats  définis  par  l'utilisateur  peuvent
être supprimés et non ceux proposés par défaut par
le programme. 
Lorsqu'un format personnalisé est supprimé, toutes
les  cellules  auxquelles  il  était  appliqué retrouvent
automatiquement le format Standard.

La liste déroulante  Langue permet de sélection-
ner  une  langue  pour  remplacer  les  formats
monétaires et date par défaut (ceux définis dans
les  Paramètres  régionaux sous  Windows)  par
ceux propres au pays choisi dans la liste.

La rubrique Options permet d'appliquer un format
numérique  avec  des  options  supplémentaires :
nombre  de  décimales  différent,  affichage  en
rouge des nombres négatifs, utilisation d'un sépa-
rateur des milliers, définition du nombre de zéro
non significatifs. 

Les formats %
Lorsqu'on tape un nombre en % dans une cellule,
Calc affiche la valeur en % et attribue à la cellule
le format Pourcentage. 

Dans les calculs, le programme utilisera bien sûr le
centième de la valeur pourcentage affichée.

À l'inverse, lorsqu'on souhaite afficher un contenu
numérique sous forme de pourcentage, il faut le
demander  explicitement  à  l'aide  du  bouton  de
Pourcentage,  dans la barre d'outils  Formatage,
ou en appelant la commande Format > Cellule -
Nombre..,  puis  sélectionner  la  catégorie  Pour-

centage et ensuite la variante de format à appli-
quer. 

Voici ce qui se produit lorsqu'on applique un for-
mat de pourcentage à un nombre :

Les formats de dates
Pour être reconnues comme telles, les entrées de
type date peuvent être faites dans l'un des for-
mats suivants, par exemple pour le 29 Septembre
1954 : 29.09.54 ou 29/09/54 ou 29-09-54. 

Lorsqu'une date est saisie sous l'une des formes
précédentes, Calc la reconnaît comme date mais
l'affiche au format de date défini dans les  Para-
mètres régionaux sous Windows. Ce format par
défaut peut être alors modifié pour un autre choisi
dans la boîte de dialogue. 

Les formats de date comportent  des indications
d'affichage pour les jours, les mois et les années.
Entre ces indications, le choix du caractère sépa-
rateur  est  libre.  Pour  créer  un  format
personnalisé, on combine les lettres j, m et a jus-
qu'à obtention du format désiré.

Par exemple, la date 14-7-1998 peut se voir per-
sonnalisée par les différents codages suivants :

Ainsi, le format jjjj mmmm aaaa affichera la date
sous la forme mardi 14 juillet 1998.

Les formats heures
L'heure se formate à la manière d'une date, mais
avec des heures, des minutes et des secondes.
Lorsque le  programme reconnaît  une entrée de
type  heure,  il  lui  associe  automatiquement  une
valeur  décimale  car  il  considère  toute  heure
comme une fraction de 24 h, le chiffre 1 étant at-
tribué  à  24  h.  Ainsi,  la  valeur  décimale  0.83
correspond à 19:55:12 lorsque la cellule reçoit un
format d'heure.
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Les formats monétaires
Le formatage d'une valeur monétaire peut se faire
aisément à l'aide de l'outil Monétaire intégré à la
barre d'outils Formatage. Le format appliqué dans
ce cas est celui défini dans le Panneau de confi-
guration de Windows. 

Si ce format ne convient pas, on peut en appli-
quer  un  autre  choisi  dans  la  liste  de  ceux
proposés dans la catégorie  Monétaire ou encore
créer un format personnalisé.

L'application d'un format monétaire peut provoquer
l'affichage  de  ######  dans  les  cellules  trop
étroites pour contenir la valeur en entier. Il suffira
d'élargir  la  colonne correspondante pour  retrouver
un affichage complet de la valeur.

Définir un format numérique personnalisé
Les  formats  numériques  fournis  par  défaut
conviennent dans la plupart des cas, mais rien ne
vous empêche de définir vos propres formats. 

Pour  créer  un  format  personnalisé,  sélectionner
d'abord  la  catégorie  Défini  par  l'utilisateur dans
l'onglet  Nombre de la boîte  Formatage des cel-
lules,  puis  éditer  le  format  souhaité  dans  le
champ  Description de format avant de valider la
création en cliquant sur le bouton Ajouter. Le for-
mat créé se rajoute alors à la liste des formats
définis  par  l'utilisateur  ainsi  qu'à  la  liste  corres-
pondant à la catégorie de nombre pour laquelle il
a été défini. 

On peut ainsi créer, par exemple, le format per-
sonnalisé  00-000-0,  pour  automatiquement
ajouter des tirets lorsqu'on tape des numéros à 6
chiffres dans les cellules où il est appliqué.

Les codes des formats numériques utilisent des
caractères de substitution pour définir les unités,
dizaines,  centaines…et  décimales,  caractères  à
partir desquels on peut construire ses propres for-
mats.

– 0 : ce caractère générique est particulièrement
utilisé pour représenter le nombre de chiffres à
afficher dans la partie décimale du nombre. 

– # : la position indiquée par ce caractère ne sera
effectivement prise en compte que si un chiffre
figure réellement à cet endroit. Le dièse double
est généralement utilisé dans les formats faisant
intervenir un espace comme séparateur de mil-
liers. Ainsi le code # 000 invite le programme à
séparer les milliers par un espace si le nombre
est suffisamment grand. Dans un tel cas, la va-

leur 10000 s'affichera 10 000 alors que la valeur
100 restera inchangée. 

Le tableau ci-dessous illustre quelques exemples
d'affichage  de  nombres  en  fonction  du  format
choisi.

Propriétés de caractères
Les commandes disponibles se trouvent dans la
barre d'outils Formatage ou au niveau des onglets
Police et  Effets de caractères de la boîte Forma-
tage  des  cellules (commande  Format  >
Cellule...).

Ces commandes correspondent essentiellement à
des options de police, taille, style, couleur, souli-
gnement ou de mise en relief des caractères.

Options d'alignement
Un autre groupe de commandes, dans l'onglet Ali-
gnement de  la  boîte  Formatage  de  cellules,
permet de gérer la disposition des contenus à l'in-
térieur des cellules. 

– Commandes d'alignement horizontal et vertical.
– Commandes permettant d'accentuer ou de dimi-

nuer un retrait gauche.
– Possibilité de faire pivoter le contenu d'un cer-

tain  angle,  celui-ci  pouvant  être  directement
édité ou atteint en actionnant le point jaune figu-
rant sur la roue notée ABCD. 

– La rubrique  Enchaînements permet de deman-
der  un retour  à  la  ligne à  l'approche du bord
droit de la cellule lorsqu'on a à saisir un contenu
qu'on souhaite voir disposé sur plusieurs lignes.

– Lorsque l'option  Renvoi à la ligne est active, il
est  encore  possible  de demander  que le  pro-
gramme le fasse avec coupures de mots.
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Contours et fond des cellules
Les boutons  Bordure et  Couleur d'arrière-plan,
situés sur la barre d'outils Formatage, ouvrent les
fenêtres déplaçables  Bordure et  Arrière-plan qui
permettent  d'appliquer  différents  types  de  bor-
dures  et  de  couleurs  de  fond  aux  cellules
sélectionnées.

Au niveau de la boîte Formatage des cellules, ce
sont les onglets  Bordure et  Arrière-plan, qui ren-
ferment ces options de mise en forme. 

L'onglet Bordure offre des possibilités supplémen-
taires à celles offertes par le bouton Bordure : 

– On peut choisir sous la rubrique Ligne, un style
de bordure et lui appliquer une couleur. 

– La  rubrique  Ombre permet  d'associer  une
ombre à une bordure, et de lui choisir une cou-
leur et une orientation.

– Enfin, la rubrique  Espacement avec le contenu
permet  de  gérer  la  distance  entre  le  contenu
d'une cellule et les bords de celle-ci.

Options de protection
L'onglet  Protection permet de définir des options
de protection applicables à des cellules sélection-
nées.
– Tout masquer : masque les formules et le conte-

nu des cellules sélectionnées.
– Verrouiller : empêche toute modification des cel-

lules  sélectionnées.  Cette  protection  des
cellules  ne  deviendra  toutefois  active  que  si
vous protégez également la feuille de calcul par
la commande Outils > Protéger le document >
Feuille.

– Masquer la formule : masque les formules dans
les cellules sélectionnées.

– Masquer pour l'impression :  empêche l'impres-
sion des cellules sélectionnées.

Fusion de cellules
Pour indiquer un titre de feuille de calcul ou définir
un  titre  sur  plusieurs  lignes  ou  colonnes,  vous
pouvez fusionner des cellules, comme c'est le cas
pour le titre du tableau ci-dessous.

Procédez comme suit :

– Sélectionnez la plage de cellules à fusionner.

– Cliquez sur le bouton de fusion de cellules 
dans la barre d'outils Formatage.

A titre d'exemple,  reproduisez le tableau ci-des-
sous,  sans  les  valeurs  de  la  plage  E6:E13  qui
sont à calculer en insérant les formules ad hoc.

5.2. Les AutoFormats de 
tableaux

La commande Format > AutoFormat ouvre une
boîte de dialogue contenant une liste de styles de
tableau prédéfinis applicables (AutoFormats) glo-
balement  à  un  tableau  sélectionné  dans  une
feuille de calcul (la sélection doit recouvrir l'inté-
gralité du tableau). 

Cette  commande  ne fonctionne  correctement  que
pour des tableaux construits de manière standard et
dans  lesquelles  on  n'a  pas  effectué  de  retouches
spéciales comme des fusions de cellules, etc.

Appliquer un AutoFormat
Le principe de la mise en forme automatique est
le suivant : le programme analyse le tableau en y
recherchant les titres de lignes et de colonnes, et
les formules représentant un calcul de synthèse
ou de totaux. Ensuite, il applique le modèle choisi.

Les  différents  modèles  proposés  comprennent
des options  de  mise  en  forme s'appliquant  aux
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nombres, à la police et à la taille des caractères, à
l'alignement, à la  largeur des colonnes, aux  bor-
dures, etc. 

Le bouton Options >> ajoute un nouveau volet au
bas de la boîte, pour permettre d'appliquer de ma-
nière  sélective  les  attributs  contenus  dans  le
modèle choisi. On n'est donc pas obligé d'appli-
quer  en  bloc  la  totalité  des  mises  en  forme
contenues dans le modèle choisi.

Pour  annuler  l'application  d'un  AutoFormat,  sélec-
tionner complètement le tableau, puis choisir dans
le  menu  contextuel  de  la  sélection  la  commande
Formatage par défaut.

Créer un AutoFormat
Procéder comme suit :

1. Dans une nouvelle feuille de calcul, créez un
tableau et procédez à sa mise en forme.

2. Sélectionnez  complètement  la  feuille  en  cli-
quant sur la case grise à l'intersection des en-
têtes de lignes et colonnes. 

3. Lancez la commande Format > Autoformat...
puis cliquez sur le bouton  Ajouter... et saisis-
sez le nom de votre nouvel AutoFormat avant
de valider la commande.

4. Votre nouvel AutoFormat se rajoute à la liste.

5.3. Le formatage conditionnel
Le  formatage  conditionnel  consiste  à  appliquer
une mise en forme particulière aux seules cellules
d'un  tableau  satisfaisant  à  un  certain  critère,
comme par exemple, celles renfermant une valeur
supérieure ou inférieure à une valeur de compa-
raison donnée au départ.

La commande Affichage > Mise en évidence des
valeurs (Ctrl+F8) affiche en bleu les données et en
vert les valeurs calculées pour mieux les distinguer.
Les textes restent affichés en noir. 
L'appel de cette commande n'est valable que pour
les feuilles  du classeur actif.  Si  on souhaite appli-
quer systématiquement cette option pour tous les
classeurs, il  faut activer l'option  Mise en évidence
des valeurs sous Outils > Options > OpenOffice
Calc – Afficher.

Créer un formatage 
conditionnel
La procédure générale est la suivante :

– On commence par sélectionner la plage de cel-
lules  à  mettre  en  forme  de  manière
conditionnelle. 

– On lance ensuite la commande  Format > For-
matage conditionnel pour définir les différents
critères auxquels les cellules doivent  satisfaire
pour se voir appliquer le formatage correspon-
dant.

On  peut  spécifier  jusqu'à  trois  conditions.  Pour
définir  une  condition  (critère),  procéder  comme
suit :

– Pour  utiliser  une  valeur  dans  l'écriture  d'une
condition,  sélectionner l'option  Valeur est,  puis
dans la liste déroulante immédiatement à droite,
l'opérateur de comparaison à utiliser pour écrire
la condition. Dans le dernier champ à droite édi-
ter  directement  la  valeur  à  prendre  en
considération,  ou  éventuellement  sa référence
absolue dans la feuille. Le bouton situé à droite
du champ d'édition permet d'effectuer cette der-
nière  opération  par  pointage  direct  dans  la
feuille. 

– Pour définir une condition faisant intervenir non
plus une valeur, mais une formule, sélectionner
l'option  Formule est,  puis éditer directement la
formule dans la zone située à droite. Pour être
valide,  celle-ci  doit retourner  comme  résultat
l'une des valeurs logiques VRAI ou FAUX. 

– Définir le style à appliquer aux cellules satisfai-
sant la condition. Au niveau de chaque rubrique
Condition, on trouve dans la boîte de dialogue,
une  liste  déroulante  intitulée  Style  de  cellule,
permettant  de choisir  le  style  à  appliquer  aux
cellules vérifiant le critère. 

– Valider la commande : le programme applique le
style choisi aux cellules de la sélection vérifiant
le(s) critère(s) défini(s).

Calc ne permet pas de mise en forme conditionnelle
autrement que par l'intermédiaire d'un style. Il faut
donc disposer de celui-ci avant de lancer toute com-
mande de mise en forme conditionnelle.
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Modifier un formatage 
conditionnel
Pour modifier une mise en forme conditionnelle,
sélectionner une cellule à laquelle ce type de for-
matage a été appliqué, puis lancer la commande
Format > Formatage conditionnel... et redéfinir
le critère et éventuellement le style à appliquer.

Exemple d'application
Vous  pouvez  utiliser  la  fonctionnalité  de  forma-
tage  conditionnel  pour  mettre  en  évidence  des
cellules vides en procédant comme suit :

1. Appuyez sur  F11 pour  afficher  le  Styliste.  Si
vous disposez d'une version AOO 4.xx, vous
pouvez également y accéder depuis  la barre
latérale.

2. Dans la catégorie Styles de cellules, cliquez à
droite dans la zone d'affichage des styles, puis
sur la commande Nouveau .... Donnez un nom
à votre nouveau style,  par exemple "Cellules
vides", puis validez par OK.

3. Modifiez le style "Cellules vides" que vous ve-
nez  de  créer  en  choisissant  d'appliquer,  par
exemple, un fond rouge aux cellules formatées
à l'aide de ce style. 

4. Sélectionnez les cellules auxquelles le forma-
tage doit s'appliquer, puis lancez la commande
Format > Formatage conditionnel ...

5. Dans la boîte qui s'ouvre, posez la Condition 1
comme suit : Valeur à = 0 puis choisissez Cel-
lules vides Style de cellule.

6. Validez  par  OK : les  cellules  vides  appa-
raissent maintenant en rouge.

5.4. Les propriétés de feuilles
La mise en page d'une feuille de calcul se fait par
l'application d'un style de page renfermant, entre
autres  des  options  d'impression  nécessaires  à
son découpage en pages d'impression. 

– On ne peut appliquer qu'un seul style de page à
une même feuille de calcul,  mais si un classeur
renferme plusieurs feuilles, celles-ci peuvent être
formatées à l'aide de styles de page différents.

– Ces styles de pages peuvent eux-mêmes être in-
tégrés à des modèles de classeur.

– En  fonction  des  indications  contenues  dans  le
style de page, le programme peut alors procéder
au "découpage" de la feuille en un certain nombre
de pages d'impression au format souhaité.

La modification du style de page actif  pour une
feuille sélectionnée, c'est à dire celui dont le nom
est affiché dans la barre d'état, peut se faire :

– par la commande Format > Page ...
– par la commande  Modifier  ... figurant  dans le

menu contextuel du style de page dans le  Sty-
liste.

Ces  deux  commandes  ouvrent  la  boîte  de  dia-
logue  Style  de  page,  comprenant  7  onglets  qui
permettent de créer de toutes pièces un nouveau
style de page ou de modifier le style de page actif.

Onglet Gérer
Cet onglet permet de nommer un nouveau style
ou  de  modifier  le  nom d'un  style  existant.  Une
description des propriétés intégrées au style  de
page figure au bas de l'onglet.

Onglet Page
Cet onglet permet de paramétrer les pages d'im-
pression : format de papier, orientation (portrait ou
paysage), marges et alignement de la table (hori-
zontal  et/ou  vertical),  etc.  Une  zone  de
prévisualisation  permet  de  mieux  se  rendre
compte de l'impact des choix effectués.

– Format de papier : choisissez ici le format des
pages  d'impression,  ainsi  que  leur  orientation
(Portrait ou Paysage) et le bac à papier à utiliser
si votre imprimante en a plusieurs.

– Marges : définissez ici  les marges à appliquer
aux pages d'impression.

– Paramètres de mise en page : vous pouvez in-
diquer  ici  si  le  style  de  page  défini  dans  cet
onglet  doit  s'appliquer  aux  seules  pages  de
droite  (impaires),  uniquement  aux  pages  de
gauche (paires), ou aux pages de droite et de
gauche  simultanément.  L'option  En  vis  à  vis
permet  un  formatage  des  pages  d'impression
qui permet de les relier comme dans un livre.
Vous pouvez également définir  le style de nu-
mérotation  des  pages  à  utiliser.  L'option
Alignement de la table permet de définir l'aligne-
ment  des  cellules  dans  les  pages  imprimées
(horizontal ou vertical).

Onglets Bordures et Arrière-
plan
Ces deux onglets permettent respectivement :

– d'appliquer  aux  pages  d'impression  des  bor-
dures dont on peut choisir le type, la largeur et
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la couleur, et de définir la distance à ménager
entre les bordures et le texte des pages ;

– d'appliquer  une  couleur  à  l'arrière-plan  des
pages d'impression. 

Les options  choisies  au  niveau  de ces  onglets  ne
sont pas répercutées à l'écran en affichage normal,
mais  seulement  en  mode  Aperçu (commande  Fi-
chier > Aperçu).

Onglets En-tête et Pied de 
page
Les  En-têtes et  Pieds de page sont des zones
reproduites  sur  toutes  les  pages  d'impression.
Elles  contiennent  des  informations  spéciales,
comme  une  numérotation  ou  un  titre,  par
exemple. 

Dans ce qui suit,  nous ne détaillerons que les op-
tions proposées pour les zones d'En-tête, les zones
de  Pied de page se paramétrant exactement de la
même manière.

La fenêtre principale de l'onglet  En-tête propose
d'abord de  choisir  d'activer  ou non la  présence
d'une zone d'en-tête sur les pages imprimées. 

Une  petite  fenêtre  de  prévisualisation  permet  à
tout moment de mieux se rendre compte de l'im-
pact des choix effectués. Si  on a coché l'option
d'activation de l'en-tête, l'onglet propose alors les
possibilités de paramétrage suivantes :

– Une première série d'options permet de définir
l'espace alloué ainsi que la position occupée par
l'en-tête par rapport aux bords supérieurs et la-
téraux  de  la  page  d'impression.  L'option
Adaptation  dynamique  de  la  hauteur permet
d'adapter  automatiquement  la  hauteur  de  la
zone au nombre de lignes de contenu qu'on y
placera. 

– Le bouton Plus... ouvre une boîte permettant de
gérer  les  bordures  et  la  couleur  de  fond  des
zones d'en-tête. 

– Le bouton  Éditer... ouvre une nouvelle fenêtre
depuis laquelle on peut éditer le contenu à re-
produire  dans  les  en-têtes  des  pages.  Cette
fenêtre d'édition permet  de répartir  le contenu
de l'en-tête en trois  zones juxtaposées : Zone
gauche, Zone centrale et Zone droite. 

Sous  ces  différentes  zones,  des  boutons  per-
mettent  de  modifier  la  police  de  caractère  des
textes ou d'insérer des champs tels que la date,
l'heure,  la  pagination  des  feuilles  d'impression,
etc.

– Attributs de texte : ce bouton ouvre la boîte de
dialogue Attributs de texte offrant dans 3 onglets
des options de mise en forme des textes :  Po-
lice, Effets de caractères et Position. 

– Titre : Insère un substituant de nom de fichier
dans la zone sélectionnée. Un clic prolongé dé-
roule une liste dans laquelle on peut choisir le
type d'information à insérer comme titre : titre in-
diqué dans la boîte des propriétés du classeur,
nom de  fichier  ou  chemin  d'accès/nom de  fi-
chier. 

– Nom de feuille : permet d'insérer en en-tête le
nom de la feuille destinée à l'impression. 

– Page : permet d'insérer le numéro des pages.
– Pages : permet  d'insérer  le  nombre  de  pages

total du document.
– Date  et  Heure : boutons  servant  à  l'insertion

sous forme de champs de la date et de l'heure.

Pour insérer sur une même ligne deux champs, les
séparer par un espace.
Il est bien sûr également possible d'insérer directe-
ment au clavier des information dans les différentes
zones

Onglet Classeur
La portée des options choisies au niveau de cet
onglet  ne se limite  pas  à la  feuille  active,  elles
sont répercutées à toutes les feuilles du classeur
actif. 
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– Ordre  des  pages : permet  d'indiquer  au  pro-
gramme le sens de découpage des feuilles du
classeur en pages d'impression. Une petite fe-
nêtre  de  prévisualisation  illustre  le  sens  de
découpage choisi. 

– Premier numéro de page : permet de choisir un
numéro  initial  à  partir  duquel  la  numérotation
des pages imprimées doit se faire. 

– Imprimer : permet  de  choisir  les  composants
des  feuilles  à  imprimer.  C'est  notamment  ici
qu'on décidera si on souhaite une impression de
la grille des feuilles de calcul. 

– Échelle : permet de jouer sur la taille d'impres-
sion,  par  exemple  pour  tenter  de  faire  tenir
l'impression sur un nombre de pages donné.

5.5. Formater à l'aide de styles
Jusqu'à  présent  nous  n'avons  abordé  que  des
mises en forme manuelles, menées au coup par
coup,  en  choisissant  les  propriétés  à  appliquer
aux cellules et aux feuilles.

On peut également appliquer de telles mises en
forme après les avoir enregistrées dans un style
réutilisable à volonté. Calc dispose, avec le  Sty-
liste, d'un outil dédié à la création et à l'application
de styles.

Définir un style de formatage consiste à enregistrer
un ensemble de mises en valeur sous un nom. 

Calc permet la création de deux types de styles :

– Des styles de cellule pour mettre en forme des
cellules ou des plages de cellules. Ce seront,
par exemple, des styles permettant d'appliquer
des  formats  monétaires,  des  formats  d'arrière
plan,  de  titres  de  colonnes  ou de  lignes,  des
bordures ou encore un état  de protection aux
cellules auxquelles on les applique. Cette façon
de procéder présente l'avantage de pouvoir mo-
difier  en  un  seul  coup  la  mise  en  forme des
cellules auxquelles un même style a été appli-
qué en modifiant simplement sa définition.

– Des styles de page renfermant des options de
mise  en  page  qu'on  souhaite  réutiliser  facile-
ment. En fait, nous avons déjà traité les styles
de pages sans le savoir. En effet, lorsque nous
lançons la commande Format > Page, la boîte
à laquelle nous accédons nous permet de direc-
tement modifier le style de page appliqué à la
feuille de calcul active. 

Le Styliste

La  fenêtre  du  Styliste (F11)  affiche  la  liste  des
styles disponibles pour mettre en page une feuille
de calcul (styles de page) ou mettre en forme ses
cellules (styles de cellule).

Si vous utilisez une version AOO 4.xx, vous pouvez
également accéder au  Styliste depuis la barre laté-
rale.

La barre d'outils de la fenêtre du Styliste comporte
5 boutons, de gauche à droite :

– Styles de cellule : permet d'accéder à la liste
des  styles  disponibles  pour  le  formatage  des
cellules de la feuille de calcul. Calc dispose de 5
styles de cellules prédéfinis : Par défaut, Résul-
tat, Résultat2, Titre et Titre1. Le style Par défaut
est  celui  appliqué au départ  à  toutes  les  cel-
lules.

– Styles de page : permet d'accéder à la liste des
styles disponibles pour réaliser la mise en page
de la feuille de calcul et préparer son impres-
sion.  Deux  styles  de  page  sont  fournis  par
défaut : Par défaut et Compte rendu.

– Mode Tout remplir : active ou désactive la pos-
sibilité d'appliquer le style choisi dans le Styliste
à la sélection en cours. 

– Nouveau style à partir de la sélection : per-
met  de  créer  un  nouveau  style  intégrant  les
mises en valeur appliquées à la sélection cou-
rante (création d'un style par l'exemple). 

– Actualiser le style : permet de modifier le style
de cellule sélectionné en le redéfinissant avec
les attributs de mises en forme en vigueur dans
la cellule/plage sélectionnée.

Au bas de la fenêtre, une liste déroulante permet
de choisir d'afficher les styles du type choisi (cel-
lules ou page) selon les critères suivants :

– Tous les styles : tous les styles disponibles dans
le  type  choisi  (cellule  ou  page)  sont  affichés
dans le styliste. 
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– Styles utilisés : seuls les styles auxquels on a
déjà eu recours pour formater la feuille sont lis-
tés.

– Styles  personnalisés : seuls  sont  affichés  les
styles créés par l'utilisateur. 

– Hiérarchie : affichage  arborescent  des  styles
permettant  de voir  leurs dépendances,  c'est  à
dire les styles sur lesquels on a basé leur créa-
tion.

Créer un nouveau style
La création d'un style peut se faire de plusieurs
façons :

– On peut opter pour une création basée sur un
exemple.  Cette méthode consiste à mettre en
forme manuellement une cellule/page (selon le
type de style à définir) puis, une fois atteint le
résultat  souhaité,  à  demander  au  programme
d'enregistrer ces mises en forme dans un style
en cliquant sur le bouton Nouveau style à par-
tir de la sélection. Le programme ouvre alors
une fenêtre permettant de nommer le style créé.
Il  est  également  possible  de  faire  glisser  une
cellule formatée dans la fenêtre du Styliste pour
créer un nouveau style.

– On peut créer un nouveau style par modifica-
tion d'un style existant. Pour ce faire, il suffit
de lancer la commande contextuelle Nouveau...
associée au style qu'on souhaite utiliser comme
base. Il reste alors à définir le nom du style, puis
modifier les attributs de mise en forme du style
de base jusqu'à obtenir  le jeu de propriétés à
enregistrer dans le nouveau style. 

– On  peut  créer  un  nouveau  style  de  toutes
pièces, directement à l'aide de la boîte de dia-
logue Style de page ou de cellule, selon le type
de style  à créer.  Une telle procédure démarre
simplement en appelant  la commande contex-
tuelle  Nouveau d'un clic droit dans un espace
vide  de  la  liste  des  styles  de  cellules  ou  de
pages du Styliste.

Modifier un style
On  peut  procéder  de  l'une  des  manières  sui-
vantes :

– Sélectionner le style à modifier puis appeler sa
commande  contextuelle  Modifier....  Effectuer
ses choix dans la boîte de formatage qui s'ouvre
(boîte de formatage de cellules ou boîte de mise
en page selon le cas). À la validation de la com-
mande,  le  style  est  modifié  et  les  éléments

formatés auparavant avec ce style sont automa-
tiquement actualisés.

– Formater ou choisir  une cellule ayant déjà les
mises en forme souhaitées, sélectionner le style
à modifier puis appuyer sur le bouton  Actuali-
ser. Le style est modifié en conséquence et les
cellules  auxquelles  il  avait  été  appliqué  sont
mises à jour automatiquement.

Appliquer un style

Appliquer un style de cellule
Commencer par sélectionner dans la feuille la ou
les cellules à formater,  puis appliquez l'une des
procédures suivantes : 

– Double cliquer, dans le  Styliste, sur le nom du
style à appliquer.

– Taper au clavier le raccourci associé au style à
appliquer  (si  vous  avez  défini  des  raccourcis
pour vos styles).

Appliquer un style de page
Commencer  par  sélectionner  la  feuille  dont  le
style  de  page  doit  être  changé,  puis  appliquez
l'une des procédures suivantes :

– Double cliquer, dans le  Styliste, sur le nom du
style de page à appliquer.

– Choisissez le style de page à appliquer dans la
liste des styles de pages de la barre d'état.

Copier et déplacer des styles
Pour copier un style d'un classeur vers un autre,
ou entre un classeur et un modèle, lancez la com-
mande Fichier > Modèles > Gérer pour ouvrir la
boîte de dialogue Gestion des modèles.

1. Dans les listes déroulantes  Modèles et  Docu-
ments, situées au bas de la boîte, affichez les
documents source et cible du transfert ou de la
copie,  puis  double-cliquez  sur  leur  nom puis
sur l'icône Styles pour que s'affiche la liste de
leurs styles respectifs.

2. Pour copier un style, maintenez la touche Ctrl
enfoncée et faites glisser le nom du style à co-
pier  d'une  liste  à  l'autre.  Pour  déplacer  un
style, faites simplement glisser le nom du style
sans utiliser touche Ctrl.

3. Répétez  l'opération  pour  chaque  style  que
vous voulez  copier/déplacer  avant  de  cliquer
sur le bouton Fermer pour terminer vos trans-
ferts. 
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5.6. Les modèles de classeur
Un modèle de classeur est un classeur enregistré
dans un format de fichier spécial (.ots), et qu'on
peut réutiliser par la suite comme base lors de la
création de nouveaux classeurs du même genre. 

L'utilisation de modèles de classeur en entreprise
garantit une présentation uniforme des feuilles de
calcul.

Tous les classeurs créés dans OpenOffice Calc sont
en fait basés sur un modèle. Si vous ne spécifiez pas
de modèle lors de la création d'un nouveau classeur,
le programme crée un classeur contenant 3 feuilles
vierges (cas de AOO Calc) et le base sur son modèle
de classeur par défaut. 
Lorsque vous créez un nouveau classeur, le docu-
ment qui vous apparaît est une copie du modèle sur
lequel repose votre nouveau classeur et non pas le
modèle de classeur lui-même.

Le modèle de classeur par 
défaut
C'est  celui  sur  lequel  sont  basés tous  les  nou-
veaux classeurs créés par la commande  Fichier
> Nouveau > Classeur. 

Changer de modèle par défaut
Vous pouvez  remplacer  le  modèle  d'origine  par
l'un  de  vos  modèles  personnalisés,  à  condition
qu'il ait été enregistré dans l'un des dossiers affi-
chés  dans  la  boîte  de  dialogue  Gestion  des
modèles. 

Procédez comme suit :

1. Lancez  la  commande  Fichier  >  Modèles  >
Gérer … pour ouvrir  la boîte de gestion des
modèles. 

2. Dans le volet gauche de la boîte, sélectionnez
le dossier renfermant le modèle personnalisé
que vous souhaitez utiliser comme modèle par
défaut. 

3. Cliquez sur le bouton Commandes et choisis-
sez  Définir en tant que modèle par défaut
dans la  liste déroulante.  Vous pouvez égale-
ment  trouver  cette  commande dans le  menu
contextuel du modèle choisi.

La  prochaine  fois  que  vous  créez  un  nouveau
classeur par la commande Fichier > Nouveau >
Classeur,  il  sera  alors  basé sur  votre  nouveau
modèle par défaut.

Restaurer le modèle par défaut d'origine
Pour réactiver le modèle par défaut d'origine :

– Ouvrez la boîte de gestion des modèles par la
commande Fichier > Modèles > Gérer …

– Cliquez sur le bouton  Commandes et choisis-
sez Rétablir le modèle par défaut > Classeur.

La  prochaine  fois  que  vous  créez  un  nouveau
classeur par la commande Fichier > Nouveau >
Classeur, celui-ci sera à nouveau créé à partir du
modèle par défaut d'origine.

Choisir le modèle à utiliser
Pour  créer  un  nouveau  document  basé  sur  un
autre modèle que celui d'origine, vous devez utili-
ser  la  commande  la  commande  Fichier  >
Nouveau  >  Modèles  et  documents.  La  boîte
Modèles  et  documents s'ouvre  pour  vous  per-
mettre  de  choisir  un  modèle  personnalisé
disponible sur votre système.

La boîte se compose des éléments suivants : 

Un volet gauche (1) affichant une série de dos-
siers dans lesquels on peut rechercher le modèle
à utiliser. Par défaut, c'est le le dossier  Modèles
qui est sélectionné et son contenu affiché dans le
volet  central  (2)  de  la  boîte,  mais  vous pouvez
également  utiliser  des modèles  stockés dans le
dossier Mes documents.

Le volet central (2) affiche le contenu du dossier
sélectionné dans le volet gauche. Des boutons de
navigation (4) permettre de se déplacer dans l'ar-
borescence de ses fichiers.

Lorsqu'un modèle se trouve sélectionné dans le
volet central (2), il s'affiche dans la zone de prévi-
sualisation de droite. Les boutons (5) permettent
deux modalités d'affichage : Aperçu ou Propriétés.

Les boutons (7), au bas de la boîte permettent :

– Gérer  … : ouverture  du  gestionnaire  des  mo-
dèles

– Éditer :  permet d'ouvrir  directement le modèle
choisi pour y apporter des modifications.
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– Ouvrir : valide la commande une fois le modèle
à utilisé sélectionner dans le volet  central.  Un
double clic sur un modèle affiché dans le volet
central  a  le  même effet.  Le  résultat  est  l'affi-
chage dans l'espace de travail  d'une copie du
modèle chois comme nouveau document.

– Annuler : referme la boîte sans rien faire (on re-
nonce à la commande)

Lorsque vous basez la création d'un document sur
un modèle, vous n'ouvrez pas le modèle lui-même,
mais une copie de celui-ci  au format normal  .ods
dans le cas d'un classeur. Il n'y a donc pas de risque
d'endommager  vos  modèles.  Seule  la  commande
Éditer dans cette boîte vous fournit un accès direct
en mode d'édition, à vos modèles personnalisés. 

Créer un modèle de classeur
Vous pouvez créer vos propres modèles de clas-
seur. Ils seront utilisables de la même façon que
les modèles fournis d'origine avec le programme.

Pour créer un modèle, utilisez simplement l'un de
vos classeurs existants en n'y conservant que les
éléments  et  styles  que  vous  souhaitez  pouvoir
réutiliser, puis enregistrez-le par la commande Fi-
chier > Modèles > Enregistrer. 

Dans la boîte de dialogue Modèles qui s'ouvre : 

1. Tapez le nom de votre nouveau modèle,  par
exemple "Budget annuel", dans le champ inti-
tulé Nouveau modèle.

2. Dans  la  liste  Catégories,  sélectionnez  celle
dans laquelle vous souhaitez ranger le modèle.

3. Cliquez  sur  OK pour  enregistrer  le  nouveau
modèle et l'ajouter à la liste des modèles dis-
ponibles dans la catégorie choisie. 

Les modèles sont enregistrés dans un format spé-
cial, avec extension .ots (modèle de classeur ODT).
Vous pouvez installer  des nouveaux modèles sous
forme d'extensions à l'aide du Gestionnaire des ex-
tensions.

Éditer un modèle existant
Vous pouvez éditer directement un modèle exis-
tant pour en modifier le contenu et les styles.

1. Lancez  la  commande  Fichier  >  Modèles  >
Gérer.

2. Dans la boîte qui s'ouvre accédez au modèle
que vous souhaitez modifier. Une fois le mo-
dèle affiché dans le volet central, sélectionnez-
le puis cliquez sur le bouton  Commandes et
choisissez Éditer dans la liste déroulante.

3. Votre modèle s'affiche alors dans la fenêtre de
Calc comme document normal, et vous pouvez
le modifier.

4. Une fois les modifications réalisée, enregistrez
votre  document  comme modèle  par  la  com-
mande  Fichier  >  Enregistrer  dans  la  barre
des menus. 
Vous ne pouvez pas modifier les modèles d'origine
du programme. 

Actualiser un classeur 
Vous  pouvez  répercuter  les  modifications  effec-
tuées  sur  un  modèle  aux  documents  antérieurs
basés sur sa version précédente.

L'actualisation se limite cependant à une réapplica-
tion  des  nouveaux  styles,  les  modifications  de
contenus du modèle modifié  ne sont pas répercu-
tées lors d'une telle mise à jour.

Lorsque  vous  avez  modifié  un  modèle  et  que
vous ouvrez un document basé dessus le mes-
sage suivant s'affiche : 

Vous avez alors  le  choix  entre  les  deux procé-
dures suivantes :

– Cliquer sur le bouton  Mettre à jour les styles
pour appliquer au document les styles modifiés
dans le modèle. Cela revient à actualiser votre
document sur le modèle modifié.

– Cliquer sur le bouton Conserver les styles pré-
cédents si vous ne voulez pas appliquer à votre
document les styles qui ont été modifiés au ni-
veau  du  modèle.  En  choisissant  cette  option,
vous renoncez définitivement à l'actualisation de
votre document par le modèle modifié. La boîte
de message ci-dessus ne vous apparaîtra plus.
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Changer le modèle d'un 
classeur
Vous pouvez souhaiter associer, par exemple, l'un
de vos modèles personnalisés à un classeur exis-
tant, mais basé sur un autre modèle ou le modèle
par défaut de Calc. 

Pour  pouvoir  procéder  de  manière  simple,  les
noms  des  styles  appliqués  devraient  être  iden-
tiques  dans  le  classeur  existant  et  le  nouveau
modèle. Comme c'est rarement le cas, vous de-
vrez souvent recourir à la fonction de recherche et
remplacement pour remplacer les anciens styles
par les nouveaux, une fois votre document asso-
cié au nouveau modèle.

Procédez comme suit :

1. Lancez  la  commande  Fichier  >  Nouveau  >
Modèles  et  documents ...  et  choisissez  le
modèle à utiliser. Vous créez ainsi un nouveau
classeur basé sur le modèle avec lequel vous
souhaitez actualiser votre document. 

2. Ouvrez ensuite le document que vous voulez
modifier, puis utilisez le raccourci  Ctrl+A pour
le sélectionner intégralement.

3. Collez la sélection dans le nouveau document
que vous avez créé à l'étape 1. 

4. Enregistrez  votre  classeur  sous  un  nouveau
nom. 

Cette méthode récupère les graphiques, les textes
et bien sûr les styles qui existent dans le nouveau
modèle et implique donc un nettoyage préalable du
modèle  pour  y  supprimer  tous  les  éléments  dont
vous ne souhaitez pas que votre document hérite.

Organiser les modèles
OpenOffice ne peut utiliser que des modèles sto-
ckés dans des répertoires prévus à cet effet, mais
vous pouvez en créer d'autres pour organiser vos
modèles de manière thématique. Il est également
possible d'importer et d'exporter des modèles.

Toutes les opérations de gestion des modèles se
font depuis la boîte de dialogue Gestion des mo-
dèles qui  s'ouvre  par  la  commande  Fichier  >
Modèles > Gérer...

Les commandes de gestion possibles pour l'élé-
ment  sélectionné  dans  la  boîte  (dossier  ou
modèle) sont présentes à la fois dans le menu du
bouton Commandes et le menu contextuel asso-
cié à l'élément sélectionné (dossier ou modèle).

Importer un modèle
Si un modèle ne se trouve pas dans l'un des dos-
siers  de  stockage  de  la  boîte  Gestion  des
modèles, vous devez l'importer dans l'un de ces
dossiers avant de pouvoir l'utiliser. 

Pour importer un modèle dans un dossier de mo-
dèles :

1. Dans la boîte  Gestion des modèles, désignez
le dossier dans lequel vous souhaitez importer
le modèle.

2. Cliquez sur le bouton Commandes et choisis-
sez  Importer  un  modèle  ….  Une  fenêtre
classique d'ouverture de fichiers apparaît.

3. Recherchez et sélectionnez le modèle à impor-
ter,  puis  cliquez  sur  Ouvrir.  La  boîte
d'ouverture  se  referme  et  le  modèle  se  re-
trouve importé dans le dossier sélectionné et
vous pouvez, au besoin le renommer avant de
valider par Enter.

Exporter un modèle
Pour  exporter  un  modèle  depuis  un  dossier  de
modèles vers un autre emplacement, par exemple
le dossier Mes documents :

1. Dans  la  boîte  de  dialogue  Gestion  des  mo-
dèles, double-cliquez sur le dossier renfermant
le modèle à exporter. Une liste de tous les mo-
dèles contenus dans ce dossier apparaît.

2. Sélectionnez le modèle à exporter.
3. Cliquez sur le bouton Commandes et choisis-

sez  Exporter  le  modèle.  La  boîte
d'enregistrement Enregistrer sous apparaît.

4. Désignez le dossier cible vers lequel l'exporta-
tion  doit  se  faire,  puis  cliquez  sur  le  bouton
Enregistrer.

Supprimer un modèle (personnalisé)
1. Dans la boîte de dialogue Gestion de modèles,

double-cliquez  sur  le  dossier  qui  contient  le
modèle à supprimer. Une liste de tous les mo-
dèles contenus dans ce dossier apparaît.
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2. Sélectionnez le modèle à supprimer.
3. Cliquez sur le bouton Commandes et choisis-

sez Supprimer dans le menu déroulant. Vous
pouvez  également  procéder  depuis  le  menu
contextuel du modèle à supprimer. Une boîte
de  message  vous  demande  de  confirmer  la
suppression. Cliquez sur Oui.

Vous ne pouvez supprimer que des dossiers de mo-
dèles  personnalisés,  jamais  ceux  fournis  d'origine
avec OpenOffice.

Déplacer un modèle
Pour déplacer un modèle dans un autre dossier :

1. Dans la boîte de dialogue Gestion de modèles,
double-cliquez  sur  le  dossier  qui  contient  le
modèle à déplacer. Une liste de tous les mo-
dèles contenus dans ce dossier apparaît.

2. Cliquez sur le modèle à déplacer et faites le
glisser vers le dossier destinataire souhaité. 

Si vous ne disposez pas des droits de suppression
des modèles, cette action aboutira à une copie et
non un déplacement.

Créer un dossier de modèles
Dans la fenêtre du  Gestionnaire de modèles sé-
lectionnez  un  dossier  quelconque,  puis  cliquez
sur le bouton Commandes et choisissez la com-
mande  Créer.  Un nouveau dossier intitulé  Sans
nom est créé dans la liste des dossiers et un cur-
seur texte clignote à l'extrémité de l'intitulé. 

Cliquez sur la touche Retour arrière pour suppri-
mer le nom d'origine, puis entrez le nom souhaité
avant de valider par Entrée. 

Le répertoire créé se place à la suite des dossiers
existants. Il n'est pas possible de le faire glisser à
l'intérieur  d'un  autre  répertoire  pour  en  faire  un
sous-dossier de celui-ci.

Supprimer un dossier de modèles
Pour supprimer un dossier de modèles:

1. Dans la boîte de dialogue Gestion de modèles,
sélectionnez le dossier à supprimer.

2. Cliquez sur le bouton Commandes et choisis-
sez Supprimer (ou utiliser le menu contextuel
du  dossier).  Une  boîte  d'avertissement  vous
demande de confirmer la suppression. Cliquez
sur le bouton Oui.

5.7. L'aperçu avant impression
La commande  Fichier  > Aperçu ouvre  une fe-
nêtre  qui  affiche  la  feuille  de  calcul  active
découpée en ses différentes pages d'impression.

Dans ce mode d'affichage, il n'est pas possible de
faire  des  modifications  dans la  feuille  de  calcul
sans retourner à l'affichage normal en rappelant la
commande  pour  la  désactiver  (commande  bas-
cule)  ou  en  cliquant  sur  le  bouton  Fermer
l'aperçu situé dans la barre d'outils de la fenêtre
du mode Aperçu.

Par contre, ce mode d'affichage permet de modi-
fier  graphiquement  les  marges  (à  la  souris),  la
position des en-têtes et pieds de page, sauts de
page, ainsi que la largeur des colonnes pour corri-
ger l'apparence des feuilles d'impression.

Cette barre d'outils renferme les boutons de com-
mande suivants (de gauche à droite) :

Page  précédente,  Page  suivante,  Première
page , Dernière page (boutons 1 à 4). Ces 4 pre-
miers  boutons permettent  de naviguer  entre les
différentes pages d'impression de la feuille de cal-
cul  pour  se rendre compte de leur  présentation
générale.

Agrandir  le  zoom : augmente la  taille  de  l'affi-
chage  et  réduit  donc  le  nombre  de  pages
affichées en réduction (bouton 5). 

Réduire le zoom : réduit la taille de l'affichage et
augmente donc le nombre de pages affichées en
réduction (bouton 6). 

Plein écran : affiche la fenêtre d'aperçu en plein
écran (bouton 7).

Formater  la  page : ouvre  la  boîte  de  mise  en
page, permettant de modifier les options de mise
en page enregistrées dans le style de page actif
(bouton 8).

Marges : affiche  des  poignées  pour  toutes  les
marges, en-têtes et pieds de page et toutes les
lignes  de  séparation  des  colonnes  afin  de  per-
mettre de modifier  les marges et  la largeur des
colonnes  à  la  souris  en  faisant  glisser  les  poi-
gnées dans la direction souhaitée (bouton 9).

Facteur  d'échelle : permet  de  définir  le  facteur
d'échelle (bouton 10).
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Fermer l'aperçu : permet un retour au mode d'af-
fichage normal (bouton 11). 

5.8. Corriger les sauts de page
Les deux commandes ci-dessous permettent de
gérer manuellement les sauts de page et de re-
toucher les choix résultant des options de mise en
page adoptées. 

Affichage > Aperçu des sauts 
de page
Cette commande affiche en réduction la feuille de
calcul décomposée en ses différentes pages d'im-
pression  numérotées,  avec  les  sauts  de  pages
prévus affichés en bleu. 

Il  est possible de redéfinir la position de ceux-ci
tels qu'ils apparaissent dans cette représentation
en les déplaçant à l'aide de la souris. Un retour à
un affichage normal de la feuille s'obtient en rap-
pelant  une  seconde  fois  la  commande
(commande bascule).

Insertion > Saut manuel
Cette commande permet de reprendre manuelle-
ment  le  découpage  de  la  feuille  en  pages
d'impression en insérant manuellement des sauts
de ligne et de colonne plutôt que de laisser le pro-
gramme s'en charger en fonction des options de
mises en page qu'on lui a demandé d'appliquer.
La commande permet d'insérer un  saut de ligne
manuel  juste  au-dessus  de  la  cellule  sélection-
née,  et  un  saut  de  colonne  contre  sa  bordure
gauche. 

5.9. Imprimer
Calc dispose de deux commandes d'impression :

– Le  bouton  Impression  rapide situé  dans  la
barre d'outils Standard permet l'impression de la
feuille de calcul active dans son intégralité, avec
les  options  prévues  par  défaut  par  le  pro-
gramme. 

– La commande  Fichier > Imprimer ... ouvre la
boîte de dialogue Imprimer qui permet de redéfi-
nir  certaines  options,  mais  uniquement  pour
l'impression du document en cours.

Le bouton Impression rapide
Cliquez sur le bouton commande Impression ra-
pide,  dans  la  barre  d'outils  Standard,  pour
imprimer complètement la feuille de calcul active

avec l'imprimante par défaut et les options d'im-
pression par défaut de Calc.

Pour imprimer avec les options d'impression enre-
gistrées  avec  le  document,  il  faut  que  l'option
Charger les paramètres de l'imprimante avec le do-
cument soit  cochée  dans  la  commande  Outils  >
Options > Chargement/Enregistrement  > Gé-
néral.

La boîte d'impression
La  commande  Fichier  >  Imprimer  ... ouvre  la
boîte  de  dialogue  Imprimer (reproduite  ci-des-
sous)  qui  permet  de paramétrer  l'impression du
document en cours. La boîte se compose de trois
parties principales : 

– une zone d’aperçu, avec des boutons de navi-
gation  pour  afficher  en  réduction  les  pages
d'impression correspondant à la feuille de calcul
active, 

– plusieurs  onglets avec  des  éléments  de
contrôle spécifiques,

– les boutons Imprimer, Annuler et Aide.

Les options choisies dans la boîte ci-dessous ne sont
valables que pour le document en cours et enregis-
trées avec lui. 
Pour définir les options d'impression par défaut de
Calc, c'est à dire celles qui resteront actives par la
suite lors de la création de tout nouveau classeur, il
faut recourir à la commande Outils > Options ... >
OpenOffice – Imprimer,

Onglet "Général"
Cet onglet permet de choisir:

– L'imprimante  à  utiliser  et  ses  options  (bouton
Propriétés  ...).  Les  options  disponibles  dé-
pendent de l'imprimante choisie, mais on trouve
systématiquement celles permettant de définir le
format du papier à utiliser, sa qualité, et l'orien-
tation à donner aux pages d'impression (Portrait
ou Paysage).

– La rubrique Plage et exemplaires permet de dé-
cider d'imprimer toutes les feuilles du classeur,
seulement celles qui sont sélectionnées, ou uni-
quement  la  sélection  en  cours  dans  la  feuille
courante. 

– Le nombre d'exemplaires à imprimer ainsi que
les options de tri. L'option  Assembler conserve
l'ordre des pages d'origine.
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Onglet "OpenOffice Calc"
Permet  de  spécifier  si  les  pages  vides  doivent
être imprimées ou pas.

Onglet "Mise en page"

Il permet d'imprimer plusieurs pages de document
en réduction sur une même feuille. 

– Pour  imprimer  deux pages côte  à côte  sur  la
même  feuille,  sélectionnez  "2"  dans  la  liste
Pages par feuille. 

– Pour  imprimer  plusieurs  pages  sur  la  même
feuille,  sélectionnez  le  nombre  de  pages  par
feuille souhaité, puis éventuellement l'ordre des
pages. Le petit aperçu montre la disposition des
pages.

Onglet "Options"

Cet onglet propose les options suivantes :

– Impression dans un fichier plutôt  que sur une
imprimante. Cette option permet d'utiliser le fi-

chier créé pour l'imprimer sur une autre impri-
mante que celle disponible sur le système. 

– Une demande d'impression en ordre inversé im-
primera  le  document  depuis  la  dernière  page
vers la première.
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Calc dispose d'un module permettant de réaliser
rapidement, à l'aide d'un Assistant, une représen-
tation graphique de données sélectionnées dans
un tableau. Ce module permet également, dans
un second temps, de retoucher le diagramme ob-
tenu  à  l'aide  de  toute  une  série  de  fonctions
d'édition et de personnalisation.

Un graphique (ou diagramme) représente graphi-
quement les données d'un tableau et facilite leur
interprétation en visualisant les tendances ou les
relations qui existent entre elles. Les graphiques
ont en effet l'avantage de pouvoir résumer en une
seule image représentative de grosses quantités
de données, et de faciliter ainsi leur analyse.

Pour illustrer l'utilisation de ce module, nous utili-
serons le tableau de données ci-dessus.

Il existe une liaison entre un graphique et les don-
nées de la feuille de calcul qu'il représente. Lorsque
celles-ci sont modifiées, le graphique correspondant
est automatiquement actualisé.

6.1. Démarrer le module 
graphique

Sélectionner la plage de données à représenter
puis  lancer  la  commande  Insertion  >  Objet  >
Diagramme .... Un diagramme de base est auto-
matiquement  inséré  et  la  première  boîte  de
l'Assistant graphique (Étape 1/4) apparaît.

Cet  Assistant  se  compose  de  quatre  boîtes  de
dialogue pour une création assistée en 4 étapes.
À tout moment, les choix effectués sont répercu-
tés en temps réel dans le diagramme inséré pour
permettre de juger de l'effet produit par les para-
métrages avant de valider.

Sur la gauche de chaque fenêtre de l'assistant,
les 4 étapes restent affichées en permanence et
permettent à tout moment de basculer de l'une à
l'autre.

Dans le bas de chaque boîte, un bouton Suivant
réalise le passage à l'étape suivante, et un retour
en  arrière  est  toujours  possible  avec  le  bouton
Précédent.

Un bouton  Terminer permet, à tout moment, de
fermer l'assistant en acceptant le diagramme créé
avec les paramètres actifs. 

Vous pouvez obtenir de l'aide de deux façons :
• En  cliquant  sur  le  bouton  Aide présent  dans

chaque  boîte  de  l'Assistant,  vous  obtenez  une
aide contextuelle sur l'étape en cours.

• En  appuyant  d'abord  sur  la  combinaison  de
touche Maj+F1, le pointeur de votre souris se
transforme en point d'interrogation. En poin-
tant avec la souris sur les différentes parties de la
boîte affichée, ou en pointant sur le diagramme
inséré,  vous  obtenez  alors  une  explication
concise dans une infobulle. Vous pouvez désacti-
ver  cette  fonctionnalité  d'un  clic  gauche  de
souris. 

Étape 1 : Type de graphique
Cette  boîte  permet  de  choisir  un  type  de  gra-
phique  dans  une  liste  et  propose  pour  chaque
type  une  série  de  variantes  (sous-types)  pos-
sibles.

Cliquez dans la colonne centrale sur les différents
types de diagramme pour faire apparaître à droite
les  aperçus  des  sous-types disponibles.  En co-
chant la case 3D, vous obtiendrez un diagramme
en relief et vous pouvez également changer la va-
leur  Simple de la liste déroulante pour la valeur
Réaliste afin d'obtenir un rendu final plus fin.
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Le type de graphique à utiliser dépend des don-
nées à représenter  et  de l'effet  recherché dans
leur représentation. 

Colonne (histogramme) : c'est le modèle de gra-
phique proposé par défaut. De tels graphiques, à
mi-chemin  entre  les  graphiques  en  courbes  et
ceux  en  secteurs,  permettent  de  comparer  plu-
sieurs  séries  de  données  à  un  moment  précis.
Les données sont représentées par des barres de
hauteur proportionnelle à leur valeur. L'axe X af-
fiche les  catégories.  L'axe Y affiche les  valeurs
pour chaque catégorie.

Barre : c'est un histogramme avec des colonnes
horizontales et non verticales. L'axe Y affiche les
catégories. L'axe X affiche les valeurs de chaque
catégorie.

Secteur : un tel graphique se limite à l'affichage
d'une seule série de données dont il  représente
les relations proportionnelles.  Un diagramme en
secteur affiche les valeurs comme des secteurs
circulaires du cercle total.  La longueur d'un arc,
ou la zone de chaque secteur, est proportionnelle
à sa valeur. 

Les graphiques en tore (anneau) sont un sous-type
de graphique en secteur qui permet d'illustrer les re-
lations proportionnelles existant entre les éléments
de plusieurs séries en utilisant un anneau différent
pour chacune d'elles.

Zone (aire)  graphique  en  courbes  dont  les  es-
paces entre les lignes sont remplis.

Ligne (courbes) : utilisé  pour  étudier  l'évolution
d'une ou plusieurs  variables,  par  rapport  à  une
autre, par exemple pour représenter l'évolution de
grands  ensembles  de  données  dans  le  temps
(ventes  d'un  produit  sur  une  période  donnée,
etc.), ou pour la mise en évidence de tendances.
Un diagramme en ligne affiche des valeurs sous
forme de points sur l'axe Y. L'axe X affiche les ca-
tégories.  Les  valeurs  Y  de  chaque  série  de
données peuvent être connectées par une ligne.

XY (nuage de points) : graphique mettant en évi-
dence  des  relations  existant  entre  différentes
séries de données. Chaque paire de valeurs (X|Y)
est affichée comme un point dans un système de
coordonnées.

Toile (radar)  affiche  les  valeurs  de  données
comme des points connectés par des lignes, sur
une grille en toile qui ressemble à une toile d'arai-
gnée ou à un affichage sur un écran radar. Pour
chaque  ligne  de  données  du  diagramme,  une
ligne radiale est affichée sur laquelle les données
sont tracées. Toutes les valeurs de données sont
affichées avec la même échelle, de façon à avoir
même  magnitude.  Généralement  utilisés  pour
comparer la valeur totale de plusieurs séries de
données.

Bulle : s'utilise pour mettre en relation 3 séries de
données. Une série est représentée par l’axe des
x, une série par l’axe des y et la dernière par la
taille des bulles.

Cours : illustre la tendance du marché en fonction
du cours d'ouverture, du cours plancher, du cours
plafond et du cours de clôture.

Colonne et ligne (courbe/histogramme) : permet
de combiner deux types de représentations gra-
phiques  pour  comparer  de  multiples  séries  de
données : superposition,  par  exemple,  d'un gra-
phique en courbes représentant les données de
ventes  réalisées,  à  un  graphique  en  histo-
grammes,  représentant  les  données des  ventes
prévues. 

Étape 2 : Plage de données
La boîte de dialogue affiche l'adresse de la plage
des données sources et permet de la modifier ou
même de complètement la redéfinir.

On peut donc tout à fait démarrer la création d'un
graphique  sans  aucune  sélection  préalable  des
données sources et définir complètement la plage
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de  données  à  représenter  au  cours  de  cette
étape.

La plage des données sources à représenter doit in-
clure les titres de lignes et de colonnes.

Différentes méthodes sont possibles pour définir
la plage de données sources :

– Cliquer sur le bouton situé à droite du champ
Plage de données, pour réduire la boîte et per-
mettre des sélections directes dans le tableau
de données à l'aide de la souris.

– Saisir directement la plage de données dans la
zone éditable de la boîte en utilisant le point-vir-
gule  comme  séparateur  entre  des  plages
lorsque la plage de données sources n'est pas
monobloc.

– Si les données sont regroupées dans un tableau
simple,  constituant  une  plage  monobloc,  le
simple fait de sélectionner l'une des cellules suf-
fit pour que le programme localise correctement
les données à représenter.

– Si  les  données  sont  réparties  sur  plusieurs
plages non adjacentes, ou qu'on ne souhaite re-
présenter  que  partiellement  les  données  d'un
tableau, la sélection devra se faire à la souris,
avec la touche CTRL enfoncée, et les zones sé-
lectionnées devront être de même longueur et
intégrer les en-têtes de lignes et de colonnes.

Il reste encore préciser si les données à représen-
ter sont disposées en  lignes ou en  colonnes. En
effet, selon le mode d'organisation choisi lors de
la  construction  du  graphique,  la  signification  de
celui-ci ne sera pas le même, comme montré ci-
dessous.

Données en colonnes
Les étiquettes de l'axe X correspondent aux va-
leurs  présentes  dans  la  première  colonne  du
tableau source. 

Dans ce type d'organisation, lorsque plusieurs sé-
ries  de  valeurs  doivent  être  représentées,

chacune d'entre elles dispose d'une colonne pour
ranger ses valeurs, et chaque en-tête de colonne
s'inscrit  comme élément  de  la  légende  du  gra-
phique. 

Si les en-têtes de colonnes font défaut, la légende
par défaut affichera Série 1, Série 2, Série 3, etc. 

Données en lignes
Les valeurs de l'axe X correspondent aux valeurs
contenues dans la première ligne de la sélection.
Les  lignes  suivantes  contiennent  les  différentes
séries  de valeurs  représentées  et  ce sont  cette
fois les étiquettes de lignes qui sont reprises dans
la légende.

Étiquettes de données
Lorsque cette option est cochée, les options Pre-
mière  ligne /  Première  colonne  comme  libellé
permettent  d'utiliser  les  entrées  de  la  première
ligne ou de la première colonne de la sélection
comme étiquettes de la plage de données et non
comme série de données à représenter.

Étape 3 : Séries de données

Cette  étape  permet  de  modifier  les  données
prises en compte dans le graphique. 

© 2014 - G. Waterval Version : 19.01.14 Apache licence, Version 2.0

O O o 4 K i d s   -  A p a c h e  O p e n O f f i c e    T M   -  O O o L i g h t
Des  solutions l ibres  et  gratuites  pour votre bureautique privée et  profess ionnel le

Page 69/92 

http://www.apache.org/licenses/LICENSE-2.0
http://wiki.ooolight.org/index.php/Main_Page/fr
http://www.openoffice.org/fr/
http://www.openoffice.org/fr/
http://wiki.ooo4kids.org/index.php/Main_Page/fr


6. Les diagrammes

Celles-ci sont classées en séries dans la liste inti-
tulée  Séries  de  données.  Il  est  possible  ici  de
supprimer ou d'ajouter des séries de données au
graphique.

Chaque série possède un nom et la référence de
la  cellule  qui  le  contient  s'affiche  dans  la  zone
Plages de données. Pour modifier ce nom, il suffit
de changer sa référence dans la zone Plage pour
nom.

Sous le nom de la série sélectionnée, à droite de
l'intitulé  Valeurs  Y,  se trouve la  référence de la
plage de données sources correspondant à la sé-
rie  sélectionnée.  Sous  la  zone  Catégories,  se
trouve la référence de la plage contenant les éti-
quettes de l'axe X.

On peut ajouter de nouvelles séries figurant dans
le tableau des données (bouton Ajouter), ou sup-
primer  du  graphique  des  séries  sélectionnées
dans  la  liste  (bouton  Retirer).  Il  est  également
possible, grâce à deux boutons fléchés, de réor-
ganiser la liste des séries pour modifier leur ordre
d'affichage dans le graphique, mais sans rien mo-
difier dans le tableau des données sources. 

Étape 4 : Éléments du 
diagramme
La quatrième boîte de dialogue de l'Assistant pro-
pose une série d'options qui concernent la mise
en forme des éléments internes du graphique. On
peut ainsi définir ses titres, ainsi que l'intitulé de
ses axes en les saisissant dans des champs édi-
tables. 

Lorsque l'option  Afficher  la  légende est  cochée,
on peut choisir parmi 4 options de position pour
celle-ci.

Le bouton  Terminer créé le graphique avec les
options choisies et referme l'Assistant.

La boîte  propose encore de choisir  d'afficher  le
graphique avec des lignes de quadrillage pour les
axes. 

6.2. Commandes disponibles
Un graphique  inséré  peut  être  sélectionné  d'un
simple clic de souris, comme un simple objet gra-
phique, ou activé par un double clic, c'est à dire
mis en mode  Édition pour pouvoir travailler des-
sus. 

Graphique sélectionné
Lorsqu'un diagramme est sélectionné d'un simple
clic de souris, il s'entoure d'une bordure de sélec-
tion  comprenant  8  poignées  de
redimensionnement.  vertes.  Dans cet  état,  il  se
comporte comme n'importe quel autre objet inséré
(image, dessin, etc.), et il est redimensionnable et
déplaçable à l'aide de la souris.

Pour désélectionner le diagramme, il suffit de 
cliquer en dehors de lui.

Les commandes à disposition se trouvent toutes
dans le menu  Format ou le menu contextuel du
graphique sélectionné. 

Un clic droit sur le dia-
gramme  laisse
apparaître  le  menu
contextuel classique
d'une  image  insérée,
avec  toutes  les  com-
mandes  qui  sont
applicables  dans  ce
cas.

La  commande  contex-
tuelle  Éditer permet de
basculer  en mode  Édi-
tion pour  modifier  le
diagramme.

La barre d'outils  Image apparaît avec toutes les
commandes  classiques  de  manipulation  d'une
image insérée (couleur de remplissage, style de
ligne, alignement, positionnement, rotation, etc.).
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Si vous utilisez AOO 4.xx, ces commandes sont éga-
lement à disposition dans le volet des Propriétés de
la barre latérale.

Graphique activé (mode 
Édition)
Le mode Édition s'obtient par un double clic sur le
graphique et se caractérise par l'apparition de 8
poignées carrées noires distribuées sur une bor-
dure épaisse et grisée qui entoure le diagramme.

Lorsqu'un graphique se trouve dans ce mode (on
dit parfois qu'il est activé), on peut accéder indivi-
duellement à ses éléments internes : 

– Par un simple clic : dans ce cas, l'élément poin-
té par la souris est sélectionné et il est possible
de le déplacer et de le redimensionner à l'aide
de la souris ou encore de la manipuler, comme
tout  objet  inséré,  par  l’intermédiaire  des  com-
mandes de son menu contextuel. La commande
Format > Formater la sélection ... fait basculer
l'élément sélectionné en mode Édition pour per-
mettre son formatage.

– Par un double clic : dans ce cas, c'est l'élément
pointé qui bascule à son tour en mode édition,
ce qui se traduit par l'ouverture de sa boîte de
propriétés renfermant toutes les options à dispo-
sition pour le mettre en forme.

Menu Format
En mode  Édition,  le menu  Format se modifie et
propose  directement  les  commandes  de  forma-
tage des différents éléments internes (axes, titres,
légende,..) ou encore la commande Type de dia-
gramme qui  permet  de  modifier  le  type  du
graphique. Les commandes principales sont répé-

tées  dans  le  menu  contextuel  associé  au  gra-
phique. 

Ces commandes permettent de procéder à la mise
en forme d'un élément interne sans que celui-ci n'ait
été au préalable sélectionné par un clic de souris.

Menu Insertion
En mode  Édition,  le menu  Insertion propose les
commandes suivantes, permettant l'insertion des
éléments suivants dans le graphique : Titre – Lé-
gende – Axes – Grilles – Étiquettes de données –
Courbe  de  tendance  –  Courbes  de  valeur
moyenne – Barres d'erreur Y.

Barre d'outils Formatage
Dans le cas d'un graphique activé, la barre d'ou-
tils Formatage se modifie et propose une série de
boutons permettant d'agir directement sur le dia-
gramme pour y effectuer des modifications.

– La liste déroulante  Sélectionner l'élément du
diagramme permet de choisir la zone à forma-
ter sans devoir la sélectionner au préalable.

– Le bouton Formater la sélection ouvre la boîte
permettant  de  formater  l'élément  sélectionné
dans la liste Zone du diagramme. 

– Le bouton Type de diagramme ouvre la fenêtre
qui permet de changer de type.

– Le bouton Afficher/masquer la grille horizon-
tale permet  d'afficher  ou  de  masquer  la  grille
pour l'axe X

– Le bouton Afficher/masquer la légende permet
d'afficher ou de masquer la légende

– Le bouton Échelle de texte permet de modifier
l'échelle du texte du diagramme lorsqu'on modi-
fie la taille du diagramme.

– Le bouton  Réorganiser le diagramme  permet
d'ajouter  ou de  supprimer  des  séries  de  don-
nées  ou  encore  de  modifier  leur  ordre
d'affichage dans le diagramme.

6.3. Changer de type de 
graphique

Pour changer de type de représentation :
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– Double-cliquez  sur  le  graphique  pour  le  faire
basculer en mode Édition (bordure de sélection
grise).

– Lancez la commande  Format > Type de dia-
gramme … ou cliquez sur le bouton  Type de
diagramme dans la barre d'outils Formatage. 

La boîte de dialogue ci-dessous s'ouvre avec la
liste des types de représentations possibles.

Cette  boîte  permet  de  choisir  un  type  de  gra-
phique  dans  une  liste  et  propose  pour  chaque
type  une  série  de  variantes  (sous-types)  pos-
sibles. 

Cliquez dans la colonne centrale sur les différents
types de diagramme pour faire apparaître à droite
les aperçus des sous-types disponibles. 

En cochant la case 3D, vous obtiendrez un dia-
gramme  en  relief  et  vous pouvez  également
changer  la  valeur  Simple de  la  liste  déroulante
pour la valeur Réaliste afin d'obtenir un rendu final
plus fin.

6.4. Modifier les éléments d'un 
graphique

Pour accéder aux éléments internes du graphique
et pouvoir les modifier, il faut d'abord basculer le
graphique  en  mode  Édition en  double  cliquant
dessus. 

Une fois le graphique activé, trois méthodes per-
mettent d'accéder à la boîte de modification d'un
élément :

– Choisir  directement  dans  le  menu  Format la
commande  qui  permet  de  modifier  l'élément
souhaité. Cette procédure évite de devoir sélec-
tionner à la souris l'élément à modifier.

– Cliquer sur l'élément à modifier  pour le sélec-
tionner, puis choisir la commande permettant de
le modifier dans son menu contextuel. Comme

l'élément est sélectionné, on peut également le
déplacer ou le redimensionner  à la souris.  La
sélection de l'élément à modifier peut également
se faire depuis la liste Sélectionner l'élément de
diagramme dans la barre d'outils Formatage.

– Double cliquer sur l'élément à modifier pour à la
fois  le  sélectionner  et  directement  ouvrir  sa
boîte de modification.

Modifier la plage de données
Lorsque le graphique est activé et que sa  Paroi
ou  son  Arrière-plan sont  sélectionnés,  la  com-
mande contextuelle Plages de données ouvre la
boîte  de même nom comprenant  deux onglets :
Plage de données et Séries de données.

Onglet "Plage de données"
Permet de redéfinir à la souris la plage de don-
nées,  de  changer  la  disposition  des  données,
ainsi que les lignes d'intitulés. 

Cette boîte correspond à l'étape 2 de l'Assistant.

Onglet "Séries de données"

Cet onglet permet de modifier les données prises
en compte dans le graphique. Celles-ci sont clas-
sées  en  séries  dans la  liste  intitulée  Séries  de
données. 
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Cette boîte correspond à l'étape 3 de l'Assistant

Les séries de données
Lorsque le graphique est activé, un simple clic sur
l'une des données représentées sélectionne auto-
matiquement  la  série  correspondante  et  un
rectangle bleu encadre les données concernées
dans le tableau source. 

À ce moment, la commande contextuelle Forma-
ter les séries de données ... ouvre une boîte de
dialogue  de  formatage  intitulée Séries  de  don-
nées.

Cette boîte renferme, dans ses 4 onglets, toutes
les options de mises en forme des données de la
série sélectionnée. On peut ainsi choisir un type
de ligne, une couleur de remplissage et une trans-
parence applicable aux données de la série. 

Les données d'une série peuvent encore être étique-
tées  par  la  commande  contextuelle Insérer  des
étiquettes de données et on peut leur ajouter des
barres d'erreurs par la commande contextuelle Insé-
rer des barres d'erreurs Y.

Lorsque le type de graphique le permet, un onglet
Statistique supplémentaire  permet  d'afficher,  sur
les  données  d'une  série,  des  marques  d'erreur,
après  avoir  choisi  sous  Catégorie  d'erreur,  l'un
des modes d'expression proposés pour la marge
d'erreur (variance, écart type, pourcentage,erreur
maximale ou valeur constante).

Dans le cas d'un graphique XY, une courbe de ré-
gression  peut  être  ajoutée  par  la  commande
contextuelle Insérer une courbe de tendance. 

Créer et modifier des titres
L'édition  d'un  titre  (titre  du  graphique  ou  titre
d'axe) n'est possible qu'après un double clic sur la
zone de titre pour y faire apparaître un curseur
d'édition. 

La création d'un titre se fait par la commande In-
sertion > Titres …

La mise en forme d'un titre se fait par l'intermé-
diaire de la commande Format > Titre ou encore
à l'aide de la commande  Format > Formater la
sélection ... lorsque le  titre  est  sélectionné (en
mode édition). La boîte qui s'ouvre renferme des
options (bordures, remplissage, transparence, ca-
ractères, effets de caractères et alignement) qui
permettent  une  mise  en  forme  complète  des
zones de titre.

Créer ou modifier une légende
La commande Insertion > Légende ….ouvre une
boîte permettant de créer une légende et de choi-
sir la position qu'elle occupera sur le graphique. 

La mise en forme d'une légende existante se fait
par la commande Format > Légende …, ou par
appel de la commande contextuelle équivalente,
si la légende est déjà sélectionnée. 

La boîte de formatage de légende renferme, sous
6 onglets, les options nécessaires au formatage
complet d'une légende : définition d'une bordure,
d'un  fond  et  d'une  transparence,  options  com-
plètes de formatage de caractères.

Les axes et de leur quadrillage
La  commande  Insertion  >  Axes  ... ouvre  une
boîte qui permet d'ajouter des axes secondaires X
et Y ou un axe axe Z à un diagramme 3D.

La commande Format > Axe permet de formater
les différents axes. La boîte de mise en forme des
axes comporte 4 onglets qui permettent un forma-
tage complet de tout axe sélectionné. 

– L'onglet Ligne permet de choisir le style de ligne
utilisé pour représenter l'axe, ainsi que sa cou-
leur et son épaisseur.

– Les onglets Caractères,  Effets de caractères et
Étiquette servent  à  la  mise  en forme des éti-
quettes des graduations de l'axe et à leur définir
une orientation et un positionnement.

La commande  Insertion > Grilles … permet de
rajouter un quadrillage à un axe.

La commande Format > Grille permet de forma-
ter le quadrillage des différents axes.

Les étiquettes  des  axes  et  leurs  graduations  sont
automatiquement  héritées  des  graduations  et  éti-
quettes présentes sur les en-têtes de lignes et de
colonnes dans la feuille de calcul.
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Paroi du graphique

La  Paroi du diagramme correspond à  sa partie
centrale,  où  se  trouvent  représentées  les  don-
nées,  comme  le  montre  la  copie  d'écran  ci-
dessous.

On peut également la formater (contour et couleur
de remplissage) à l'aide de la commande Format
> Paroi du diagramme... 

Arrière-plan du graphique

L'arrière-plan correspond à toute la surface occu-
pée par le diagramme comme le montre la copie
d'écran ci-dessous. La commande  Format > Ar-
rière-plan du diagramme permet de le mettre en
forme (bordure, couleur d'arrière-plan et transpa-
rence).

6.5. Ajouter des dessins
Il est possible d'intégrer à un graphique des gra-
phismes ou des zones de texte créés à l'aide de
la barre d'outils  Dessin (commande  Affichage >

Barres d'outils > Dessin) ou encore des images
en provenance de la Gallery. 

Par défaut, les éléments insérés se disposent en
avant plan du diagramme et il est possible d'éditer
du texte à l'intérieur. 

On peut  manipuler  de  tels  objets  par  l'intermé-
diaire de leurs menus contextuels. 

6.6. Graphiques 3D
Dans un graphique 3D, après sélection de sa Pa-
roi ou  de  son  Arrière-plan ,  il  est  possible  de
modifier la disposition des séries de données en
les déplaçant vers l'avant ou l'arrière, à l'aide des
commandes  Format  >  Disposition  >  Vers
l'avant / Vers l'arrière. 

Une telle modification peut parfois améliorer la li-
sibilité du diagramme sans toutefois affecter ses
données sources.

À la suite d'une telle manœuvre,  il  n'est toutefois
plus possible de modifier la disposition des données
(en lignes ou en colonnes).

On peut affecter à des diagrammes 3D (en mode
édition)  un  certains  nombre  d'effets  particuliers,
par la commande Format > Affichage 3D : ajus-
ter  le  filtre  couleur,  la  lumière  ambiante  et  la
direction de l'éclairage. 

On peut faire basculer et pivoter des diagrammes
3D en mode Édition en se servant des poignées
rouges qui apparaissent sur le pourtour de leur ar-
rière-plan  lorsque  celui-ci  est  sélectionné
(diagramme au préalable en mode édition).
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Une  liste de données est une collection d'infor-
mations organisée en une suite d'enregistrements
(ou fiches), eux-mêmes structurés en un certain
nombre de rubriques (champs)  pouvant  être  de
type  numérique,  textuel,  date,  formule  (champs
virtuels), etc.

Dans une feuille de calcul, une telle liste occupe
une zone rectangulaire, dans laquelle la première
ligne doit toujours être réservée aux intitulés des
champs  (en-têtes  de  colonnes),  chacune  des
lignes suivantes  correspondant  à  un  enregistre-
ment. 

On conseille  généralement de réserver  une feuille
de calcul entière par liste, afin de se ménager toutes
les possibilités d'extensions futures et faciliter la sé-
lection de la liste par le programme.

Si  on  souhaite  faire  cohabiter  sur  une  même
feuille une liste avec d'autres tableaux, il peut être
utile de déclarer au programme la zone qu'elle oc-
cupe en lui  donnant un nom, par la commande
Données >– Définir  la plage….  Par la suite,  il
sera alors plus facile de la sélectionner la liste en
se basant sur son nom affiché dans la boîte ou-
verte par la commande Données > Sélectionner
la plage.

Pour sélectionner la zone occupée par une liste on
peut également :
• Cliquer dans une cellule quelque part à l'intérieur

de la plage de données. 
• Sélectionner la totalité de la liste.

7.1. Créer une liste
1) On commence par définir la structure des enre-
gistrements de la liste, c'est à dire les différents
champs qui seront utilisés, au niveau de chaque
enregistrement, pour stocker les informations de
manière  homogène.  Concrètement,  cette  étape
consiste  à  écrire,  dans  la  première  ligne  de  la
liste, les intitulés des champs qui serviront au sto-
ckage  des  informations  dans  les  différents
enregistrements.  Ainsi,  si  on souhaite créer une
liste d'adresses, ces intitulés peuvent être : Nom,
Prénom,  Adresse,  Téléphone,  Fax,  Émail,  Code
Postal, Ville, etc... On peut attribuer un formatage
différent à cette première ligne pour mieux la dis-
tinguer  des  suivantes  qui  seront  réservées  aux
enregistrements.

2) Sans ménager de ligne vide après la ligne des
intitulés de champs, saisir les premiers enregistre-
ments de la liste, un enregistrement par ligne, et
formater  les  valeurs  de  manière  adéquate  (for-
mats numériques ou formats de date ad hoc). 

3)  Afin  de  faciliter  les  extensions  futures  de  la
liste, on peut  directement préformater  complète-
ment ses colonnes pour éviter d'avoir à le faire au
coup par coup lors de l’ajout de nouveaux enre-
gistrements.  Pour  une  raison  similaire,  on
procédera  à  une  recopie  des  champs  virtuels
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(champs contenant une formule) jusqu'au bas de
la feuille. On pourra être amené à utiliser la com-
mande  Fenêtre  >  Fixer pour  maintenir  en
permanence visible la ligne des titres de colonnes
(intitulés de champs) et faciliter ainsi la navigation
dans les enregistrements de la liste.

4) On peut enfin, si on le souhaite, utiliser la com-
mande  Données  >  Définir  la  plage… pour
attribuer un nom à la plage de base de données
créée.

7.2. Trier les données
Trier  des  lignes  de  données  selon  certains  cri-
tères consiste à les réorganiser de manière à ce
qu'elles se suivent dans l'ordre souhaité.

Le  critère de tri, à l'inverse du critère de filtrage,
ne produit pas de masquage de données. Il sert
essentiellement à définir un ordre de succession
pour l'affichage des enregistrements ou des lignes
de données d'un tableau. Filtrage et tri sont donc
deux concepts différents.

Pour  pouvoir  rétablir  facilement  l'ordre  initial  des
données après plusieurs tris successifs, vous pouvez
procéder comme suit :
1. Avant le tri, créez une nouvelle colonne à droite

de la dernière colonne de la liste et inscrivez de-
dans une suite continue de chiffres.

2. A la fin de vos opérations de tri, effectuez un tri
croissant de votre liste sur base du contenu de
cette dernière colonne.

Sélectionner la liste à trier
Calc est capable de reconnaître automatiquement
une liste lorsque ses titres de colonnes sont pla-
cés  au-dessus  d'un  bloc  de  données  contigu,
sans cellules vides ni cellules fusionnées, comme
c'est le cas dans la copie ci-dessous pour la liste
Standard. Dans un tel cas de figure, le simple fait
de sélectionner l'une des cellules de la liste per-
met  au  programme  d'étendre  lui-même  la
sélection à l'ensemble de la liste. Mais vous pou-
vez  bien  sûr  également  utiliser  la  méthode  de
sélection classique décrite ci-dessous.

Si votre liste n'est pas disposées de manière stan-
dard, comme c'est le cas dans le tableau intitulé
Non Standard,  qui  présente  en  haut  de  la  liste
deux lignes de titres s'étalant  sur  plusieurs  cel-
lules fusionnées, la sélection d'une cellule de la
liste ne permet plus au programme d'étendre lui-
même la sélection à toute la liste et vous devez
dans ce cas sélectionner manuellement les enre-
gistrements de la liste à trier. 

Dans le cas d'une disposition standard, vous pouvez
même inclure dans la sélection la ligne des en-têtes
de colonnes, car le programme est capable de la re-
connaître lui-même et de l'exclure du tri.

Tri rapide (boutons de tri)
Cette méthode fait appel à deux boutons intégrés

dans la barre d'outils  Standard,   l'un pour
effectuer un tri croissant et l'autre pour un tri dé-
croissant. Elle permet de trier une liste sur un seul
critère qui correspond à la colonne contenant la
cellule active.

Une fois votre plage de données sélectionnée, et
avant de lancer votre commande de tri, vous pou-
vez déplacer la cellule active dans la colonne qui
vous servira de critère de tri à l'aide de la touche
Tab ou de la combinaison de touches Maj+Tab
sans perdre votre sélection. 

Une fois votre sélection et la colonne servant de
critère bien désignée, appuyez simplement sur le
bouton correspondant au sens de tri à effectuer :
croissant ou décroissant.

Dans la copie d'écran ci-dessus, la cellule active est
située dans la colonne Résultats ce qui signifie que
le tri s'effectuerait dans ce cas par rapport aux va-
leurs de cette colonne.

Utiliser la boîte Trier
Sélectionner la plage de données à trier, celle-ci
peut inclure toute la liste ou seulement une partie
de celle-ci extraite par un filtre.

S'il s'agit de trier la totalité de la liste, le simple fait
d'y placer le pointeur suffit si la disposition de la
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liste est classique, sans cellules vides ni cellules
fusionnées. 

Appeler  alors  la  commande  Données >  Trier...
pour ouvrir la fenêtre de dialogue de tri.

Onglet "Critères de tri"
Il permet de définir les différentes clés de tri sou-
haitées  en  les  sélectionnant  dans  les  listes
déroulantes  Trier  selon et  Puis  selon.  Pour
chaque clé de tri définie, choisir entre un tri crois-
sant ou décroissant.

Les trois  clés  disponibles  dans la  boîte  de dia-
logue sont classées par ordre de priorité : lors du
tri,  la première clé définit  un sous groupe de la
liste sur lequel sera appliqué le second critère de
tri, puis le troisième s'il a été spécifié.

1. Sélectionner la clé primaire (clé de tri N°1) puis
choisir  dans la liste déroulante le champ par
rapport auquel les fiches seront triées. Ensuite,
sélectionner le type de tri  souhaité (croissant
ou décroissant). 

2. Entrer  une clé  secondaire si  nécessaire  (par
exemple dans le cas où plusieurs fiches satis-
font  au  premier  critère  de  tri),  puis
éventuellement encore une troisième en spéci-
fiant pour chacune d'elles le sens croissant ou
décroissant du tri souhaité.

3. Cliquer sur OK ou appuyer sur Enter pour lan-
cer la commande.

Onglet "Options"
L'onglet Options de tri permet d'affiner le tri en de-
mandant, par exemple, un tri respectant la casse
(termes en majuscules triés avant ceux en minus-
cules).

L'option  La plage contient des étiquettes de co-
lonne permet d'exclure du tri la première ligne de

la liste, c'est à dire celle contenant les en-têtes de
colonnes.

L'option  Copier le résultat du tri  vers permet de
définir  une  plage  destinataire  vers  laquelle  on
peut copier le résultat du tri.

La rubrique  Direction permet de choisir entre ef-
fectuer un tri en lignes (de haut en bas), qui est
l'option par défaut, ou au contraire, un tri de co-
lonnes (de gauche à droite).

7.3. Filtrer une liste
Le filtrage d'une plage de base de données per-
met  de  limiter  son  affichage  aux  seuls
enregistrements  qui  satisfont  au(x)  critère(s)  de
filtre  défini(s),  Calc  masquant  temporairement
tous les autres enregistrements.

Le  filtrage  permet  d'extraire  certains  enregistre-
ments pour les utiliser dans un autre contexte, par
exemple comme données pour un mailing.

Plusieurs types de filtres peuvent être définis. Du
plus simple au plus élaboré, on distingue :

– Le filtre automatique, à un critère. 
– Le filtre standard, qui peut comprendre jusqu'à

3 critères.
– Le filtre spécial, qui permet d'intégrer jusqu'à 8

critères dans un filtre.

Filtre automatique (1 critère)
Sélectionner  la  liste,  puis  lancer  la  commande
Donnée > Filtre – AutoFiltre. 
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Un bouton fléché apparaît alors sur la droite de
chaque intitulé de champ. Ces différents boutons
donnent  accès à la  liste  des  valeurs  du champ
correspondant, valeurs qui constituent autant de
critères possibles pour filtrer la liste.

Le résultat du filtrage réduit l'affichage de la liste
aux seuls enregistrements qui satisfont au critère
choisi.

À ce moment, vous pouvez tout à fait filtrer à nou-
veau les enregistrements qui  vous sont  affichés
selon  un  nouveau  critère.  Cette  méthode  vous
permet donc d'appliquer une série de filtres suc-
cessifs à 1 critère. 

Pour abandonner  le  filtre et  retourner à un affi-
chage  complet,  rappelez  simplement  la
commande Données > Filtre – AutoFiltre.

Filtre standard (1 à 3 critères)
Les  critères  définis  par  la  méthode  précédente
sont très précis puisqu'ils filtrent la liste en se ba-
sant sur une de ses valeurs pour un champ. Dans
certains cas toutefois, on souhaite un filtrage plus
large, reposant sur plusieurs critères combinés à
l'aide des opérateurs ET et OU.

La commande  Données > Filtre  – Filtre stan-
dard... offre cette possibilité. Elle ouvre une boîte
de dialogue qui permet de définir un filtre compor-
tant jusqu'à trois critères. 

Pour utiliser cette commande, il faut d'abord sélec-
tionner complètement la  plage correspondant à la
base en n'omettant pas d'inclure dans cette sélec-
tion la ligne d'en-têtes de champs.

La boîte ci-dessus nous offre, pour les trois cri-
tères  possibles,  les  listes  déroulantes  Nom  de

champ, Condition et Valeur qui permettent d'éditer
individuellement  les  critères  composant  le  filtre,
tandis  que la  rubrique  Opérateur permet  de les
combiner à l'aide des opérateurs ET/OU. 

Un clic sur le bouton Plus d'options rajoute à la
boîte  un  certain  nombre  d'options  supplémen-
taires qui permettent de préciser plus encore les
conditions dans lesquelles on souhaite réaliser le
filtrage et de définir une zone de destination si on
souhaite obtenir une copie du résultat du filtrage
de la base.

La copie d'écran ci-dessous réalise la filtration de
la base en ne retenant que les enregistrements
de l'équipe Gilson, pour le canton de Fribourg, et
qui  datent  du  05.04.1999 ou  sont  antérieurs  à
cette date. Dans la rubrique  Options nous avons
demandé la recopie des résultats filtrés dans une
zone dont  le  coin  supérieur  gauche doit  être  la
cellule H1 de la même feuille.

Le résultat du filtrage est le suivant :

• Si on a activé la case  Copier le résultat vers et
spécifié  une plage cible,  l'option  Conserver  les
critères de filtre permet d'établir un lien perma-
nent entre la plage cible et la plage source, pour
autant que celle-ci ait été auparavant définie en
tant  que  plage  de  données  par  la  commande
Données – Définir une plage. Le filtre ainsi dé-
fini peut alors être exécuté par l'intermédiaire de
la commande  Données > Actualiser la plage
dès  que  le  curseur  se  trouve  dans  la  plage
source. 

• Si on n'a pas décidé de copier les résultats du fil-
trage  vers  une  zone  de  la  feuille,  les
enregistrements filtrés remplacent l'affichage de
la base. Pour retrouver  l'affichage de celle-ci,  il
suffit de lancer la commande Données > Filtre
> Supprimer le filtre.

Filtre spécial (1 à 8 critères)
La  commande  Données  >  Filtre  –  Filtre
spécial... ouvre  une  boîte  qui  permet  de
construire  un  filtre  pouvant  comporter  jusqu'à  8
critères combinés. 

Le filtre  est  créé  directement  dans la  feuille  de
calcul avant le lancement de la commande de fil-
tration.

Construire un filtre spécial
Recopier,  de préférence dans une ligne en haut
de la liste, la ligne des en-têtes de champs de la
liste. 
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Le lancement de la commande  Insertion > Ligne
peut  s'avérer  nécessaire  si  on  ne  dispose  pas  de
toute la place nécessaire en haut de la liste. On peut
ménager, si on le souhaite, une ligne vide entre la
zone de critères et la ligne des intitulés des champs
pour bien séparer celle-ci de la zone de critères.

Sous chaque intitulé de champ recopié, entrer au
clavier les valeurs qui serviront de critères dans le
filtre (8 critères au maximum). 

• Vous pouvez utiliser les opérateurs de comparai-
son (< ; > ; <= ; >= ) dans l'édition des critères
numériques, monétaires ou de type date. 

• Si vous utilisez des caractères génériques, vous
devrez  activer  l'option  correspondante  dans  la
boîte de dialogue Filtre spécial avant de valider la
commande. 

Les  critères  reliés  par  l'opérateur  logique  OU
doivent être saisis dans des lignes différentes de
la zone de critères, car cet opérateur connecte les
données affichées verticalement. 

Les  critères  reliés  par  l'opérateur  logique  ET
doivent être saisis au sein de la même ligne dans
la zone de critères, car cet opérateur connecte les
données  affichées  horizontalement  dans  une
ligne.

Appliquer le filtre créé
Sélectionner la plage de base de données à filtrer,
avec sa ligne d'en-têtes de colonnes, puis lancer
la  commande  Données  >  Filtre  –  Filtre
spécial.... 

La boîte de dialogue Filtre spécial s'ouvre et c'est
à partir de là que sera lancé le processus de fil-
trage de la liste de données.

Dans la boîte de dialogue  Filtre spécial, la zone
de liste déroulante  Lire les critères de filtre dans
permet de sélectionner le nom de la zone de cri-
tères, pour autant que celui-ci ait été défini. Si ce

n'est pas le cas, il faut entrer dans le champ situé
à droite l'adresse de la plage correspondant au
critère  ou  la  sélectionner  directement  dans  la
feuille de calcul.

Dans l'exemple ci-dessus, on voit qu'on cherche à
filtrer  les  enregistrement  satisfaisant  aux  condi-
tions suivantes : ils  concernent  l'équipe Decortis
ET ne concernent que le canton de Fribourg ET
doivent être antérieurs au 10.05.99 OU sont ceux
de l'équipe Gilson concernant le canton du Jura
uniquement. 

Comme dans le  cas  du filtre  standard,  la  boîte
nous propose des options supplémentaires nous
permettant encore d'affiner le filtrage.

La copie d'écran suivant affiche les résultats obte-
nus dans la base exemple filtrée sur place (c'est à
dire sans recopier les résultats à un autre endroit
de la feuille).

Pour revenir à l'affichage complet de la liste, lan-
cer la commande Données > Filtre – Supprimer
le filtre.

7.4. Informations de synthèse
La commande  Données > Sous-totaux… ouvre
une boîte de dialogue permettant de trier une liste
de données selon divers critères pour l'organiser
en groupes auxquels on peut ajouter des informa-
tions de synthèse.

Par exemple, si une liste contient des enregistre-
ments de chiffres de ventes réalisés par diverses
équipes dans diverses régions (feuille Ventes), on
peut comparer les chiffres réalisés par les diffé-
rentes équipes, ou encore comparer les chiffres
réalisés par régions (cantons),  indépendamment
des  équipes  de  vente  qui  les  ont  réalisés.  De
telles informations peuvent être obtenues par l'in-
sertion d'informations de synthèse dans la liste.

L'insertion  de  telles  informations  suppose un tri
préalable de la plage de base de données, le cri-
tère de tri  à  appliquer  correspondant  au champ
selon lequel les données doivent d'abord être re-
groupées, avant d'être synthétisées à l'aide de la
fonction de calcul souhaitée.
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La boîte Sous-totaux
La boîte  Sous-totaux  regroupe,  sous  4  onglets,
toutes les options nécessaires à l'insertion d'infor-
mations de synthèse dans une liste sélectionnée. 

Les  trois  onglets  1er  groupe,  2e  et  3e  groupe,
permettent  de définir  jusqu'à trois  groupes pour
lesquels des informations de synthèse seront cal-
culées.

Pour définir un sous-total pour un groupe, procé-
der comme suit :

1. Dans la zone de liste déroulante  Grouper se-
lon,  choisir  d'abord  le  critère  permettant  de
regrouper les données pour pouvoir y insérer
l'information de synthèse souhaitée. Si le tri n'a
pas été effectué sur la liste avant le lancement
de la commande  Données > Sous-totaux...,
ce tri préliminaire indispensable peut être de-
mandé depuis l'onglet  Options de la boîte en
cochant  Trier au préalable la plage selon les
groupes. 

2. La rubrique Calculer les sous-totaux pour per-
met  d'indiquer  la  ou  les  colonne(s)  qui
renferment  les valeurs à synthétiser  selon la
fonction choisie parmi celles qui se trouvent af-
fichées dans le volet droit de la boîte, intitulé
Fonction. 

3. Il reste alors à préciser, sous l'onglet  Options,
les préférences relatives à la présentation des
informations de synthèse à insérer.

– Saut  de  page  entre  les  groupes permet
d'insérer  automatiquement  un  saut  de
page  avant  chaque  groupe  de  données
faisant l'objet d'un sous-total.

– Respecter  la  casse permet  de  tenir
compte  des  majuscules  et  minuscules

dans la définition des groupes de sous-to-
taux.

– Trier  au  préalable  la  plage  selon  les
groupes donne l'ordre de tri  selon le cri-
tère  spécifié,  avant  de  procéder  à
l'insertion des  sous-totaux,  au cas  où la
liste n'aurait pas encore été triée.

4. Les options de la rubrique Trier permettent de
définir des choix quant à la manière dont le tri
doit  s'effectuer  pour  constituer  les  groupes
dans lesquelles des informations de synthèse
sont à insérer.

La validation de la commande par OK referme la
boîte  et  insère  les  sous-totaux  désirés  dans  la
plage de données. À ce sujet, remarquez les mo-
difications  intervenues  dans  la  présentation  de
votre  plage  de  données.  Des  boutons  de  com-
mandes apparaissent  à gauche des en-têtes de
ligne.

Ces  boutons  indiquent  les  enregistrements
(lignes) regroupés dans chaque sous-total. En cli-
quant  sur  un  bouton  affichant  le  signe  (-)  on
masque les lignes prises en compte dans le calcul
du sous-total, et seule la ligne affichant le sous-to-
tal reste visible. La liste peut donc être présentée
de manière résumée, en "condensant" ses diffé-
rents  niveaux,  ou,  au  contraire,  en  les
développant.

Un autre moyen de réduire ou de développer l'affi-
chage des détails entrant dans le calcul des sous-
totaux consiste à manipuler  les boutons chiffrés
de 1 à 3 apparaissant sur la gauche de la ligne
d'en-têtes de colonnes de la plage de données.

– Le bouton 1 produit l'affichage du résultat global
de la synthèse des données de la liste.
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– Le bouton 2 affiche le résultat global ainsi que
les résultats obtenus pour tous les groupes syn-
thétisés.

– Enfin, le bouton 3 affiche complètement la liste
des enregistrements avec les sous-totaux insé-
rés dans les différents groupes.

Un exemple concret
Voici ce que nous obtenons avec la feuille Ventes,
dont une capture d'écran partielle est affichée ci-
dessous. 

Si  nous effectuons un groupement par  Date (tri
croissant) et que nous calculons les sous-totaux
dans la colonne Chiffres avec la fonction Somme,
nous obtenons le résultat ci-dessous.

On remarque que :

– le  premier  sous-total,  celui  de  la  date  lun.
01.03.99 est montré avec ses détails comme en
témoigne le bouton (-)  et  le crochet à gauche
englobant  la  liste  des enregistrements  pris  en
compte dans son calcul ;

– le second sous-total, lun. 08.03.99 n'est pas dé-
taillé  comme  en  témoigne  le  signe  (+)  à  sa
gauche ;

– Le sous-total du lun. 15.03.99 est à nouveau dé-
veloppé avec la liste des enregistrements pris
en compte.

7.5. Le mode Plan
Le mode Plan améliore la lisibilité d'un tableau en
masquant certaines colonnes ou lignes contenant
le détail d'informations qu'il n'est pas nécessaire
d'afficher  en  permanence.  Trois  méthodes  sont
possibles pour réaliser cette opération :

– On peut masquer manuellement, à l'aide de la
souris,  les  lignes  et  les  colonnes "inutiles"  en
leur  attribuant  respectivement  une  hauteur  ou
une largeur  nulle.  Une telle  procédure s'avère
peu pratique lorsqu'on souhaite récupérer tem-
porairement  l'affichage  des  informations
masquées. 

– On  peut  procéder  à  des  regroupements  de
lignes ou de colonnes, après les avoir sélection-
nées,  par  la  commande  Données  >  Plan  et
groupe > Grouper...

– On peut  demander  l'affichage automatique du
plan de la feuille par la commande Données >
Plan et groupe > AutoPlan. Cette commande
ne fonctionne que pour des feuilles déjà structu-
rées par la présence de lignes ou de colonnes
intégrant  des  formules  de  synthèse  (sous-to-
taux, moyennes, etc...). 

Regroupement manuel
Les commandes  Données > Plan et groupe >–
Grouper .(F12) permet le regroupement de lignes
ou  de  colonnes  complètement  sélectionnées  et
formant une plage monobloc.

Si  on  ne  sélectionne  pas  des  lignes/colonnes  en-
tières mais qu'on limite la sélection à une plage de
cellules, le lancement de la commande de groupe-
ment  ouvrira  la  boîte  de  dialogue  Grouper
demandant de spécifier si ce sont les lignes ou les
colonnes  correspondant  à  la  sélection  qui  doivent
être regroupées.

À l'issue du groupement, le programme masque
les lignes/colonnes correspondantes et des bou-
tons apparaissent sur le bord gauche de la feuille
(en cas de regroupement  de lignes)  ou tout  en
haut du tableau (en cas de regroupement de co-
lonnes). 
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Ces  boutons  permettent  la  manipulation  des
plages groupées, pour les afficher de nouveau ou,
au contraire, les masquer d'un simple clic.

– Lorsqu'un bouton affiche un signe "-", cela signi-
fie que le groupe est ouvert c'est à dire que les
lignes/colonnes qui le composent sont affichées.

– Lorsque le bouton affiche un signe + cela signi-
fie  que  le  groupe  est  fermé  et  que  les
lignes/colonnes  qui  le  composent  sont  mas-
quées, comme en témoigne la rupture dans la
continuité  de  la  numérotation  des  lignes/co-
lonnes à cet endroit. 

Pour supprimer un groupe utiliser  la commande
Données  >  Plan  et  groupe  >  Dissocier
(Ctrl+F12) ou la commande  Données > Plan et
groupe  –  Supprimer pour  supprimer  tous  les
groupements  d'un  seul  coup  et  revenir  à  l'affi-
chage normal de la feuille.

Regroupement automatique
Si le tableau comporte déjà des éléments de syn-
thèse comme des sous-totaux,  moyennes,etc…,
on peut demander, par la commande Données >
Plan et groupe > AutoPlan que le programme se
base sur  ces  lignes/colonnes  de  synthèse pour
générer un plan de manière automatique.

La  copie  d'écran  ci-dessus  montre  un  tableau
comportant des informations de synthèse sur les-
quelles le programme peut se baser pour réaliser
un regroupement  de lignes et  colonnes de ma-
nière  automatisée.  On  y  voit  les  éléments  de
synthèse qui permettent la création des groupes
par la commande  Données > Plan et groupe >
Autoplan (lignes  Total  A,  B,  C et  colonnes Tri-
mestre 1, 2, 3).

Après  exécution  de  la  commande  Données  >
Plan et  groupe  >  AutoPlan,  on  obtient  un  re-
groupement  de  lignes  et  de  colonnes  sur  2

niveaux, comme le montre la copie d'écran ci-des-
sous.

En cliquant sur les symboles des groupements de
lignes, ou sur le numéro de niveau, on peut à loi-
sir faire apparaître ou disparaître les détails de la
feuille. Ainsi, en cliquant sur le numéro de niveau
1 pour les lignes, on obtient le niveau de regrou-
pement supérieur, comme illustré ci-dessous.

À ce stade, nous pourrions encore regrouper les
lignes 6, 10 et 14 par la commande  Données >
Plan et groupe > Grouper... et nous obtiendrions
dans ce cas un plan à 3 niveaux de lignes et 2 ni-
veaux de colonnes.

Les  boutons  numérotés  apparaissant  dans  le  coin
supérieur  gauche  du  tableau  nous  permettent  de
déterminer aisément le niveau de groupement que
nous souhaitons afficher pour les lignes et les co-
lonnes.

7.6. Tableau croisé dynamique
Le  Tableau croisé dynamique (TCD), encore ap-
pelé  parfois  Pilote  de  données,  permet  de
combiner, comparer et analyser de grandes quan-
tités  de  données.  Vous  pouvez  ainsi  visualiser
différents résumés des données source,  afficher
des  informations  détaillées  sur  les  aspects  qui
vous  intéressent  plus  particulièrement,  et  créer
des rapports.

Une table créée par le biais du TCD est interac-
tive : on  peut  organiser,  réorganiser  et  résumer
ses données selon différents points de vue. 
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Les données sources exploitables à l'aide de ce
concept peuvent provenir :

– d'une  plage  de  feuille  de  calcul,  à  condition
qu'elle  contienne  des  colonnes  étiquetées,
comme c'est le cas dans une liste de données ;

– d'un autre TCD.

La création d'un TCD à partir d'une plage de don-
nées  consiste  à  spécifier  les  champs  à  utiliser
comme titres de colonnes ou de ligne et ceux af-
fectés  aux  données  et  à  leur  synthèse  pour
atteindre la présentation souhaitée.

Éléments constitutifs d'un TCD
Pour  définir  les  éléments  constitutifs  d'un  TCD
nous partirons de l'exemple ci-dessous.

Champs de la page
Faites glisser un bouton vers la zone Champs de
la page afin de créer un bouton et une zone de
liste  au-dessus  du  tableau  croisé  généré.  Cela
permet d' utiliser la zone de liste pour le filtrer sur
la base du contenu de l'élément sélectionné. En
effectuant  un glisser-déposer  à  l'intérieur  du ta-
bleau croisé, on peut utiliser un autre champ de
page comme filtre.

Champs de ligne
Ce sont les champs auxquels on a attribué une
orientation de ligne dans le tableau croisé dyna-
mique.  Les  éléments  associés  à  un  champ  de
ligne  sont  affichés  sous  forme  d'étiquettes  de
lignes. Dans l'exemple ci-dessous,  Noms est un
champ de ligne. 

Champs de colonne
Ce sont les champs qui se verront attribuer une
orientation de colonne dans le TCD. Les éléments
associés à de tels champs s'affichent sous forme
d'étiquettes de colonnes. Dans l'exemple ci-des-
sous, Matières est un champ de colonne.

Champs de données
Ce  sont  les  champs  renfermant  les  données
sources synthétisées (obtenues par suite de l'utili-
sation d'une fonction de synthèse) ou pas. Dans

notre exemple,  Résultats est un champ de don-
nées. 

Définir la plage à analyser
Partons  du tableau ci-dessous,  représentant  les
résultats scolaires d'un groupe d'élèves dans dif-
férents  cours.  Nous  allons,  à  partir  de  ces
données, créer un tableau montrant la moyenne
des résultats obtenus par chaque élève pour l'en-
semble des matières, ainsi que la moyenne des
résultats obtenus par le groupe pour chaque ma-
tière.

Commençons par sélectionner  la  plage de don-
nées  à  exploiter,  avec  sa  ligne  d'en-têtes  de
colonnes, soit A1:C14, puis lançons la commande
Données > Tableau croisé > Créer.

Dans la boîte de dialogue qui s'ouvre et qui de-
mande  l'origine  de  la  plage  de  données  sur
laquelle on désire travailler, sélectionnons l'option
Sélection active puis validons par OK pour ouvrir
la boîte de dialogue Tableau croisé.

La boîte Tableau croisé
Grâce à cette boîte, nous allons pouvoir redéfinir
la mise en page de notre plage de données et la
structurant dans le sens qui correspond à la ma-
nière  dont  nous  souhaitons  présenter  les
données.

Mise en page
La  boîte  de  dialogue  présente  dans  sa  partie
droite  une  série  de  boutons  rectangulaires  qui
correspondent  aux  champs  de  la  liste : Noms,
Résultats, Matières.
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On commence par définir la structure du tableau
en  spécifiant  les  champs  à  utiliser  comme
champs de ligne et de colonne. Pour ce faire, il
suffit de faire glisser les boutons correspondants
dans les parties LIGNE et COLONNE de la boîte
de dialogue. 

En  ce  qui  nous  concerne,  nous  donnerons  au
champ  Noms une  orientation  de  ligne  et  au
champ Matières une orientation de colonne. 

Si plusieurs champs sont déposés, on peut les dé-
placer à sa guise à l'aide de la souris à l'intérieur
même des zones pour modifier leur ordre, ou encore
les retirer et les remettre à leur position de départ.

Dans  la  partie  DONNEES  on  fait  glisser  les
champs dont les valeurs devront être synthétisées
dans le  TCD,  dans notre exemple,  il  s'agira  du
champ Résultats. Une étiquette est automatique-
ment créée : elle se compose de la formule (par
défaut la fonction  Somme) qui sera utilisée pour
synthétiser les valeurs, suivie du nom du champ
lui-même. 

Mais comme ce n'est pas la fonction Somme que
nous voulons  utiliser  mais  la  fonction  Moyenne,
on double clique sur le champs Résultats, dans la
zone des DONNEES pour ouvrir la boîte de dia-
logue  Champ de  données,  et  y  sélectionner  la
fonction Moyenne que nous voulons utiliser.

Options supplémentaires
Il nous reste encore à préciser quelques options
d'édition  à  appliquer  à  notre  tableau  de  sortie,
entre autres la plage de la feuille où nous souhai-
tons le voir apparaître. C'est le boutons Plus>>qui
nous permet d'effectuer ces derniers choix dans
un volet intitulé Résultat.

Sélection à partir de : permet de sélectionnez la
zone qui contient les données du tableau croisé
dynamique actif.  À droite, le bouton Réduire  ou
Agrandir permet de réduire la boîte de dialogue à
la taille d'un champ de saisie (ou de lui faire re-
trouver  sa  taille  d'origine),  pour  faciliter  la
sélection  d'une  référence  directement  dans  la
feuille.

Résultat à : permet de choisir dans une liste dé-
roulante  une  plage  destinataire  déjà  définie.  Si
aucune plage de destination n'est spécifiée (op-
tion indéfini), la table est automatiquement créée
au-dessous de la plage source, comme le montre
le  champ situé juste à droite.  Par  contre,  il  est
possible de définir soi-même cette zone par poin-
tage d'une cellule directement dans la feuille ou
en saisissant directement dans le champ éditable
l'adresse de la  cellule  supérieure  gauche de la
plage destinataire.

Ignorer les lignes vides : en cochant cette case,
les lignes vides figurant dans le tableau d'origine
sont ignorées.

Total - colonnes/lignes     : si cette case est cochée,
la fonction de synthèse choisie,  ici  la  Moyenne,
affiche le résultat de son calcul pour les lignes et
les colonnes du tableau.

Ajouter un filtre : ajoute un bouton de filtre aux ta-
bleaux  croisés  basées  sur  des  données  de
classeur. Lorsqu'on clique sur le bouton Filtre une
boîte de dialogue s'ouvre, permettant de filtrer le
tableau croisé à l'aide d'un filtre pouvant compor-
ter jusqu'à trois critères.

Identifier les catégories : en activant cette option
le programme assigne aux lignes sans intitulés la
catégorie supérieure suivante.

Activer le rappel des éléments : cochez cette case
et double-cliquez sur l'étiquette d'un élément dans
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7. Les listes de données

la table pour afficher ou masquer les détails de
l'élément. Décochez cette case et double-cliquez
sur une cellule dans la table pour éditer le conte-
nu de cette cellule.

La copie d'écran ci-dessous nous montre le  ta-
bleau obtenu après  validation  de  la  commande
par OK.

Modifier un TCD
Le tableau créé se laisse encore manipuler : il est
ainsi possible de modifier l'orientation des champs
directement dans le tableau final, en affectant, par
exemple, une orientation de ligne à des champs
ayant  initialement  une orientation en colonne et
vice versa. 

Un TCD se laisse formater comme tout autre ta-
bleau de données.

Les résultats d'un TCD ne s'actualisent pas automa-
tiquement  lors  de  la  modification  des  données
sources. Il doit être recréé pour répercuter ces modi-
fications. 
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8.1. Valeur cible
Cette fonctionnalité permet de déterminer la va-
leur  que  devrait  prendre  une  cellule  impliquée
dans une formule pour que le résultat calculé par
la formule corresponde à une valeur donnée.

Cette fonctionnalité se lance à l'aide de la com-
mande Outils > Recherche de valeur cible…

Trois paramètres sont requis pour une recherche
de valeur cible : 

1. Cellule  de  formule : correspond  à  l'adresse
de la cellule qui renferme la formule de calcul. 

2. Valeur  cible : correspond  au  résultat  qu'on
souhaite que la formule renvoie. 

3. Cellule variable : correspond à l'adresse de la
cellule à modifier pour que la formule retourne
le résultat escompté.

Exemple
Nous avons contracté un prêt aux conditions sui-
vantes :

– Remboursement annuel : 18 000 sFr.
– Nombre d'années : 10 ans
– Taux d'intérêt annuel : 9.40%

C'est la fonction financière VA qui nous permet de
calculer  le  montant  qui  peut  être  emprunté  aux
conditions précédentes. 

Nous  constatons  que  le  crédit  alloué  dans  ces
conditions sera : 113 511.48 sFr.

Nous voudrions maintenant savoir combien d'an-
nées  seraient  nécessaires  au  remboursement
d'un emprunt de 130 000 sFr, par exemple, dans
les conditions de prêt identiques à celles décrites
ci-dessus (taux de 9.40%, 18 000 sFr remboursés
annuellement).  La fonction  valeur  cible va nous
permettre de répondre à cette question.

Lançons la  commande  Outils  > Recherche de
valeur cible…, ce qui ouvre la boîte de dialogue
de  même  nom,  puis  spécifions  les  paramètres
comme ci-dessous avant de valider. La boîte nous
permet  de définir  l'adresse de la  cellule  de for-
mule et celle de la  cellule variable par pointage
directement dans la feuille de calcul.
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Le nombre d'années nécessaires au rembourse-
ment s'affiche dans la boîte ci-dessus.

En cliquant  sur  Oui,  le résultat  s'insère dans la
feuille de calcul. Il nous faudra donc un peu plus
de 12,4 ans pour rembourser le prêt, si celui-ci est
de 130 000 sFr.

8.2. Le Solveur
Le  solveur permet de résoudre des équations à
plusieurs  variables  inconnues  par  les  méthodes
de recherche de valeur cible.

Le  solveur  de  Calc  supporte  uniquement  les
équations linéaires. Il fonctionne de manière ana-
logue  à  la  valeur  cible,  mais  avec  plus  de
possibilités, puisqu'il permet de calculer un objec-
tif  à  atteindre  (valeur  cible)  en  fonction  de
plusieurs  cellules  variables,  et  non  plus  d'une
seule, comme c'est le cas avec la valeur cible. 

On peut choisir si la valeur dans la cellule cible est
un maximum, un minimum ou une valeur  donnée
approchante.

On fait donc appel au solveur pour rechercher la
valeur optimale d'une cellule donnée (objectif ou
valeur cible) par ajustement des valeurs de plu-
sieurs autres cellules, ou lorsqu'on veut fixer des
limites pour une ou plusieurs des valeurs impli-
quées dans le calcul.

Un petit déjeuner pauvre en 
glucides
Pour illustrer l'utilisation du solveur, examinons le
tableau ci-dessous.

Ce tableau liste  une série  d'aliments  "riches en
glucides" entrant fréquemment dans la composi-
tion d'un petit déjeuner. La colonne B propose un
exemple de quantités consommées, la C indique
combien de glucides sont trouvés dans 50 g de
chacun des aliments listés dans le tableau, et la
colonne D calcule la quantité de glucides ingérés
lors  d'une  consommation  de  ces  produits  telle
qu'indiquée  dans  la  colonne  B.  Au  final,  dans
notre exemple, notre petit déjeuner nous ferait in-

gérer 100 g de glucides. C'est trop si vous êtes
diabétique, vous devriez tenter de vous maintenir
entre 50 et 60 g. Comment faire pour déterminer
les quantités  de ces  aliments que vous pouvez
consommer ?

C'est là que le solveur intervient. Il vous suffit de
lui dire que dans le tableau précédent vous viser
une consommation totale de 55 g de glucides et il
vous aidera à composer votre menu pour y arriver
en tenant compte de contraintes que vous lui four-
nirez.  Cela  revient  à  dire  que  dans  le  tableau
précédent, il va vous proposer des valeurs dans
la colonne B qui vous permettront d'atteindre une
valeur cible de 55 g dans la cellule D8.

– Les cellules de la plage B2:B7 sont les cellules
variables auxquelles le solveur va tenter, en te-
nant compte des contraintes que vous fournirez
sur les valeurs de ces cellules, de trouver des
des valeurs permettant d'atteindre l'objectif fixé.

– La cellule D8 renferme la formule de calcul et la
valeur  cible à  atteindre.  Sa valeur  dépend de
celle des cellules variables de la plage B2:B7.

Sélectionnez la cellule cible D8 puis lancez le sol-
veur par la commande Outils > Solveur …

Configurez  le  solveur  comme ci-dessous en cli-
quant sur son bouton Options … pour éviter qu'il
ne vous retourne des valeurs fractionnaire ou né-
gatives dans les cellules variables.

La fenêtre ci-dessous montre l'utilisation du sol-
veur avec les choix effectués.

Vous pouvez bien sûr tester les solutions proposées
par le solveur en posant d'autres conditions sur les
variables.
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Comme vous pouvez le constater dans le champ
intitulé  Par modification de cellules,  nous ne fai-
sons bouger ici  que les cellules variables de la
plage B4:B7 (les valeurs de B2 et B3 restent in-
changées) et nous posons des contraintes sur les
valeurs des cellules variables de la plage B4:B7
dans la rubrique Conditions de limitation. 

La cellule cible est celle qui contient l'objectif à at-
teindre (valeur cible), c'est à dire ici les 55 g de
glucides à atteindre. Comme vous pouvez le voir
dans la boîte, la valeur cible peut être une valeur
précise ou une valeur minimale ou maximale à at-
teindre. 

Une fois la boîte remplie, cliquer sur le bouton Ré-
soudre. 

Une boîte  de dialogue apparaît  avec le  résultat
trouvé par le solveur, 

Les  données  du  tableau  d'origine  sont  rempla-
cées par les résultats trouvés par le solveur, mais
elles ne sont pas encore remplacées de manière
définitive.

On a alors deux possibilités : 

– Restaurer  les  précédents :  les  valeurs  d'ori-
gine  sont  alors  restaurées  dans  la  feuille  de
calcul.

– Conserver le résultat : les données modifiées
par le solveur dans la feuille de calcul d'origine
sont conservées, sans possibilité de revenir en
arrière. Il  faut donc être prudent et éventuelle-
ment prendre la précaution de recopier ailleurs
les valeurs d'origine avant de jouer avec le sol-
veur. 

En cas d'échec, le solveur affiche le message sui-
vant : 

8.3. Les scénarios
Un scénario permet de faire varier le résultat re-
tourné par  une formule en modifiant  le  contenu
d'une  ou  de  plusieurs  cellules  impliquées  dans
son calcul.

Créer le modèle de calcul
Commençons par créer un modèle de calcul nous
permettant  de  déterminer,  pour  un  emprunt
contracté sur un certain nombre d'années avec un
taux d'intérêt donné, le remboursement mensuel
qui nous sera demandé et au final, le montant to-
tal que nous aurons remboursé une fois notre prêt
arrivé à terme.

Ce modèle de calcul est reproduit ci-dessous.
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Formules utilisées : 

– en B4 : =VPM(B2/12;B3*12;B1) 
– en B5 : =B4*12*B3

Nous voudrions connaître les mensualités et le to-
tal remboursé pour différents taux et des périodes
de remboursement variables, qui correspondront
à autant de scénarios qu'on peut tester. 

Les  cellules de résultats seront donc  B4  et B5
et les cellules variables, c'est à dire sur lesquelles
on testera des valeurs, seront les cellules  B2 et
B3.

Les cellules variables et résultantes doivent appar-
tenir  à  la  même  feuille  de  calcul  pour  que  des
scénarios puissent être définis.

Créer un scénario
Pour créer un nouveau scénario, commencez par
sélectionner  les  cellules  variables,  dans  notre
exemple, il s'agit des cellules B2 et B3.

Les cellules variables ne peuvent contenir que des
données,  jamais  des  formules.  Elles  peuvent  être
contiguës ou constituer une plage multiple.

Lancez  ensuite  la  commande  Outils  –  Scéna-
rios... pour  ouvrir  la  boîte  de  création  de
scénarios.

Donner un  nom au scénario. Ce nom apparaîtra
par la suite dans le  Navigateur sous la catégorie
Scénarios,  ce  qui  permettra  de  l'utiliser  par  la
suite.

On peut également ajouter un commentaire au scé-
nario.  Celui-ci  apparaîtra  alors  aussi  dans  le
Navigateur lorsqu'on y sélectionnera le scénario

La rubrique Paramètres permet de choisir des op-
tions de représentation. 

– En cochant l'option Afficher le cadre, le scénario
sera mis en évidence dans la feuille de calcul
par un cadre entourant ses cellules variables, et
une barre de titre affichera le nom du dernier
scénario utilisé, ainsi que la liste de tous ceux
déjà définis dans cette zone. 

– L'option  Recopier permet de recopier  les don-
nées des cellules variables directement dans le
scénario choisi pour pouvoir les modifier directe-
ment dans la table pour chaque scénario. 

– L'option  Copier  la  feuille  entière recopie  la
feuille entière dans une feuille de scénario qui
se rajoute au classeur. Dans cette feuille sup-
plémentaire les cellules variables apparaissent
sur fond gris et il est alors possible de faire va-
rier leurs valeurs pour examiner l'impact de ces
modifications  sur  les  cellules  résultantes.  Ces
manipulations se font  alors  de manière tout  à
fait indépendante de la feuille de départ qui ne
subit pas les modifications produites par l'exé-
cution du scénario dans la feuille rajoutée. 

À la validation par  OK la boîte se referme et le
nouveau scénario se retrouve activé.

On  peut  alors  remplacer  les  valeurs  contenues
dans  les  cadres  par  celles  souhaitées  dans  le
scénario et constater la répercussion de ces mo-
difications sur les cellules résultantes. 

Utiliser un scénario
1. Ouvrir le Navigateur en cliquant sur le bouton

Navigateur dans la barre d'outils Standard ou
utiliser  le  raccourci  F5.  Si  vous  utilisez  AOO
4.xx vous pouvez également accéder au Navi-
gateur depuis la barre latérale.

2. Cliquez sur l'icône représentant les scénarios. 
3. Les  plages  correspondant  aux  cellules  va-

riables  apparaissent  encadrées  et  on  peut
choisir l'un des scénarios disponibles dans la
liste déroulante intégrée à la barre de titre de
chaque cadre. Il  est également possible d'ef-
fectuer ses choix dans le Navigateur. 
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8. Outils d'analyse et de synthèse

8.4. Créer un tableau de 
synthèse

On peut créer, dans une feuille de calcul, un ta-
bleau de synthèse à partir de données situées sur
d'autres feuilles faisant partie du même classeur
que la feuille de synthèse, ou se trouvant dans un
classeur différent.  Dans ce dernier  cas,  le  clas-
seur contenant les données et celui intégrant la
feuille de synthèse doivent se trouver ouverts si-
multanément. 

Le tableau de synthèse obtenu par cette méthode
est lié aux données sources et s'actualisera auto-
matiquement  lorsque  celles-ci  se  trouveront
modifiées.

L'exemple ci-dessous illustre le cas où la feuille
de  synthèse  et  les  données  appartiennent  au
même classeur. On se propose de créer dans une
feuille appelée  Synthèse, un tableau totalisant le
nombre  de  PC complets  et  de  boîtiers  qu'on  a
commandés au cours du premier trimestre chez
les fournisseurs 1 et 2.

Feuille "Fournisseur 1"

Feuille "Fournisseur 2"

Feuille "Synthèse"
Notre feuille de synthèse affichera le tableau sui-
vant,  où  se  trouvent  additionnés  les  pièces
concernées achetées chez les deux fournisseurs.

Pour insérer les différentes formules dans le ta-
bleau de synthèse,  on procède comme suit,  en
prenant l'exemple de la cellule B2 :

1. On  commence  par  sélectionner  dans  le  ta-
bleau  de  synthèse  la  cellule  destinataire  du
calcul, c'est à dire ici, B2. Dans la barre de for-
mule,  on  commence  par  taper  le  signe  "="
(sans les guillemets), puis on clique sur l'onglet

de feuille  Fournisseur 1 pour afficher la feuille
correspondante,  et  pouvoir  y  sélectionner  la
cellule B2. La barre de calcul affiche =Fournis-
seur 1.B2. 

2. On poursuit l'édition de notre formule en tapant
le signe + (plus), puis on désigne le deuxième
opérande  en  cliquant  sur  l'onglet  de  feuille
Fournisseur  2,  puis  en  sélectionnant  dans
cette feuille la cellule B2. On obtient l'affichage
complet  de  notre  formule  =Fournisseur
1.B2+Fournisseur2.B2. 

3. En validant par  Enter on voit apparaître dans
la cellule B2 du tableau de synthèse la somme
du nombre de PC complets commandés chez
les fournisseurs 1 et  2 au cours du mois de
janvier. À noter que le calcul est dynamique et
s'actualisera  si  nous  modifions  les  données
des feuilles Fournisseur 1 et Fournisseur 2. 

4. La formule créée peut alors être recopiée tout
à fait classiquement dans les autres cellules du
tableau de synthèse.

8.5. Consolider les données
La consolidation est une technique qui permet de
regrouper dans une même feuille de calcul, appe-
lée  Feuille  de  synthèse,  des  données  en
provenance  d'autres  feuilles,  appelées  Feuilles
sources. 

La feuille de synthèse et les feuilles sources n'ap-
partiennent pas obligatoirement au même classeur. 

Les grosses différences avec le cas précédent du
tableau de synthèse, c'est qu'on utilise cette fois
une fonctionnalité intégrée à Calc pour générer le
tableau de synthèse et que nous pouvons ici déci-
der  de  ne  pas  lier  le  tableau  de  synthèse  aux
données sources.

La procédure
L'opération se déroule en deux étapes : 

1. Dans un premier temps on crée la feuille de
consolidation et on y définit la plage occupée
par le tableau de synthèse. On peut reproduire
sur  cette  feuille  la  même structure que celle
existant  sur  les  feuilles  à  consolider  (feuilles
sources), mais ce n'est pas obligatoire. 

2. Dans  une  seconde  étape,  on  lance  la  com-
mande  Données > Consolider… pour ouvrir
la  boîte  de  dialogue  permettant  d'indiquer
l'adresse  des  données  sources  ainsi  que  le
type de fonction impliquée dans la consolida-
tion (Somme, Moyenne…).
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8. Outils d'analyse et de synthèse

Un exemple concret
Pour  mieux  comprendre,  nous  partirons  de
l'exemple suivant : nous sommes une société de
montage de PC qui s'approvisionne en pièces dé-
tachées auprès de trois fournisseurs différents.

Sur 3 feuilles de calculs distinctes nous avons re-
porté les achats en nombre de pièces réalisés au
cours du premier  trimestre de l'année chez nos
trois fournisseurs. Ces trois feuilles de calculs ont
pour noms Fournisseur 1, Fournisseur 2, Fournis-
seur 3. 

Les trois tableaux créés ont la même structure gé-
nérale.

Fournisseur 1

Fournisseur 2

Fournisseur 3

Positionnons nous dans une nouvelle feuille pour
y sélectionner la cellule à partir de laquelle le ta-
bleau  de  consolidation  sera  construit,  soit  par
exemple A1. Appelons cette feuille de récapitula-
tion Consolidation. 

Lançons  maintenant  la  commande  Données  >
Consolider... la  boîte  de  dialogue  suivante
s'ouvre. Par défaut c'est la fonction "SOMME" qui
est proposée dans la zone Fonction, mais la liste
déroulante nous en propose d'autres, comme par
exemple Moyenne, Max, Min, Écart-type, Produit,
etc.

1) Sélectionnons dans la feuille  Fournisseur 1 la
plage (A1:D3) correspondant à la première plage
de données  sources  (avec  ses  en-têtes  de  co-
lonnes et de lignes), puis cliquons sur le bouton
Ajouter pour  intégrer  cette  plage  à  la  liste  de
celles à considérer dans la consolidation (rubrique
"Plages  de  consolidation").  Pour  supprimer  une
plage existante, la sélectionner puis cliquer sur le
bouton Supprimer. 

2) Procédez de même pour les plages à consoli-
der des feuilles Fournisseur 2 et Fournisseur 3. 

3) Choisir la fonction à appliquer, par exemple la
fonction  Somme si  nous  souhaitons  savoir  le
nombre total de pièces de chaque catégorie qui
ont été commandées au cours du trimestre écou-
lé. 

4) Le champ Copier le résultat vers nous permet
de définir l'adresse du tableau de consolidation si
nous ne l'avions pas spécifié avant de lancer la
commande. 

5) En cliquant sur le bouton Plus nous obtenons
un volet supplémentaire au bas de notre boîte de
dialogue, avec des possibilités supplémentaires :

– L'option  Lier  aux  données sources permet  de
créer une feuille de consolidation dynamique qui
s'adaptera  automatiquement  aux  modifications
des données sources.

– Les options  Étiquettes de ligne et  En-têtes de
colonnes permettent de construire le tableau de
synthèse avec le  nom de ses  colonnes et  de
ses lignes

À  l'issue  de  notre  travail  la  boîte  se  présente
comme montré ci dessous :
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8. Outils d'analyse et de synthèse

La  validation  par  OK referme  la  boîte  et  nous
montre le tableau de consolidation créé.
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